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Tiger compatible ... 

The complete Macintosh problem solving uti lity. 

Diagnostics and Repair 
Tech Tool® Pro includes options to thoroughly check various hardware 
components, drives, and other aspects of your computer system. 
One of the most important tests is the S.M.A.R.T. test, which checks 
for impending drive failure. 

Optimization 
This feature defragments the files on your hard drive and consolidates 
all the free space into one large block. Optimizing enhances the 
overall performance of your hard drives and simplifies file layout on 
the disk. 

Data Recovery 
TechTool Pro includes routines that can search a damaged drive 
and attempt to recover valid files to another location. Hence, even 
if a drive is damaged beyond repair, you may still be able to save 
important data that had not been backed up. 

Safety 
The Safety feature can be configured to protect your drives by 
automatically creating backups of critical drive directory data. It can 
also test the computer for developing problems and alert you, both 
onscreen and via email, if problems are detected. 

eDrive 
One of the most innovative features of Tech Tool Pro is the eDrive. 
This is a bootable Mac OS X partition containing Tech Tool Pro and 
a small copy of your system that you can use in an emergency. It 
is created on one of your hard drives without the need to reformat. 

Micromat, Inc., 5329 Skylane Blvd. , Santa Rosa, CA 95403 
800-829-622 7 707-566-3831 info@micromat.com www.micromat.com 
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·1FM RADIO, REMOTE, AND RECORDER FOR 1PoD 

• Listen to FM radio on your iPod 
• Record FM radio to your iPod 
• High quality omnidirectional built in microphone 

for recording voice memos 

AirClick REMOTE CONTROL FOR MAc, PC, 1PoD AND 1PoD MINI 

~ .. • Designed specifically for use with iPod & iPod mini 
• Uses RF for control from up to 60 feet away 
• Control Keynote, iTunes, QuickTime, DVD player 

and more with AirClickUSB 

Smart Deck INTELLIGENT CASSETTE ADAPTER FOR 1PoD 

• Control iPod navigation through your car stereo 
• Intelligent level control for optimal input levels 
• Constructed of the highest quality components 
• Seamless integration between iPod and car stereo 

• • 

Power Jolt 1PoD AuTo CHARGER 

• Charges ALL iPod models, including iPod shuffle 
• Includes 20 inch USB to Dock cable 
• Fused to protect against power surges 

T uneJ u ice BATTERY BACKUP FOR 1PoD & 1Poo MINI 

• Powered by a standard g Volt battery 
• Provides up to 8 hours of additional play 
• Compact and lightweight 

" .. -

(GRIFFIN) 
buy now at: www.griff1ntechnology.com 
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features 
21 Get in Sync! 
Given up trying to juggle email and contacts 
on multiple Macs, your PDA, and a mobile 
phone? Here's how to make your gazillion 
gadgets live together in perfect harmony. 
by Deborah Shadovitz 

30 'Pod People 
Whether you're a snobbish audiophile, 

hypergeek, gym fiend, or family man who 
spends lots of time in the minivan, we've 
got iPod gear to suit your lifestyle. 
by the editors of MacAddict 

ow to 
58 Ask Us 
Is iTunes having volume problems? Do you have 
a PowerBook with screen-stretching issues? Are 
you sick of Mail mistakenly marking messages as 
read? We have the diagnoses-and the cures. 

60 Make Over Your Mac 
with Custom Icons 
Aqua's icons look nice, but 
sometimes you might get a 
little seasick-here's how 
to craft your own . 
by Johnathon Williams 

62 Back Up Your iTunes Tunes 
Keep your precious iTunes 
Music Store purchases from 
being lost forever in a freak 
Mac-cident. 
by Niko Coucouvanis 

36 Wireless 
Buzzcronyms 
The world of Wi-Fi is a bubbling stew of acronyms, 
arcane protocols, and endless technobabble. Let 
this field guide be your Rosetta Stone. 
by Niko Coucouvanis 

64 Put a 
Flipbook 
Animation 
on Your 
iPod 
Can't afford 
to buy a new 
video iPod? Try 
watching a movie on your photo-capable iPod 
using the oldest-fashionedest method possible. 
by Niko Coucouvanis 

65 Blow Stuff 
Up in Photoshop 
You can enlarge a digital 
photo in one of two 
ways : the easy way or the 
right way. Here's how to 
do the latter. 
by Niko Coucouvanis 
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10 Editors' Page 
Apple's latest gizmos may not change the way you get 
your media just yet-but the revolution is coming. 

12 Get Info 
Apple announces a video-capable iPod and media
centric iMac, the sun rises on Civilization IV, and we 
invite you to dress you r iPod in dinosaur skin. 

39 Reviews 
41 319 LCD Monitor LCD monitor 

49 C01U USB microphone 

46 CatDV Pro 4 media-management software 

45 Chatalog iChat utility 

42 Dreamweaver 8 Web-authoring software 

47 FinePix F10 digital camera 

51 HarmonyAudio audio hardware interface 

49 I-Dog robotic speaker 

54 LEGO Star Wars action-adventure game 

50 Mathematica CalcCenter 3 math software 

52 Micro Hard Drive USB hard drive 

52 PhotoKit Color Photoshop plug-ins 

56 Pixma iP4200 inkjet printer 

48 Pixma MP780 multifunction inkjet printer 

40 ROKR iTunes-equipped mobile phone 

53 Squeezebox2 digital-music player 

44 Stylus Photo R2400 inkjet printer 

48 Stylus Photo RX620 multifunction inkjet printer 

54 TC1000BN Power Ready Notebook Case notebook case 

50 WGXB102 56 Mbps Wall-Plugged Wireless 
Range Extender Kit Wi-Fi network extender 

57 The Hot List 
We'd spend our own hard-earned money on these 
products. 

QUICK TIPS 
FROM THIS MONTH'S ISSUE 

+ SYNCHRONOUS 
If you use your Palm OS 
PDA with more than one 
computer, sync it with the 
one on which you enter 
most of your new contacts 
and to-do items, and then 
have the Palm overwrite the 
information on the others. 
From "Get in Sync!", p21. 
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+ IMPENETRABLE 
If you're using a non-Apple 
keyboard that has no Eject 
key, you can just hold down 
F12 to open up your disc t ray. 

~~:~~~~~d. 
just tap F12. 
From Ask 
Us, p58. 

78 Log Out 

78 Letters 
Our readers' imaginations run 
rampant with iPod origami 
artwork, tales ofTiger Island, 
and poultry-themed restoration 
projects. 

+ SUBFREQUENT 
Tekkeon's myTune FM iPod
to-radio car adapter works 
better than most because 
it operates at 87.7KHz and 

87.9KHz-below most 

79 Contest 
Picture this: You winning a Canon 
EOS Digital Rebel XT after coming 
up with a clever caption . 

so Shut Down 
If you think an iPod emblazoned 
with the Hogwarts crest is a bit 
outre, consider the alternatives. 

+ VOLUMETRIC 
To adjust a track's volume 
in iTunes, select it, press 
Command-I, click Options, 
and fiddle with the slider 
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for Volume 
Adjustment. 
From "Back Up 
YouriTunes 
Tunes," p62. 





the disc WorkSmaJ 
Pia¥ Hart What's a better assortment of apps for the 

Disc: a couple of heavyweights or a passel 

of nifty lil' apps? How about both? This 
month we've got demos of such industry 
leaders as Macromedia's Dreamweaver 

8, Native Instruments' Kontakt 2, and 
Mathematica CalcCenter 3, plus a ton 
more-74 items in all! 

All the apps you 
need to be more 
productive and 
more creative
and to have a 
boatload of fun! 

Image Tricks 
free ware 
Got Tiger? Dying to test-
drive all the powers of 
its Core Image filters? 
Here's an 
app that' ll 
get you 

started. 

AUDIO & MUSIC 
Audiocorder (OS X) 4.5.0 
shareware 

AudioFinder 3.8.3 shareware 
ID Tunes 1.7 shareware 
Kontakt 2.0.1 .007 trial 
Max Magic Microtuner 1.5.2 

shareware 

Peak Pro 5 Demo Video 
Sound Byte (OS X) 2.6.1 

shareware 

FUN&GAMES 
BeerMeister 3.1 shareware 
Betty's Beer Bar 1.0 demo 
BoXIKoN 1.3.7 demo 
BreakQuest 1.0 demo 
Burning Monkey Mahjong 2 demo 
Digby's Donuts 1.0 demo 
Downfall 2.5.2 shareware 
FRS Coloring Book 1.0 trial 
Marbles Deluxe 1.0 demo 

GRAPHICS & MULTIMEDIA 
Easy Card 3.1 .0 shareware 
History for Adobe 

lnDeslgn 2.1 trial 

iDive 1.4 shareware 
Image Tricks 1.1 freeware 
iWatermark 3.0.2 demo 
MacCapture 1.0 demo 
Slideshow Magic 4.0.1 shareware 
ZeboPhoto 1.7.1 shareware 

INTERFACE 
Docktopus 1.0.1 demo 
FolderGlance 1.5 
donation ware 
iClock 2.5 shareware 
lconBuilder 8.0.1 shareware 
Namely 1.6 freeware 
Silk 2.1.1 shareware 
World Clock Deluxe 4.2 

shareware 

UPCiRADE 

Dreamweaver 8 
trial 
Dreamweaver has 
always been a leader 
in Web design; this 
upgrade brings 

it even further 

down the road 
to perfection . 

INTERNET& 
COMMUNICATION 
AB for Web 1.2 demo 
Chatalog 1.2 demo 
Dreamweaver 8 trial 
GarageSale 1.9 shareware 
Little Snitch 1.2 shareware 
PhoneAgent 1.2.3 shareware 
PhoneDlrector 1.0.7 shareware 
PhoneManager 1.1.5 shareware 
PictureSync 1.4.2 shareware 
RSS DreamFeeder 1.1.2 shareware 
TrendyMac 1.0.4 demo 

PRODUCTIVITY 
Alarm Clock Pro 7.4.1 shareware 
Assignment Planner 2.0 shareware 
ConceptDraw Mlndmap 
Pro 4.0 trial 

DEVONagent 1.7 demo 
DEVONthlnk Pro 1.0 demo 
iEvents 2.5.3 shareware 
llist Data 3.0.1 demo 
Mathematica CalcCenter 3 demo 
NoteBook 2.0 demo 
Omni Productivity Bundle demo 
slmpleDays 3.3.1 shareware 
Studlometry 3.0.7 trial 
You Synchronize 2.1 .1 trial 

UTILITIES 
AB Transfer 1.8.0 demo 
Album Cover Finder 3.3.5 trial 
CDFlnder 4.5 shareware 
ChronoSync 3.1.0 shareware 

Kontakt 2 
trial 
If you're into sampling, 

you already know of 
Kontakt 2's awesome 
capabilities. 
If you're not, 

then now's 
the time. 

Cocktail (Tiger Edition) 3.6.5 
shareware 

Cocktail (Panther Edition) 3.5.4 
shareware 

Cocktail (Jaguar Edition) 3.5 
shareware 

Delicious Library 1.5.3 demo 
DiskTracker (Classic) 2.3.2 
shareware 

DiskTracker (OS X) 2.3.2 
shareware 

FontAgent Pro 3.0.2 trial 
Font Pilot 2.0.3 shareware 
LogSurfer 1.2.2 freeware 
Smart Crash Reports 1.0.1 
freeware 

Snapz Pro X 2.0.2 shareware 
SoftRAID 3.2.1 demo 
Tech Restore Demo Video 
Tidy Up 1.0.5 shareware 
Unlockupd 1.0 freeware 

SPONSORS 
Betty's Beer Bar 1.0 demo 
BreakQuest 1.0 demo 
Burning Monkey Mahjong 2 demo 
DEVONagent 1.7 demo 
DEVONthink Pro 1.0 demo 
Digby's Donuts 1.0 demo 
FontAgent Pro 3.0.2 trial 
Marbles Deluxe 1.0 demo 
NoteBook 2.0 demo 
Omni Productivity Bundle demo 
Peak Pro 5 Demo Video 
SoftRAID 3.2.1 demo 
TechRestore Demo Video 

If you don't receive the Disc with your copy of MacAddlct, you might want to consider upgrading. Each monthly Disc contains cool 
demos, useful shareware and freeware , and the Inimitable MacAddlct Staff Video. To get 12 Issues of MacAddlct that Include this value
packed disc with your subscription (prorated If necessary) for just $1 more per Issue, call 888-771-6222-the operator will take care of 
everything. 
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TRANSFORM YOUR PAPERWORK. 
Give yo ur administrative paperwork new life with the Fujitsu ScanSnap™ Paper Manager for Macintosh '" Its 50-page automatic 
docu ment feeder quickly transforms a stack of paper into useful , easy-to-manage electronic files. It transforms double-sided documents 
into POFs with one-button ease and automatica lly transforms documents in to ema il attachments for faster, surer de livery th an fa xi ng . 
All on a sca nner footprint smal ler than a sheet of paper. Add Advance Exc hange ownership protection for worry-free serv ice . 
Now, that is a thing of beauty. Call 800-831-8094 ext.9489 or see it in action now at www.fcpa.fujitsu.com/9489 
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The End of Television 
A bit of advice: The next time Apple 
throws one of its product-announcement 
shindigs, go to whatever lengths necessary 
to wrangle an invitation. Lie. Cheat. Steal 
Walt Mossberg's ID. Become a world
renowned recording artist and offer to play 
for free. Do whatever it takes-you won't be 
disappointed in Steve Jobs's performance. 
He's good. He's very good. 

Another bit of advice: Once you've made it 
into the auditorium and are among the pack 
o' panting pundits fixated on Steve's every 

word, try to keep a clear head. What's truly significant are not the products 
being announced, but the changes they bring to the entire digital ecology. 

Take, for example, the new video-capable iPod and the media-center 
iMac GS. Droolworthy and groundbreaking as they may be, they are 
merely enablers ofThe Next Big Thing in digital content delivery. The 
first videos available on the iTunes Music Store are just baby steps on 
the way to comprehensive, personalized, on-demand entertainment. A 
few years from today-five? 10? 20?-broadcast video will be a shadow 
of its current self, and movie megaplexes will be closing faster than the 
Microsoft Media Center's window of opportunity. You and I will choose 
what we want to watch, when and where we want to watch it, much like 
we do today with the majority of our music. 

The signs are everywhere. On-demand cab le-TV content is catching 
on. Movie-ticket sales are down-not only because so many current 
movies are lousy, but because the movie-going experience has become 
both unpleasant and expensive. As bandwidth increases and video
compression technology improves, choice, comfort, and near-instant 
gratification will become the order of the digital day. 

Sure, there are gnarly details to sort out-how much artists and 
writers will share in the take, the role of digital rights management, and 
so on-but the on-demand digital-entertainment-d istribution train has 
left the station, and it ain't coming back. 

Apple is starting small and stealthy in this video revolut ion; it's not 
even touting the new iPod as the "iPod video" a la the iPod photo, mini, 
shuffle, and nano. That's smart. It's just the latest iPod, and oh look, it 
plays video, too -as does most every Mac and PC on the planet. Steve 
has smarts, money, market share, and talent on his side. Don't bet 
against him. He's good. He's very good. 

Enjoy, Y~ 

comingsoon :january2006 
Here's what our editors are preparing for the next issue of MacAddict. 

Niko Coucouvanis FACT CHUCK ER 
What's your favorite among Apple's recent announcements? 
I love how one slide in Steve's presentation said that the 
new iMac comes with either a 160MB or 250MB hard 
drive-a typo so blatant that I could have caught it in 
my sleep. It's obviously a cleverly coded job offer for an 

eagle-eyed chimp like me. 

Sean Molloy NUMEROLOGIST 
What's your favorite among Apple's recent announcements? 
The fact that I can now download older episodes of 
Lost- I've only caught onto this crazy-awesome show 
recently, and I've still got a lot to catch up on. Now if I could 
only download, wel l, anything else I actually want. 

Roman Loyola eMAC TORCH BEARER 

What's your favorite among Apple's recent announcements? 
How 'bout a non-announcement: It's the end of the line 
for the eMac-Apple's most misunderstood Mac. If you 
compare the cost of the eMac to that of a Mac mini with a 
new display, keyboard , and mouse, the eMac was a good 

deal. Long live the eMac! 

Mark Rosenthal MR. FUN 
What's your favorite among Apple's recent announcements? 
I can only really comment about an announcement that 
wasn't made, the announcement that I've been hoping to 
hear for months ... even years. That is, the introduction of 
the first iPod that wiggles. Well, maybe next year. 

Jake Widman PUNDITWANNABE 

What's your favorite among Apple's recent announcements? 
The video iPod . Not because I want a video iPod, 
particularly, but because now I won't have to keep 
reading all the breathless speculation about when we'll 
finally see a video iPod. But wait-when do you think 

we'll see one with a camera in it? 

Peter Marshutz FASHIONISTA 
What's your favorite among Apple's recent announcements? 
It's not an announcement, really, but more of a 
statement-a fashion statement, that is: For the first time 
in recent memory, Steve didn't appear in his trademark 
Levis, but instead in what looked like chinos. I'm surprised 

the punditocracy hasn't tried to read some deeper meaning into his 
wardrobe transformation. 

. ..... Max AFICIONADO-DEE-0-00 

What's your favorite among Apple's recent announcements? 
Hands down, Steve's best announcement was that this 
year's musical guest would be Wynton Marsalis, who then 
proceeded to blow the room away with 17 minutes of pure 
genius- enough time for Apple's Web monkeys to get all 

the product announcements up on www.apple.com, thus scooping 
the assembled journalists. 

lnkjets and lasers and dyes, oh my! We'll lead you through the deep woods of printer technology and show you how to choose 
the best printer for your needs. Our experts will explore the heights, depths, and insides of the new iMac GS and video 
iPod, and our Field Guide will make you a boss of gaming terminology. We'll then pull into The Sims 2 Body Shop for a 
megamakeover, hack an old Webcam into a stealthy night-vision cam, tell you how to configure your home network for remote 
access, learn savvy scanner secrets, and dumb down your desktop to resemble Windows. Finally, we'll ruthlessly review 
Apple's new iMac GS, the new video iPod, Macromedia's Flash 8, lntuit's Quicken 2006, and a lot more. 
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··~I The Omni Group 

This year, give something fun and useful. 
The Omni Group creates software that's a pleasure to use, and that gets 
the job done quickly and cleanly. We design our applications with the user 
in mind, so the interfaces are beautiful and the functionality is 
sensible-that's more than we can say about the tie. 

Customize the entire internet 
with an intelligent browser. 

Organize your words into 
elegant, logical outlines. 

Convey any idea graphically 
in gorgeous diagrams. 

See for yourself what a difference the right software can make 

Download a free trial at www.omnigroup.com/macaddict12 



First Steve said, 
"It's all about the 
music." Then Apple 
added photos
and now video. 

At an invitation
only event on 
October 12, 2005, 

Steve Jobs rolled out an 
onslaught of products 
and partnerships aimed 
squarely at advancing 
Apple's dominance of the 
digital-media world. 

Not just a video iPod, but a video iPod available 
in both white and black. Oooh ... Ahh ... 

STRAIGHT TC 
FIFTH-GENERATION iPOD 
The video iPod that's been the subject 
of rumors for months on end is finally 
here-but instead of being yet another 
model in the iPod line, the new 'Pod 
replaces the fourth-generation (4G) 
version. "This is the best music player 
we've ever made," said Steve Jobs 
during the press event-and he's right. 

Equipped with a crisp, bright, 2.5-
inch, 320-by-240-pixel color LCD screen, 
the 30GB ($299) and 60GB ($399) 
iPods can play 30-fps video encoded in 
H.264 or MPEG-4 at 320-by-240-pixel 
resolutions. If you wantto play video on 
an external display, you'll have to shell 
out an extra $39 for the Universal Dock, 
which has connections for S-Video and 
composite-AV cables. You can add your 
own videos to the iPod by encoding them 
in H.264 or MPEG-4, and then importing 
them into iTunes 6. 

If you like the slimness of the iPod 
nano, you'll love the svelte figures of 
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the new iPods.The 30GB 'Pod is 30-
percent thinnerthan the 20GB 4G-model, 
while the new 60GB unit is 12-percent · 
thinner. One downer: Like with the iPod 
nano, the remote connector located 
near the headphone jack on 4G iPods 
is now gone, thus crippling third-party 
accessorlesthatusethatport. 

iTUNES 6 
What's a video iPod without video 
content? (Yeah, yeah, we know: a music 

iPod. Smart-ass.) The new iTunes 6 lets 
you purchase videos online, though this 
feature is clearly in its early stages-at 
launch, iTunes' video library included 
only 2,000 music videos; five TV shows 
from ABC and Disney (Lost, Desperate 

Housewives, Night Stalker, The Suite Life 

of Zack & Cody, and That's So Raven); 

and six Pixar shorts, all for $1.99 each. 
Expect new shows and networks to 
jump on the bandwagon if this delivery 
method proves to be a moneymaker. 

Left: Photo Booth lets you mess around 
with Tiger's Core Image technology. 
Right: The hyper-simple Remote. 

The purchased videos, however, have 
significant strings attached. They're at 
320-by-240 resolution, they're copy
protected so you can't play them on 
unregistered Macs, and you can't burn 
them to discs. At $1.99, the price might 
be low enough to convert BitTorrent 
users who like to download (read 
"stea l") full-screen versions of TV shows 
for free, but the inability to burn them to 
disc might be a deal-breaker. 



Other new features include the ability 
to "gift" an iTunes Music Store product 
to another user, reviews written by iTMS 
customers, and a beta version of a Just 
For You section that provides customized 
(and tweakable) recommendations 
based on your buying habits. 

NEWiMAC GS 
If you've been waiting for a media
centric computer with Apple's traditional 

fire up Front Row, it fades the standard 
Mac desktop into the background 
and replaces it with jumbo icons for 
accessing iTunes, iPhoto, videos, and TV 
shows you've bought via iTunes; it also 
shows the DVD currently in the iMac's 
BX SuperDrive. Once you select one of 
the main icons, navigating through your 

media on Front Row's large-print display 
is a lot like navigating an iPod, complete 
with playlists, slideshows, album art, 

Front Row gives couch 
potatoes easy remote
driven access to all the 
media files on their new 
iMac GS-and if thin is in, 
then thinner is inner. 

onscreen status-the 
whole works. 

The Apple Remote 
also works with 
iPods-after you buy 
the aforementioned 
Universal Dock-but 
that's Universal as in 

VIDEO 
"comes with adapters 
for all current iPod 
models." Apple 
says that you can't 
use the new Dock 

savvy and flair, check out the new iMac 
GS (17-inch, 1.9GHz, $1,299; 20-inch, 
2.lGHz, $1,699). The new iMac's 
improvements are visually subtle; 
shave half an inch off the original iMac 
GS, smooth down the corners a bit, and 
you get the idea. Look a little closer, 
and you'll find the marquee features: 
an integrated iSight camera just above 
the screen (more on that in a bit); and 
clinging magically (OK, magnetically) 
to the iMac's lower-right side, a simple 
six-button remote control that resembles 
an iPod shuffle. The IR sensor? Hidden 
behind the Apple logo. This is exactly 
the kind of style and grace we've come 
to expect from Apple. 

But slapping on a remote does not a 
media center make-for that you need 
software, and Apple's new Front Row 
is the best 10-foot interface we have 
seen. (Yes, a 10-foot interface is one you 
use from further away, such as when 
lounging on your couch.) When you 

as an IR receiver to 
add remote-control 

capabilities to older Macs-but we'll try 
anyway the minute we get our grubby 
little hands on one. 

A nifty new app called Photo Booth 
jazzes up the old-school-department
store-photo-booth concept with a 
healthy dose of Apple's Quartz-fueled 
eye candy. Tapping into the Core Image 
technology of Mac OS 10.4 (Tiger), 

Photo Booth lets you smile at the 
iMac's integrated iSight camera and 
filter your image through 18 of Tiger's 
Core Image filters and effects : Sepia, X
ray, Thermal Camera, Stretch, Squeeze, 
Fish Eye, and more. And if you think 
that's cool, you'll love this part: Snap 
a shot, and the iMac's screen will flash 
white to illuminate the scene. Apple 
spokesfolks refused to give us official 
word on when or whether Photo Booth 
or Front Row will migrate to other 
Macs-but how could Apple deny the 
rest of us such awesome toys? 
-Niko Coucouvanis and Roman Loyola 

NEW STUFF 

~ PAYOLA-FREE RADIO 
SoundBridge Radio 
$399.99 
www.rokulabs.com 
Available: November 2005 
Roku's latest musical 

You're listening 
to Wi-Fi in hi-fi! 

device uses Wi-Fi to tap into your 
Internet connection and play Internet 
radio stations. The Sound Bridge Radio 
also works with iTunes to play y.our 
unprotected music (sorry, no iTMS
purchased songs), plays audio from 
an SD card or MultiMediaCard, and 
functions as a clock radio. 

You too can feel like a pro music producer. 

~ BATTLE OF THE CiARACiEBANDS 
CubaseSE3 
$159.99 
www.steinberg.de 
Available: Now 
Steinberg's entry-level music
-production app has a new interface, 
drag-and-drop MIDI support, a 
redesigned Track Inspector, new key 
commands and editing functions, and 
a lot more. 

~ CiET CONNECTED 
HomeDock 
$99.99 
www.dlodirect.com 
Available: Now 
This sexy little 
slab from DLO 
connects your 
iPod to your home 
entertainment A 'Pod's home sweet home. 
center via RCA 
plugs or to your Mac via USB. It also 
charges your iPod, and the remote lets 
you control your 'Pod from the couch. 
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14 /1 GET INFO 
ifJ the news of the month in bite-size chunks 

DROOL WORTHY 
Sexy Stuff We Can't Wait to Get Our Mitts On 

iGroove-y1' 
Klipsch's iGroove ($279.99, www.klipsch .com) has a pair of fiber
composite 2.5-inch woofers and a pair of 1-inch MicroTractrix Horn-loaded 

tweeters. Your iPod charges while it's docked, and a wireless remote can 
control the iGroove and iPod from across the room . 

1'Bad-Ass 'Blad 
Hasselblad's 22-megapixel H2D ($26,995, www.hasselblad .se) has sensors that 

are twice the physical size of today's 35mm sensors, an ISO range of 50 to 400, 
Hasselblad's FlexColor for accurate color reproductions, a 2.2-inch OLEO display, 
the ability to shoot in Adobe DNG (it stands for "digital negative") format, 
FireWire 800 connectivity, and a whole lot more. 
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• Canon's EOS-10 
Mark II N ($3,999, 
www.canon .com) 
is an 8.2-megapixel 

digital SLR. It has a 

2.5-inch LCD, can 

fire 8.5 frames per 

second, and can 
shoot up to 22 RAW 
frames or 48 full

resolution JPEGs in 

a burst. 
• Nikon's new 8-

megapixel Coolpix 

P1 ($549.95, WWW 

.nikonusa.com) 
and 5-megapixel 

Coolpix P2 ($399.95) 

both have built-in 
Wi-Fi for wireless 
file transfers . Both 

3: ,. 
~ .., 

cameras also have 

multiple settings 

for file transfers, 

~:'.! including a shoot- ::: 

and-transfer mode ~ 

and transfer based ~ 

Canon's EOS-10 
Mark II N: Faster, 

on date. 
• Olympus's SP-500 

UZ ($379.99, WWW 

SLR! Shoot! Shoot! .olympusamerica 

.com) is a 6-
megapixel camera with a 10x optical 
zoom. It has 27 shooting modes and 

a 2.5-inch LCD. Olympus's Evolt E-500 
($799) is an 8-megapixel digital SLR 
with 25 shooting modes, a 2.5-

inch LCD, and xD-Picture Card and 
CompactFlash compatibility. 

• Ricoh's Caplio R3 (price TBD, www 
.ricoh-usa .com) is a compact 5-

megapixel camera with a 7.lx optical 
zoom. Its vibration -cancelling system 

stabilizes the image when it senses 
excessive camera shaking. 

• Sony's Cyber-shot DSC-R1 ($999.95, 
www.sonystyle.com) is a 10.3-
megapixel camera that uses an APS 
(advanced photo system) CMOS image 
sensor and a Carl Zeiss Vario-Sonnar 
5x-optical-zoom lens. 

• Pentax's 6-megapixel Optio 56 ($350, 
www.pentaximaging.com) measures a 
compact 3.4 by 2.1by0.7 inches. It has 
a 2.5-inch LCD and 3x optical zoom. 

• Leica's 8.4-megapixel D-Lux 2 (price 
TBD, www.leica-camera.com) has 4x 
optical zoom and a stylish aluminum 
body.-Michelle Victoria 

g 



Intel 101 
>>>>>>>>>>>>>>, 
A MONTHLY GUIDE TO INTEL BUZZWORDS 

NORTH BRIDGE AND SOUTH BRIDGE 
What they are: Bridge chips control a microprocessor's communications with the rest 
of the computer and its peripherals. Typically, the North Bridge communicates with 
RAM and graphics, while the South Bridge communicates with such 1/ 0 goodies as 
USB, FireWire, and hard drives. 
What the Apple equivalents are: Apple designs custom bridge chips for its machines, 
but instead of identifying them as North Bridge and South Bridge chips, it gives them 
individual names. For example, the equivalent of the North Bridge in a dual-processor 
Power Mac GS is called the U3H; in an iMac GS, it's called the U3 Lite- the reason fo r its 
Lite designation may be because it hands off its PCl-communication duties to its South 
Bridge equivalent, named Shasta (called K2 in the more-powerful Macs). PowerBooks, 
iBooks, and Mac minis combine both North Bridge and South Bridge functions into a 
single chip called Intrepid . 
Why you should care: Intel, like Apple, makes a variety of North Bridge and South 
Bridge chips with different levels of performance . An Intel-box manufacturer-which 
Apple is about to become-can shop on Intel's Web site to learn the capabilities 
of the various bridge chips. You can check out Intel's offerings yourself to find out 
whether the ones Apple chooses for its upcoming Mactel machines are Performance, 
Mainstream, or Value models (www.intel.com/products/chipsets/index.htm is a good 
place to start) . Also, Intel recently demonstrated a Pentium M prototype with the 
North Bridge's graphics controller and memory hub (GMCH) capabilities right on the 
chip itself-a development that should speed performance.-Rik Myslewski 

Bug of the Month 
'->> ), 
MAC OS X FREEZES WHILE WEB·BROWSING 

Sometimes your Mac freezes while you ' re browsing the Web-a Web page 
suddenly stops loading, your Mac becomes completely unresponsive, and 

you have to shut it down by pressing and holding the power button for S seconds. 
Double-plus uncool. 

The root cause for this annoying behavior is a long-standing bug in /ookupd-a 
Mac OS X Unix background process, also known as a daemon. The quick-and-dirty 
workaround is to simply power-cycle your network adapter (router, cable or DSL 
modem, et cetera) or disconnect an active Ethernet cable. Doing so will temporarily 
free lookupd from active network processes and allow normal system operation 
to resume. If the problem happens often, however, bring in the heavy artillery by 
using the following workarounds . 

TIME OUT In the Terminal, set a higher timeout period for the lookupd process. 
Launch the Terminal (/Applications/Utilities) and enter the following commands, 
pressing Return after each one. 

sudo mkdir /etc/lookupd 
sudo sh -c "echo TimeToLive 300 > /etc/lookupd/hosts" 
sudo sh -c "echo ValidateCache NO » /etc/lookupd/hosts" 
After entering these commands, restart your Mac, and power-cycle any network 

adapters (cable or DSL modems), AirPort base stations, other routers, and so on . 
CLEAR CACHE Clear the lookupd cache, which may have corrupt files. Launch 

Terminal, type* lookupd -flushcache, and press Return . 
TRY SOFTWARE Install Unlockupd (free, on the Disc or 

download from www.dshadow.com/software/unlockupd) , which 
periodically checks lookupd and forces it to restart if it fails . 

ON THE 
DISC 

Unlockupd 

Disk drives don't last 
forever, but your 
data can with ... 

SoftRAID®3 
Real-Time 

Data Protection 
that's 

Get a free demo at 
www.softraid.com 

SoftRAID, LLC 
44801 Main Street 

P.O. Box 1600 
Mendocino, CA 95460-1600 

SoftRAID is a t rademark of SoftRAID LLC 
Mac and the Mac logo are trademarks of 

Apple Computer, Inc., registered in the U.S. 
and other countries. 
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ANOTHER CIVILIZATION RISING 
Ever since the release of Civilization Ill : Complete, turn

based tactical gameplay has been alive and well-but it 
was really just practice for Civilization IV. Coming in 2006, the 
latest entry in game guru Sid Meier's empire-building series 
continues to balance religion, technology, diplomacy, and 
war-only this time in eye-popping 30. Play as one of 18 nations 
from the U.S. to Mongolia, choose a historical leader, and guide 
your empire through human history from stone axes to space 
shuttles . Each civilization has unique military units and tactics 

MASSIVELY CHEAP MMORPG 
~ Are you a massively multiplayer on line role-playing gamer 
who's watching your gold purse? Give Dofus a try; this 20 
anime-inspired tactical MMORPG (think Tactics Ogre on Game 
Boy Advance or Disgaea: Hour of Darkness on PS2) casts you as 
a cute fantasy character exploring the colorful world of Dofus in 
real time. When you fight monsters or other players, the action 
swings into turn-based play and becomes a chess-like battle 
of wits. Play in your Web browser for free for seven days-after 
that, it's $6.90 a month. Get it at www.dofus.com .-MO 

and can claim victory through a combination of diplomatic 
maneuvering, technological and resource dominance, alliances, 
and - everyone's favorite-good ol' fashioned world conquest. 
Veteran Civ addicts will cheer at the better 
maps; improved interface (with more info 
selectable onscreen) ; and the ability to share 
wonder effects, resources, and territory in 
on line multi player games. 
-Matt Osborn 

GET IN AT THE 
GROUND LEVEL 
~ Second Life is a go-anywhere, 
do-anything MMORPG-and now 
the $10 fee for a single account 
is history. So how does Second 
Life make its money? Land. If you 
want a permanent villa in the 
virtual world , new land costs you 
about $129 (plus $25 per month 
to maintain it) . Owning virtual dirt is 
optional, but the online-real-estate-as
income-stream model could open up a 
new can of online worms.-MO 

! 

Civilization IV 

I Price l TBD I 
I Available I 2006 I 

AspyrMedia 
www.aspyr.com 

linden Research 
http://secondlife.com 

Hmm ... don't you think those leg 
warmers are a bit over-the-top? 

TIPS & TRICKS: COMMAND & CONQUER GENERALS: ZERO HOUR MODS 
You've played through all the campaigns in the Command & 

Conquer Generals: Zero Hour expansion pack and dazzled 
the online world with your tactical brilliance. Now, armchair
general guy, try enhancing your game with these mods, 
brought to you by the good folks at Macologist (www 
. macologist.org) . 
MIDEAST CRISIS Mideast Crisis puts you in the middle of a 
struggle between Syria and Israel. Syria uses large amounts 
of old Russian technology, while Israel uses cutting-edge 
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technology with precision . There are no campaigns, so 
playing on line on GameRanger (www.gameranger.com) is 
your best bet. Oh, and make sure to keep the original Zero 
Hour audio tracks in the Tracks folder, or the game will crash 
on startup . 
IMPERIAL ASSAULT Choose between the Galactic Empire 
or the Rebel Alliance in this Star Wars-themed mod. Install 
the patch that comes with the mod to better balance the two 
armies.-MO 



French Italian German Japanese 
Indonesian 

Portuguese 

Chinese Vietnamese Russian 
English Spanish Farsi 

(US or UK) (Latin America or Spain) 

Award-winning software successfully used by 
U.S. State Department diplomats, Fortune 500" 
executives and millions of people worldwide. 

Step-by-step immersion instruction in all key language skills: 

Listening - Rosetta Stone uses native speakers and 
everyday language to develop your understanding of 
the spoken language naturally and easily. 

Reading - Text exercises develop your reading 
ski lls by linking written language to real-life objects, 

--- actions and ideas. 

Speaking - Speech-recognition feature records, 
diagrams and compares your voice to the native 
speaker's, grading your pronunciation. 

Writing - Dictation exercises evaluate your spelling, 
syntax and punctuation. 

" ... your program is the absolute best, bar none. I am 

shocked at how quickly I learn." 

- Michael Murphy 
Texas, USA 

"Stupendous ... the juxtaposition of text, sound and picture 
was masterful. The quality of both sound and graphics 

was first rate." 

- The Boston Globe 

Thai 
Korean 
Hindi 

Arabic 
Hebrew 
Greek 

Turkish 
Danish 
Swahili 

Polish 
Welsh 
Dutch 

Swedish 
Pashto 
Latin 

Great Holiday Gift Idea 

Level 1 Program 
Regularly ..$l&5:1Rf 

0 
Your Price 

$175.50 

Level 2 Program 
Regularly~ 

0 
Your Price 

$202.50 

SAVE 
10°/o 

Level 1 &2 
Regularly ..$329:01f 

BEST VALUE! 
(!) 

Your Price 

$296.10 

Personal Edition. Solutions for organizations also available. 

Call today or buy on line for a 10% discount. 

RosettaStone.com/mas 125 
1-800-399-6162 

Use promotional code masl 25 when ordering. 

Give the gift they'll be talking about all year! 

Language Le arning 
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SHAREWARE PICK OF THE MONTH 

f·j!f!®iibfjffli www.icedaudio.com $69.95 donationware 

ON THE 
DISC 

AudioFinder 3.8.3 

G arageBand, Soundtrack Pro, Logic Pro-whatever your audio-editing level, the one thing that these fab packages all lack is a 
utility for managing your audio samples. AudioFinder fills this space with loop editing, beat slicing, and bit- and sample-rate 

conversion-and that's just a sliver of what it can do. It can also easily break out individual sound samples from an audio track, save 
them as separate files, and turn them into a sampler instrument in Logic Pro. Here's how.-Andrew Tokuda 

0 Launch Audiofinder, then use the 
Browser to go directly to your audio 
files, or use the Scanner to search your 
audio files. 
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@With your 

multisample audio 

file selected, choose 
Signal> Sample 
Extractor. 

XG\1tcher ' X 

Stueo8001ttr 
SwapChannt J' 
Stueo Mix to Mono ,, 
S{ereoSpll1100ualMono ' L 
Join Du~l Mono to '.)lttto I 
CopyltfttORlgh1 Ch1nMI 
CopyRlghlto~ftChAnnet 

Splltc m °'ltM<l1ng OHIU '0 
SpHcit1nAutnc11n901der 
Mirror Forwardfhckwird ' M 
Mirror Bilckward/ Forwltd ' XM 
Double lrngth ' O 

Conven lltt Otpth and Sample lliltt ' C 
Altt1SJmp!tll.~1t A 
St;rftl'lttil and Spud 
PltchAnalyu1 ... 

Auto Crop ' U 

€) Once you extract 

samples from your 
original track, you can 

rename each one by 
Control-clicking it. 

0 You can turn an audio file into an EXS 

Instrument-Logic's software sampler-by 
Control-clicking it and choosing Convert> 

Convert To EXS Instrument. 

' Track 15 

..: tradt lS 
!dh!f!M Mlfod!llJ 

I Track 15 0002 _~ Meta Editor 

:,:i Track 15 0004. Convert 
Tuck 15 0003.~ Open With 

j ~i« rruk 15 0005 . Color Llbel 
1 Tu ck 15 0006.a 

! . 

..., Tr.ick i s 0001. Reveal In Mac OS x 
~ Track 16 Show In Browser 
~ Track 1 7 

:5 ~~:~~ t: • "1'w1'm
01
1d'1' .. . 

':: Tr.ck 20 Power Renime .. . 

0 In Logic Pro, the 

EXS24 sampler now 
has a new patch 

created from the 
audio sample you 

~ Truk 21 BPM Rename 
~ Trick2Z 
_ r r.ick 25 
~ Tr.a.ck2Ei 
~ 1rack27 

~ Tr.ick211 
~ Tr.uk29 

~~m~ ~~ 

AudloUntt Puxeu 
Sa.mp le Extractor ... 
Pl1ChAn0ilyzer ... 

extracted . 

• MAC UPGRADES 
A pp le has added new features and upgrades to its .Mac 

on line service. Individual accounts still cost $99.95 
per year, while Family Pack accounts (up to five users) are 

$179.95 annually. 
STORAGE Standard members now get 1GB of combined 
storage. Family Pack accounts get 2GB of total storage. 

GROUPS This new feature allows you to create groupings 
of users with access to a private Web site, message board, 
shared iCal schedule, member list, Group email, photo 
sharing, and more. You can create as many Groups as you 

want, and you're only limited by the amount of storage space 
you have-each Group requires 100MB of storage. 
BACKUP 3 .Mac's backup tool gets a makeover. You can 
now use one of the preset Backup Plans, which include 

backups fo r your Home folder, ilife files, personal data 
and settings, and purchased iTunes music. Backup can 
now perform incremental backups, which save only new or 
recently modified files. The built-in 
Spotlight features let you find 
individual files you want to 
designate for backup. 
-Roman Loyola 

.Mac just got bigger and buffer. 





Available for Mac 
November 2005 
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With Zoo Tycoon® 2, you can get as · close to the animals as you 
want withqut smelling like a zo?keeRe~ .. fee~lhem, build their 
habitats, and manage your own zoa o: ke~p;t~~ guests and the 

• animals satisfie~; you,can 'even keep,a P,.hoto ,~l~um of your special 
moments together. Sa come on, step intq th~ on,ly zoo where yo 
won't step in anything else. 



and h,f,]:11[j.lft.htJ? Here's how to make sure all your gizmos 

have exactly what you need, t§:ft§!Mwhen you need it. 

BY DEBORAH SHADOVITZ 

he address you need is on your Mac at home, but you're 

stuck in the office. The details about tomorrow's big 

meeting are on your Mac at work, 

but you're on the road with your 

'Book-and you're beginning to 

think you might be better off carrying a Day

Timer instead of multiple electronic gadgets 

that each have only a fragment of all your 

information. 

Don't give up. All you need is 

synchronization-and we're here to help. 

We'll show you several ways to make 

sure all your info is the 

same on all your Macs, 

as well as on your iPod, 

cell phone, and even your 

peecee (your secret's safe 

with us). Some of the 

techniques we outline 

work over the Internet; 

others require your Macs to be networked 

together; and several involve using another 

ON THE device to ferry data-but any of 

DISC them will help you keep your 
ChronoSync, 
You Synchronize info-seeking head above water. 
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You may not be 
able to resolve 
some .Mac sync 
conflicts while 
the related apps 
are running. If 
you repeatedly 
seethe same 
conflict report, 
quit the problem 
apps,andthen 
rerun the sync 
process. 

GETTING 
FROM A TO B 
In the following 
explanations, we 
refer to the two Macs 
involved as Mac A 
and Mac B, but it 
doesn't much matter 
whether A is your 
Mac at home and B 
your 'Book, or the 
other way 'round. In 
general, however, 
it's best to start each 
process on the Mac 
that already has most 
of the information you 
want to share. 

If you 're just looking for a way to coordinate basic info among multiple Macs, consider springing for a .Mac account 

($99.95 per year for 1GB of storage, $179.95 per year for a five-account Family Pack with 2GB of total storage) . Your 

account gives you an easy, built-in way to synchronize your contacts, calendar items, and a limited amount of other data. 

Once you've set up your .Mac account, it's time to prep it for the syncing process. Open System Preferences on 

Mac A and select .Mac from the Internet & Network pane. Enter your Member Name and Password, click the Sync 

tab, and check Sync With .Mac. Choose Manually, at least the first time. (After you're sure it works, you might want 

to go with a timed schedule.) Lastly, check the items you 'd like to sync-you can sync your Address Book contacts; 

iCal Events and To Do items; Safari bookmarks; Keychain passwords; and Mail's account rules, signatures, and 

Smart Mailboxes (but not account passwords) . 
The first time you do this, you'll be asked what kind of syncing you want to do. The choices are: 

• Have the data on your current Mac override any data already on .Mac. 

• Have the data on .Mac replace what's on your Mac. 

• Merge the data on .Mac with the data on your 

current Mac. 

Assuming you've followed our advice (see " Getting from A 

to B," above) and started the process from the Mac that has 

most of the data you want on it, choose the first option-to 

place that data on .Mac. Later, when you're on Mac B, follow 

the same process; only this time, choose to have the .Mac data 

replace what's on Mac B. Presto! Both Macs now have the same 

info. From now on, .Mac won't ask you if you'd like to overwrite 

fi.les-instead, the syncing routine will automatically merge the 

data in both directions, so any changes you make on one Mac 

(either A or B) will be reflected on the other. 

In the Sync pane, you can set a schedule for automatic 

syncing, which happens almost invisibly. The sync engine watches 

for changes in your Apple-supplied organization apps, and you'll 

only hear from it if you've changed the same item on more than 

one Mac. If that's the case, the 

Conflict Resolver shows you the info 

in each record and which Mac that 

data is on; it then lets you pick which 

to keep and which to throw away. 

II . 

Getting a .Mac account is 
the easiest way to start 

synchronizing data across 
multiple Macs. 

.Mat 

! Account 5opK 4 lDbk AdY1.nced ) 

~ SynchrOlll:te: with .Mile: !'-"M='""=''~'-----'"-': I 

.mac 
Syncing M.lc: 

t_ , M~IAccounts 

Ma.111\uln , Slgrwwru, and Sman Ma.llboxu 

Alert 

You are. about to sync the followlng informat ion 
wit h .Mac 

•Contacts 

What would you like to do for thi'" first sync? 

( ~~erge data on this computer and .Mac I : t 

SYNC YOUR EMAIL-NOT! P~[]G;' CONS \.; i.;:a • ;,.J 
;:,; Easy to use. • Doesn' t sync 

::; Works across 
multiple Macs • • 

r-t Works across 
the Internet. 

n Can be • 
scheduled and 
automated. 

documents. 

Costs $99.95 
or more per 
year. 

Doesn't work 
with non·Apple 
calendar or 
contact apps. 

While the .Mac method of syncing Macs matches up your Mail and 

Address Book contacts, it doesn't sync your actual email. If you 
want to have the same email messages on multiple machines, 

you'll have to try one of these alternate methods. 
One way is to simply set the email apps on all of your Macs but 

one to leave your messages on the server. Then only that one (call 
it the primary Mac) will be empowered to delete the messages 
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If you want to 
sync a folder 
that's standard 
on all your Macs, 
such as Music 
or Pictures, 
you can choose 
QuickSync and 
pick the folder 
from a menu 
rather than 
navigating to 
it the old· 
fashioned way. 

Contact l ist 

- Add New Emall 

=net.~1 
JK~bt.Kg~"leJ,tOfl'I 
~lt9ri11~1t.<;l)m 
jM'ltUsmacwot1d.com 
~~a.buom 

t::=.com 
',t.t!OicltttJnMll~~com 
JW2bwtlil1t."'1COfll .tom 
~m.:tlon.com 

1.,fwlnc1~.com 

If both of your to-be-synced computers-yes, computers as in Mac or Windows-have high-speed Internet 
access, FolderShare is the easiest way to synchronize your files . With this for-fee service, you can sync any 
folder (or folders) with any number of Macs or Windows-based computers. It also provides two excellent 
bonuses: First, you can share a folder with other people ; and second, you can access your own files from any 
Web browser (which can be a real butt-saver sometimes) as long as your computer is running and online. 

Start by downloading the free version of FolderShare from www.foldershare.com and installing it on all the 
computers among which you want to share files. Then, with FolderShare running, log in from Mac A by choosing 
My FolderShare from the new FolderShare menu at the right 
of your menu bar, and create an account (with nickname 
and password) by stepp ing through the login wizard that 
appears. Once that's done, open your FolderShare home 
page in your browser. Repeat the process on Mac B, only this 
time tell the wizard you already have an account. 

To set up synchronization, click the Sync My Folders 
icon on your My FolderShare Web page, and choose (or 
create) a folder on your Mac to sync. The volume the folder 
is on will then show up under Configured Devices in the 
FolderShare browser window. Next, select one of your other 
to-be-synced computers from the Available Devices list on 
the left and choose (or create) the folder on the computer 
that you want to sync to. That's it, really. Your two folders 

KHpfold1r11ynchronlud 
bothltMnrnyr:ompu11n. 

My Librarie• 

FolderShare lets you sync files (even with PCs!), 

share files, or grab your files from wherever you are. 

will now automatically sync; as soon as you save a chan ged file to the synced folder on the computer you' re 
working on, it'll overwrite the file in the proper folder on the other computer-or it will the next time you log in 
on that computer. If you want to sync more devices, choose another and repeat the process. The transfers are 
encrypted and sent directly from one computer to the other-your files never reside on FolderShare servers. 

The free Basic plan lets you share two folders with a 500 -file limit on each. If you upgrade to the Personal 
($49.95 per year) or Professional ($99.95 per year) plan, you get to sync more and bigger folders. You also get 
to set up FolderShare to sync with another person. (You can share files with others on the Basic plan, but the 
other person merely has read -only access.) To share with others, instead of choosing Sync My Folders on your 
My FolderShare Web page, you choose Share With Others and specify a folder. Then enter your colleague's 
email address, set the permissions level, and add a personal message. FolderShare sends your colleague an 
email with an Access Files link. Once that person has installed 
FolderShare, logged into your account, and specified a folder to 

r ~ 
ac 

People To Invite 
share, whenever either one of you makes a 
change to your synced folders, the change 
will be reflected on the other's computer. 

I • 

PROS 
Iii Works with Macs 

and PCs. 

m Works among 
multiple 
computers. 

CONS 
• Syncing requires 

computers to 
be online and 
awake. 

NOTE! f'l&iN• wetl'J lhe - l addrfftn 1.11~ eorreetbofof• u1Dc:1.n9 No.l Tho cOf!leflb of 11'9 Hb 
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The last option on the My FolderShare 
Web page is Access My Files, which (if you 
have a Personal or Professional account) 
lets you use your browser to log into 
FolderShare and download files from any 
of your shared volumes, whether they're in 
a shared folder or not. 

:W Offers option to 
download files 
and share them 
with others. 

• Advanced 
features require 
yearly fee. 

FolderShare reads your Address Book and 

gives you a list of potential sharers. 

from the server-the others will download your messages but 
leave copies behind so other Macs can download them, too. To 
pull off this trick in Mail, go to Preferences> Accounts, click the 
Advanced tab, and make sure the Remove Copy From Server After 
Retrieving A Message option is unchecked; repeat this on all of 
your Macs except your primary one. On the primary Mac, check 
that option and, from the pop -up menu beneath it, choose After 
One Day or After One Month-however long you need to make sure 
your other computers can download your messages, as well. 

A better way is to keep all your mail on the mail server all the time. 
For that, you'll need to set up an email account as IMAP (Internet 
Messaging Access Protocol) rather than POP (Post Office Protocol). 
A .Mac account is IMAP by default; if your mail account is elsewhere, 
check with your mail-service provider to see if you can use IMAP. 
Unfortunately, many (if not most) service providers still don't offer it. 

These approaches work across platforms. If you want to use 
Entourage on one Mac, Mailsmith on another, and some flavor of 
Outlook on your PC, feel free. 
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If you use 
ChronoSync 
for backup
for example, to 
sync a folder 
toa CD-you 
can save space 
by choosing 
not to archive 
deletions. 

The basis of ChronoSync ($30, on the Disc or download 
from http://www.econtechnologies.com) is a synchronizer 
document-a file that contains the setup information needed to 
sync two folders. You create one synchronizer document on each 
Mac for each folder or volume you want to sync, specifying rules, 

sync direction, verification and logging options, and so on. You 
can collect multiple synchronizer documents into a container 
document and later call them all into action at once. 

Start by going to Mac A and mounting Mac B (or an 

external drive) on its desktop. Launch ChronoSync, and 
the sync setup window appears. Drag the folder or volume 
to be synced on Mac A into the Left Target area, and drag 
the corresponding folder or volume on Mac B into the Right 

ChronoSync provides the security of placing your 
deleted files in an archive-just in case. 

Target area. (It doesn't really matter which one goes on the left or right; the sides are just visual cues.) Choose 
Bidirectional so the sync goes both ways, letting ChronoSync keep the newest files on both targets . Check Sync 

Deletions to have ChronoSync delete files on one Mac if it sees that they were removed from the other; you can 
opt to have them moved to an archive if you want, just to be safe. 

If you'd like to exclude any files from synchronization that are inside the folder you've set to be synced, 
click the Analyze icon, Control-click the items you don't want to sync, and choose Exclude . You can set up 

Rules to include files based on such criteria as file extension and date modified; you can also use Rules to 
exclude files for the same reasons . Finally, save your new synchronizer document. If you're using an external 
device to carry your files between Macs, you'll need to repeat the setup process for that device and Mac 
B-just be sure to get in the habit of syncing before and after you work on each Mac. But if the two Macs are 
networked, at this point you're good to go-just click the Synchronize icon in the toolbar. Or if you'd rather, 
click the Schedule icon to tell ChronoSync when or how often to run the sync. 

ChronoSync also includes Trial Sync, which shows what'll 
happen if you run your planned sync. And finally, if you've set 

the sync to run automatically on networked Macs, you can opt 
to receive notification by email that it has been completed. 

SYNC HELPERS 
You can still use ChronoSync, FoldersSynchronizer X, and You 
Synchronize even if your Macs aren't on the same network 
by using an intermediary device-an iPod, Palm OS PDA, or 
external hard drive or flash drive-to transport files. Here's how. 

iPOD Your iPod is a terrific little carrier for Address Book 
contacts and iCal Events and To Do items because you can 
copy them to the 'Pod automatically when you sync your music. 
Unfortunately, you can't copy them off to another Mac the same 
way-automatic syncing only works in the Mac-to-iPod direction. 
However, you can still use you iPod as a syncing intermediary, 
because your Address Book info saves as VCF files, and your iCal 

24 MacAddlct December 2005 



~rnlJ[}{]@[ID ~~ FOLDERSSYNCHRONIZER X 

To check that 
you've set 
everything 
up correctly 
before you 
run your sync, 
you can check 
Show Preview 
under the 
General pane 
in Preferences. 
Just remember 
that this setting 
will still be on 
during your next 
session. 

6 0 0 FoldersSynchronizer 3. 5.4 O 

o;fa~lt Sy-;;c Session - :i 

The buttons at the right of the 
FoldersSynchronizer X main interface 
provide access to options such as 
finding files to sync according to 

Ljke ChronoSync, FoldersSynchronizer X ($20 for Lite Version, $40 
for Full Version, www.softobe.com) syncs by creating a document
in this case, a session file . To set up FoldersSynchronizer X, mount 
Mac Boran external drive onto the desktop of Mac A and launch 
FoldersSynchronizer X. In the Default Session window that appears, 
drag one folder or volume to be synced onto the top folder icon, and 
then drag the counterpart on the other disk or Mac onto the lower 
folder icon. (It doesn't matter which volume or folder goes on the 
top or bottom.) By default, FoldersSynchronizer X uses two-way 
sync: New files copy in both directions, and the most recently 
modified version of a file on whichever side overwrites the other 
one. If you're paranoid about losing data, you can use the Conflicts 
pane to set up alternative ways to handle files, such as skipping any 
files that have been modified on both sides or copying the modified 
files in both directions. 

To get rid of deleted files-so they don't keep getting copied 
back and forth-click the S button and check Exact Sync in the 
resulting dialog box. 
Save and name the 
session file, and 

particular criteria. click Synchronize. 
During your first 

sync, no files will be deleted, even with the Exact Sync option 
on; instead, both folders will add files until they're matched. 

If you're syncing networked Macs, you're done. If you're 
using an intermediary device, you just need to repeat this 
process with your other Mac. Then, to keep things in sync, 
remember to run your session file before and after working at 
each location. 

You can save multiple session files and run them all at the 
same time to sync several different folders on one Mac or disk 
to corresponding folders on the other. Just keep creating new 
session files as described above; to sync all the paired volumes 
or folders at once, choose All from the pop-up menu in the 
main window, and click the Synchronize button in the center. 
Alternatively, you could go up to the menu bar and choose 
Options > Multiple and make a list of folders to be synced 
in a table, putting one item on the left of each row and its 
corresponding item on the right. 

stuff saves as one ICS file per calendar. Just open the iPod in disk 
mode on the second Mac and manually copy the files over; double
click them, and Address Book and iCal will automatically add the 
data. Unfortunately, you can't do the same to get your files onto a PC: 

HARD DRIVE OR FLASH DRIVE Mac-to-Mac synchronization is 
simple-just sync one Mac with a folder on the drive, then sync that 
folder with the corresponding folder on the second Mac. But if you 
want to sync your Mac to a PC, you'll quickly find that your Mac
formatted drive won't mount on a PC, and your Mac can't write to a 
standard Windows XP NTSF-formatted hard drive. If you format the 
drive as FAT32, however-which Apple's Disk Utility can do-then 
both computers can read and write to it. But the FAT32 format 
doesn't carry Mac resource forks (necessary for files from Pro Tools, 
Final Cut Pro, and many other media-editing applications). 

When you connect a Mac-used iPod to a PC running Windows, you're 
told you need to reformat it in order for it to be read. 

PALM OS PDA It's easy to move your contacts and calendars from 
your Mac to the Palm device; here's how to get the info off your Palm 
and onto another computer: Sync the Palm only with the Mac where 
you tend to add the most new addresses and appointments. On the 
other computer, choose to have the Palm device always overwrite 
the computer's data. When using the second computer, always enter 
new data on the Palm itself, not the computer. 

The best solution? Keep your Mac formatting on your external drive 
and get Mediafour's MacDrive 6 ($49.95, www.mediafour.com) for 
your PC. MacDrive supports all media, including flash drives. 
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~rnLr[}{]@rnJ ®~ YOU SYNCHRONIZE 
ChronoSync has synchronizer documents; FoldersSychronizer has sessions; You Synchronize ($49.95, on the 

Disc or download from www.yousoftware.com) has projects. Each pair of folders or volumes to be synchronized 

makes up one project, and by now, you can probably guess how the process of creating a project goes. When 
you launch You Synchronize, a Default Project window appears. Click the Settings button to get to the setup 
window, and drag the folder or volume to be synced from Mac A into the Local Folder area (you can also navigate 

to it or create a new one using the Select Folder button, also in the Local Folder area). Next, drag the folder you 
want to sync with on Mac Boran external drive into the Remote Folder area. (As with ChronoSync's Left and 

Right targets, Local and Remote is really just a way to differentiate the two devices-it doesn't matter which is 
which.) Keep the default Type set to Two Way Synchronization so that changed files always replace older ones 

e you synchronize 
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SYNC YOUR PHONE 
The always-with-you-ness of a cell phone isn't helpful if you 
don't have your phone numbers with you as well. Every phone 
has a built-in address book-so wouldn't it be great to be able 

to sync your Mac's Address Book contacts with your cell phone? 
Well, you can, maybe-all it depends on which phone you have 

and which carrier you use. 
The first thing you have to do is connect your phone to your 

Mac. You have two choices: Bluetooth or USB cable. Phones don't 
usually come with USB cables, but you may be able to purchase 
one from your cellular provider or phone manufacturer. Otherwise 
(or also) ask them which cable they recommend-many are 
available from Susteen at www.datapilot.com/shop_cables.htm. 

Once you're connected, there are a couple of ways to actually 

transfer the data. The easiest way is to use Apple's iSync, which 
should already be on your Mac as part of OS X (if not, download 
it from www.apple.com/support/downloads/isync.html). It 
supports a lot of phones (listed at www.apple.com/macosx/ 

features/isync/devices.html), but iSync only syncs Address 
Book contacts and iCal entries, not pictures and ringtones. 
Furthermore, even if your phone is listed as supported, it may 
not actually work-carriers sometimes ask phone manufacturers 
to limit a phone's features. For example, on the first Bluetooth 
phone Verizon offered, the Motorola v710, Verizon didn't allow 
Bluetooth sync-they only authorized the use of a wireless 
headset. 

If your phone doesn't work with iSync, you'll need to find 
software that does. The most-talked-about app on cell-phone 
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In Trash.) You can also play it safe by clicking Inspect to 
preview the proposed sync and clearly see which files will 

be replaced, added, or deleted. To exclude items inside 
the folders being synced, click the Exclude Files button at 

You Synchronize features four ways to determine which files 

have been changed and need syncing, which-the company 

claims-increases accuracy and reduces lost data. 

iSync 

.mac Zir<!7LD ... 

Motorola Phone 
For firs t sync: ['_M_e-rg_e_d_a-ta- o n- co- m- pu_t_e_r -an_d_ d-ev_ic_e ___ ,_:"""l 
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~ Contacts ________________ ~ 

Synchronize: ! ACN/consultants ~ : f ( Options .. . ) 
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Events Time Zone: America/Los_Ange les 

You can use iSync to put your Address Book contacts on your 

phone-if you've got the right kind of phone, can connect it to your 

Mac, and your provider hasn't disabled syncing. 



You can click 
on the Schedule 
Icon in You 
Synchronize's 
toolbarto 
automate the 
sync process. 
However, 
unlike with 
ChronoSync 
and Folders· 
Synchronizer 
X,you must 
mount the 
external volume 
yourself-there's 
no automount 
feature. 

the bottom of the Settings window, click New, specify the Type 
of item, click Select, and navigate to the unwanted folder or file . 
Satisfied? Just click Sync. 

You Synchronize gives you four choices of how to determine 
if a file has been modified since the last sync : checksum 
comparison , file signature, checksum plus modification date, or 
modification date only. The company claims that the checksum 
comparison plus the database the software maintains about 
your projects makes You Synchronize's syncing more reliable 
than simple modification-date checking. You trade time for 
accuracy, though-the checksum comparison can take a while. 

Projects automatically store as you create them, and you 
can choose which one to run by selecting it from the Projects 
Drawer at the side of the main window or from the pop-up 
list under the Projects icon in the tool bar. You can only run 
one project at a time, though you can schedule several to run 
sequentially. 

No matter how you get your 
data from you Mac to your phone, 
you may still face hurdles, as the 
format of imported data is partly 
phone dependent. For example, 

email lists is a piece of open-source freeware called BitPim (free, 
bitpim.sourceforge.net). As with much open-source software, 
however, support is minimal to nonexistent. Another choice is 
OnSync ($12, www.onmadesoft.com) . But the most-developed 
commercial product-and the best choice for most people-is 
Susteen's DataPilot for Mac OS X, ($34.95, www.datapilot LG phones put all the info for one person in a single record . 
. com) . DataPilot's Universal Kit for Mac ($100) comes with 
DataPilot phone transfer software and a whole slew of cables. 
The software transfers Address Book contacts, iCal calendars, 
ringtones, and photos. It's carrier-agnostic and supports most 
late-model phones from Motorola, LG, 
Samsung, Nokia, Sanyo and Sony. 

CDMA phone carriers-Verizon and 
Sprint, specifically-support an over
the -air technology (generically called 
BREW, for "binary runtime environment 
for wireless") to transfer information to 
their phones. Verizon calls its technology 
Get It Now (GIN). Sprint calls it Sprint 
PCS Vision , and for installing games 
or ringtones , it's a great solution. 
Unfortunately for us Mac folks, BREW 
contact and calendar providers don't 
yet support the Mac. And because 
Verizon would prefer you to use GIN, it 

But when you sync to a Motorola phone, Data Pilot warns you 
that only one number can be stored for each entry; if you have 
multiple phone numbers for someone, you'll need to create extra 
address book entries for them . 
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does not fully support Bluetooth on its 
phones-and it doesn't officially support a 
Mac-friendly cable -syncing solution . (We 
did get our Verizon phone to work with the 
DataPilot kit, though.) 

Phones that don't work with iSync might work with Data Pilot, which lets you sync more stuff 
than iSync does. 

,~Deborah Shadovitz's favorite thing about setting up a syn chronization system for 
~her clients is that it forces them to keep their files in organized folders. 
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100's of Prices Slashed! Call or visit macmall.com! 

The NEW iPod nano 
Even though the iPod® nano is 1 /5 the size of the original iPod, it still packs incredible 
audio fidelity into a sleek and eye-catching design that's as thin as a pencil! It weighs 
just 1.5 ounces but holds up to 1,000 of your favorite songs or thousands of photos! 

NEW! iPod nano startingat$194f 
The coolest iPod accessories! 

Mac® mini G4 
up to 1.42GHz 
Up to 256MB SDRAM; exp. to 1 GB 
Up to 80GB Serial ATA hard drive 
Combo Drive (DVD/CD-AW) or 
SuperDrive (DVD±R/CD-RW) 
10/1 OOBT Ethernet networking 
Optional AirPort + Bluetooth 2.0 

starting at 

$474! 

eMaC'M G4 
up to 1.42GHz 
17" built-in display (16" vis. ) 
Up to 512MB SDRAM; exp. to 1 G 
Up to 160GB Serial ATA hard dril 
Combo Drive (OVD/CD-RW) or 
SuperDrive (DVD±R/CD-RW) 

starting at 

$794! 
Rnance for as low as 520/mo 

'WE'LL BEAT ANY PRICE or (Offij)etitivepromotlOO on MIY Apple cornpu1er. We may require proof of dealer\ pr1dfl<} 
CompetitDl must be un /itJp!eAuthonzed ReseHer.Produa must be in stock at the competitionAdvt'l'tiseditem mu~ be 
idenlrc.1! 10 the one offeied by MacM.ill and must be• oew item in• factory sealed bo~ \Vereser.~ the righ110 limi1 
quantity ord.,ed. This off!!< does not apply lo special.bonul or free offers,9..00opening•special purchases or special 
boys.manufacturer's rebotes,doseouts,ooron<es or 1odealers'one-of-"'1<rnd or other limited quantity offers. Nor does tt 
•Pf~Y to advertising errors nooe by any •uthorized de~er.No1 open iodealers. Void where prohibited. lorry, off er not 
valid in conjuncuon wilh other reb.lie offers. Oo multiple-item quotes:'We11 Beat Any Pri<e" appli5 to the price of the 

The hottest software deals! 



INSTANT 
SAVINGS! 

Save even more 
than our advertised 
price by shopping 
online or calling. 
Prices are too low 

to advertise! 
Look for the shopping cart symbol 

for models that qualify. 
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iBook® G4 iMac® G5 
up to 1.4GHz up to 2GHz! 
512MB SDRAM; exp. to 1.SGB Up to 512MB SDRAM; exp. to 2GB 
Up to 60GB ATA/100 hard disk drive Up to 250GB Serial ATA hard drive 
Combo Drive (DVD/CD-RW) or Combo Drive (DVD/CD-RW) or 
SuperDrive (DVD±R/CD-RW) SuperDrive (DVD±R/CD-RW) 
AirPort® Extreme + Bluetooth 2.0 AirPort® Extreme + Bluetooth 2.0 

starting at starting at 

$994! $1,294! 
Finance for as low as 520/mo Finance for as low as $39/mo 

ti Authorized Reseller 

PowerBook® G4 Power Mac® G5 
up to 1.67GHz up to 2. 7GHz! 
512MB SDRAM; exp. to 1.25GB PowerPC'" GS dual processors 
Up to 100GB Ultra ATA hard drive 512MB DDR RAM; expandable to BGB 
Combo Drive (DVD/CD-RW) or Up to 250GB Serial ATA hard disk drive 
SuperDrive (DVD±R/CD-RW) 16X Dual Layer SuperDrive'" 
AirPort® Extreme + Bluetooth 2. O Gigabit Ethernet networking 

starting at starting at 

$1,494! $~994! 
Finance for as low as 545/mo Finance for as low as 560/mo 

entiie order, not individual line item>Offer applies to pre· taxed prices on~. Offer valid only at time ol purchase, not aftertho fact. !FREE RAM OFFER·FREE up to I GB total p!emium RAM for your eMac or iMac after MacMall mail·in rebate. This offer is for a branded 51 lMB memory 
module. Total RAM stated is based on initial RAM configuration of eMac or iMac +the SllMB upgrade.A $39.99 installation fee is required. Price of RAM before rebate is $65. FREE up to I.SGS total premium RAM for your Power Mac a her Ma<Mall mail· in rebate. This offer is for 
a branded !GS memory module. Total RAM stated is based on initial RAM configuration of Power Mac+ !he !GB upgrade. A $39.99 installation fee is required. Prke of RAM before rebate is 51 I 9.FREE up to I SGS total premium RAM for your PowerSook or iSook ah er MacMall 
mai~in rebate. This offer~ for a branded IGB memory module. Total RAM stated is based on initial RAM configuration of PowerSook or iBook t the !GS upgrade.A S39.99 installotion fee is required. Price of RAM before rebate is $179. All RAM offers end 12/31105. FREE PRlmfR 
OfFER·Epson CX%00 All·ln-One printer Is free after Sl9 MacMall mail·ln rebate and S20 and SSO Epson mail in rebates with purchase of any Apple Compulerthrough 12/31105. Price before rebaie is $99. Printer model may change without notice. FREE ENGRAVING OFFER-Ga 
yt>Jr iPodiPod nano or iPod mini engraved for FREE when you purchase rt through Mac Moll.Not available for iPod shuffle or U1 iPod.Place your order now, then 11sit www.macmollcom for details. FREE FM TRANSMITTER OFFER-After S t9.99 MacMall mail-in rebate. Prke befme rebate is 
$19.99. Ends 11/31/05. ALL OFFERS VALIDWHILE.\UPPUESLAST. Download rebate coupons al 1W1W.macmaR.com/rebates. 

The best selection of displays and accessories! 

Call MacMall today! 
1-800-965-3282 
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Mr. Pretends-To-Be Healthy 

iFM 
.,..Griffin ..,,.$49.99 
..,,.www.griffintechnology.com 
Music is usually a workout's best friend, 
but some mornings I like to blast my glutes 
to an inane-morning-zoo-talk-radio groove. 
That's where Griffin's little FM tuner comes 
in. It's compact, doubles as a remote so 
I can listen to music during commercials, 
and picks up stations in my area well. 

ACTION JACKET FOR iPOD SHUFFLE 
..,,. DLO ..,,. $24.99 ..,,.www.dlodirect.com 
The iPod shuffle's size and penchant to 
never skip make it ideal for jogging or 
snowboarding out of a burning helicopter. 
This minimalist black number keeps it secure 
and safe from the whims of weather. 

AIRCLICK 
..,,.Griffin ..,,.$39.99 
..,,.www.griffintechnology.com 
This little remote comes in handy 
while biking; just attach it to your 
handlebars with its Velcro strap. 

E4C SOUND-ISOLATING 
HEADPHONES 
..,,. Shure ..,,. $299.99 
..,,.www.shure.com 
Shure's comfortable, flexible, in-ear 
wonders sound great, block out noise, 
and stay in your ears no matter what-but 
the sensation of removing them is akin to 
pulling an octopus out of your ears. 

SEAN MOLLOY, MANAGING EDITOR 

AMP PACK 
..,,. Burton ..,,. $199.95 ..,,.www.burton.com 
When hiking up a vertical cliff during an 
avalanche, Burton's Amp Pack serves my 
need for back-based portable storage 
and on-the-go iPod interfacing-the damn 
thing's got iPod controls built right into 
the friggin' shoulder strap. Oh, and yes, 
it does come in patterns that aren't so 
heinously glaring-but will that keep you 
from getting shot by yeti hunters? 

PUMPPOD 
..,,. PumpPod ..,,. $19 to $49 
..,,.www.pumppod.com 
If you find yourself wandering 
among your gym's glistening white 
machines and strange inflatable 
spheres, Pump Pod offers a series 
of "iPod workouts" (series of still 
photos, really) you can view on 
any photo-ready 'Pod. 

iTOP 
..,,. Nyko ..,,.$29.99 ..,,.www.nyko.com 
Nyko's button relocator keeps me from 
pulling my 20GB iPod from my pocket 
every time I want to skip a song that just 
isn't extreme enough. Certain Coldplay 
ditties can kill an endorphine rush fast. 

MUSICASE 
..,,. iRock ..,,.. $24.99 
..,,.www.myirock.com 
When your extreme hiking pals need a 
rest, break out the Mountain Dew and 
this iPod case with built-in speakers. 

.. 
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Soon-To-Be Soccer Dad 
ROMAN LOYOLA, REVIEWS EDITOR 

iGUY 
~Speck Products ~ $34.95 ~www.speckproducts.com 
It's not just a case; it's also a toy to occupy my boys when over 
the river and through the woods to grandmother's house we go. 

I-DOG 
~Hasbro ~ $29.95 ~ www.hasbrotoyshop.com 
He has a built-in speaker, but most of all, my kids love his 
flashing lights and head movements synced with the music. 

OTTERBOX FOR iPOD 
~Otter Products ~ $49.99 ~www.otterbox.com 
Toddlers want to get their hands on everything, and my 
iPod is no exception. The OtterBox is a waterproof case 
that's also tough enough to survive caveman-like pounding. 

SONIC BOOM BAG 
~Sonic Impact ~ $39 ~www.si-technologies.com 
For me, it's a diaper bag with built-in battery-powered speakers 
and controls in the straps. C'mon kids, it's "Hokey-Pokey" time! 

ICE CREME 
~RadTech ~$35 .95 ~www.radtech.us 

I'd like to blame my boys for scratching up my iPod, but I abuse 
it more than they do. Ice Creme M helps remove the· scratches, 
making my iPod look almost new. (Not shown.) 

TUNEDOK CAR HOLDER FOR iPOD 
~Belkin ~ $29.95 ~www.belkin.com 
My kids have car seats. Might as well 
have one for my iPod, too. 

iCARPLAY WIRELESS PLUS 
~Monster ~ $79.95 
~www.monstercable.com 

My 1993 Ford Explorer was built back 
when the 12-volt socket was known as the 
cigarette lighter, so it's located in the ash 
tray-and the iCarPlay is one of the few 
car adapters that actually fits . Thankfully, 
its reception is quite good. 
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iPAL 
)J>- Tivoli Audio )J>- $149.99 )J>-www.tivoliaudio.com 
iPal isn't the loudest speaker you can plug an iPod into, but it's the 
smartest. Thanks to its rechargeable, replaceable NiMH battery, 
the iPal plays longerthan some of my iPods-and that's when the 
built-in AM/FM radio comes in handy. Add in the 'Poddish styling, 
solid construction, and awesome sound, and I'd call you a sucker 
for using anything else. 

iPOD SOCK 
)J>-Apple )J>-$29 )J>-www.apple.com 
Go ahead and laugh, tough guy, but I've got a brand-spankin'
new nano to protect, and I swear the screen scratches if I look at 
it funny. Besides, I stole the Sock from my girlfriend. Heck, since 
I have a half-dozen different iPods at this point, I might even pop 
for my own six-pack o' socks. 

SOLIO 
..,. Solio ..,. $99.99 )J>-www.solio.com 
I'm not dorky enough to don one of those solar e-vest dealies, 
but I'd hot-glue this bad boy to my favorite beanie-instant 
propellerhead! You say it'll also charge my Dock-connectable 
iPods with power from the sun? That's just gravy. 

iPODONUT 
)J>- Frontfield )J>-www.ipodonut.com 
)J>- $9.95 ($9 for third-generation-iPod version) 
Hell no, I don't need a glowing green clickwheel; but it's green 
and it glows! And believe it or not, without this protection, I can 
make a real mess of my clickwheels. (Not shown .) 

iBEAMS 
)J>- Griffin Technology ..,. $19.99 
)J>-www.griffintechnology.com 
No matter how practical I am, I'm not above dropping $20 
on pointless fun like this two-piece lighting kit. The LED 
makes a handy flashlight for finding keys or ports on the 
back of the GS; the laser pointer keeps me amused at night, 
messing with airline pilots-er, I mean neighborhood cats. 

REMOTETUNES 
)J>- Targus )J>- $49.99 )J>-www.targus.com 
Another way to keep ye aide clickwheel clean: Dirty up a remote 
controller instead . There are, oh, about 900 of them on the 
market, but this one from Targus sends its remote mojo 
over radio-frequency signals, thus giving it killer range. 

TUNETALK FOR iPOD 
)J>- Belkin )J>- $29.99 )J>-www.belkin.com 
I can plug this slick nubbin into my 'Pod and record notes 
to myself, interviews, and blackmail fodder. (Not shown.) 

PERSONAL AUTO SOLUTION 
)J>- Me )J>-About $5 )J>- Never you mind 
After trying a bunch of iPod-to-auto junk, I got a five-
dollar cable from Radio Shack and plugged one end into 
the back of my in-dash stereo and the other into my iPod's 
headphone jack. Looks skanky; sounds great. (Not shown.) 
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Family Guy 
JAKE WIDMAN , FEATURES EDITOR 

MICROFIBER SLEEVE 
~Kensington ~ $19.99 
~www.kensington.com 

I once had an iPod slip out of my hands-not 
recommended unless you want to meet the fine 
folks at iPodResQ (www.ipodresq .com)-so I 
mainly want a cover that gives a good grip. The 
Microfiber Sleeve feels like suede, I can use 
the clickwheel right through the fabric-and I 
haven't dropped my 'Pod since I got it. 

POCKETDOCK LINE OUT USB 
~ SendStation Systems ~ $29.95 
~www.sendstation.com 

I've been known to forget things, so I'm sure that 
someday I won't have the right cable or power 
adapter when it's time to recharge my 'Pod. But 
with the PocketDock, I just need a standard USB 
cable. Bonus: The line-level miniphone-plug port 
supplies better audio than the headphone jack. 

MYTUNE FM 
~ Tekkeon ~ $69.95 ~www.tekkeon.com 
I've tested tons of FM car adapters, and this one works best. It's even 
got a cradle to hold your 'Pod at eye level-safer than looking in the 
next seat. 

PORTABLE 
SPEAKERS FOR iPOD 
~ Logitech ~ $149.99 ~www.logitech.com 
These guys aren't going to power your next dance 
party (when was my last dance party?), but they're perfect 
for listening in the kitchen while making dinner. The built-in 
Li Ion battery lets my kid take the speakers to his room 
when a friend is over. To top it off, my wife thinks they're 
cute-not what she usually says about technogadgets. 

GRAB FOR iPOD 
~Rivet International ~ $29.99 
~www.rivetnow.com 
I don't carry my iPod around much, but when I 
do, I don't want to just shove it in a pocket, and 
I don't like the way belt-clipped holsters dig into 
your side. A nice, secure holder that hangs from a 
clip-that sounds like just the ticket. And it is . 

TUNESTAGE FOR iPOD 
~Belkin ~$179.99 ~www.belkin.com 

The Bluetooth receiver hooks up to your stereo; 
the little transmitter goes on your iPod; you sit 
on the couch and listen to your music. Honey, 
could you get me a beer? 



Audiophile 
Mouse-Potato 
RIK MYSLEWSKI, EDITOR IN CHIEF 1--------___, 

HD595 
..,. Sennheiser ..,. $289.95 ..,.www.sennheiserusa.com 

When the hour is late and the "Kyrie" from Bach's Messe in 

H-Moll might disturb my slumbering spouse, I don these 

12Hz-to-38.5KHz circumaural headphones. Earbuds are so 

declasse-and uncomfortable. 

FX6021 
..,.Altec Lansing ..,.$249.95 ..,.www.alteclansing.com 

When sitting at my desk at home, I pleasure my eardrums with this 
top-quality powered-speaker system. Six 180Hz-to-15KHz Altec 
Micro Drivers in each satellite speaker (12.5 watts per channel) are 

supported by a 6.5-inch, 40Hz-to-180Hz subwoofer. (Not shown.) 

NAVIPOD EX 
..,. TEN Technology ..,. $49.95 ..,.www.tentechnology.com 

Most iPod remotes allow you merely to adjust volume and 
skip from song to song; the naviPod EX also allows me to 

navigate playlists, albums, and audio book chapters. 

iPODARMOR 
..,. Matias ..,. $39.95 ..,. http://matias.ca 

I'm fussy about my iPod's appearance, so when I'm traveling, I give 
it the best protection I can without sacrificing aesthetics-namely, 
the smooth-and-subtle yet virile-and-rugged aluminum embrace of 

this well-padded case. Toss it into your luggage and banish 

your fear of brutish baggage handlers. 

iCRUZE 
..,. Monster Cable ..,. $199 for Interface Module, $99.95 

for optional LCD Display ..,_www.monstercable.com 

For the best possible audio quality, I've connected my 
iPod directly to my car stereo's CD-changer jack by way of the 

iCruze, which allows me to peruse my playlists using my in 
dash CD controls and the optional blue-LED display. 

(A list of supported car-audio systems can be 
found on Monster Cable's Web site. Other 
Monster-supplied components may be needed 
depending on your car.) 

iFI 
..,. Klipsch ..,_ $400 ..,_www.klipsch.com 
While the FX6021 speakers are perfect for at-desk listening, 
the 27Hz-to-20KHz iFi system does a superior job at filling an 
entire room. Its iPod dock-complete with main and subwoofer 
vo lume controls and a mute button-accepts signals from 
the included radio-frequency remote with a range sufficient 
enough to allow me to adjust Anthony Braxton's volume while 
searching forthe perfect Pi not Blanc in my wine cellar. 



Wireless Bu2zcronyms 
By Niko Coucouvanis 

: ' · : i I . ; . 

1 
A lthou1gh wirelessnetv.)orking-Wi-Fi for short-is only a subset of the networked universe, it's a bubbling stew of acronyms, 

M ar,cane protocols, and ever-evolving standards. ~ere's your cheat sheet to the wacky world of Wi-Fi terminology. 
: I \ ! ; I ' 

Hardw~re 
Mac users with Wi-Fi dreams need look no further than Apple's AirPort Extreme Base Station, which can function as any or all of 
these devices. -

BRIDGE 

ROUTER 

WAP. 

WIRELESS 
ADAf TER 

A piece of equipment that links two or more local-area networks (LANs) or devices together through simple data 
forwarding. You could, for example, use a wireless bridge to connect one local Ethernet network to another. 

Like a bridge, a router connects disparate network?. Unlike a bridge, a router also provides the NAT (Network 

Address Translation) an,d DHCP (Dynamic H9st Configuration Protocol) services required to connect your home 

local network to the Internet. 

Wireless Access Point: A blanket term for Wi-Fi devices that transmit and receive data. (Also stands for Wireless 
Application Protocol, the global standard for mobile wireless access by devices such as cell phones and pagers.) 

_ ' ' ' I 1 ' ~ _ 

The device that lets your Mac transmit data wirelessly: For most recent and current Macs, this means an Airport 
or Airport Extreme card. Older Macs ,and garden-v,ariety PCs can use USB 1 PCI, or Ethernet-connected adapters. 

' ' ' ' 

Tec-hnologies, Protocols, and Standards 
The Institute of_Electrical and Electronics Engineers (IEEE, pronounced "1-triple-E") sets the standards for wireless-access 
protocols; here are some of the main ones. 

802.H 

802.11b 

The ever-evolving specification for wireless networking (covering frequency, protocols, and so on), based on the 
802.3 standard (aka Ethernet). 

Consumer Wi-Fi started out using the'802.11b standard, which operates in the range of 2.4GHz to 2.4835GHz 
with a maxim~m speed of 11 Mbps (megabits Rer second) and a relatively high range of 300 feet. Apple's original 
AirPort hardware is based on 802.llb. 
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Technologies, Protocols, and Standards (continued) 

802.11a A higher-speed (up to 54 Mbps), lower-range (60 feet maximum) version of 802 .11 used in some specialized 
settings. Because it operates at SGHz, it's not interoperable with standard 802.1 lb Wi-Fi, though -newer flavors of 
802.11 incorporate bits of both . 

802.11g Uses lla's advanced multiplexing and modulation within llb's 2.4GHz to 2.468GHz frequency range to achieve 
greater speed and distance. Unlike 1la,1 lg is backward-compatible with 1 lb. 

802.11 n Though not yet approved, the 802.1 ln spec promises speeds above 500 Mbps and backward compatibility with 
11 b, 1 lg, and possibly 1 la. It's available to consumers in Belkin's so-called Pre-N hardware. 

BLUETOOTH Short range and a slow 2-Mbps maximum throughput makes Bluetooth a poor choice for transferring big files, 

but its ease of use, low cost, and low power requirements make it ideal for syncing c,ell phones and PDAs with 
your Mac, as well as for wireless mice and other input devices: 

IR Infrared Radiation (or just lnfraRed, depending on whom you ask) is only capable of short-range, line-of-sight 
transmissions, and is used for simple devices such as your1V remote and Apple's remote for the new iMac GS. 

lrDA 

RF 

RFID 

-+-

Infrared Data Association: This modified form of IR, named after its governing body, is slower than IR but has a 
higher theoretical range. 

Radio Frequency: An electromagnetic field-a radio wave-that is created when electric1current is piped through 
an antenna. Unlike IR, RF can travel through walls. 

i I , i • : 
Radio Frequency 'ldentification : RFID systems use a central transcei'ver and multiple transponders to, for 
example, track product inventory, or grant an RFID-device-carrying person keyless access to sewre areas. 

I 

Encryption 
A Wi-Fi signal happily meanders outside the safe confines of your home or office walls. Encryption is the answer to that security 
problem; scrambling the data while it's transmitting keeps prying eyes from intercepting your private info. 

LEAP 

WEP 

WPA 

WPA2 

Lightweight Extensible Authentication Protocol: Cisco Systems' proprietary security protocol, which is used in some 
Cisco-based installations. If you use LEAP, use a tricky password; LEAP's authentication scheme is vulnerable to so

called dictionary attacks-repeated login attempts using everyday words. 

Wired Equivalent Privacy: Part of the 802.1 lb standard, WEP uses passwords and data encryption to provide a level 

of security equivalent to that of a wired Ethernet network. 

Wi-Fi Protected Access: WPA uses more-sophisticated data encryption and more-ro,bust password authentication 

than its predecessor, WEP. 

Although the IEEE claims that WPA is still good enough, the more-muscular WPA 2 scrambles data via AES 

(Advanced Encryption Standard); standard WPA uses TKIP (Temporal Key Integrity Prot?col). As if you didn't know. 

WPA Apple's implementation of individual-strength WPA, which authenticates users via RADIUS (Remote Authentication 
ENTERPRISE Dial-In User Service). , 

WPA 
PERSONAL 

802.1x 

Apple's implementation of shared-key WPA, whereby all network clients use a common ,password or phrase-
good for home and small-group networks. 

1 
. 

Next-generation Wi-Fi security that uses EAP (Extensible Authentication Protocol) for more-secure authentication 
with a central password server (based on RADIUS or another password-checking technology) . -

,~ MacAddict How-To Editor Niko Coucouvanis has a 
~photo of Hedy Lamarr on his desk. Seriously. 
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Macworld 
Conference & Expo® 

(f) ... 

CONFERENCES: JANUARY 9-13, 2006 

EXPO: JANUARY 10-13, 2006 

THE MOSCONE CENTER 

SAN FRANCISCO 

Flagship Sponsors: 

Macworld Macworld.com 

Macworld Conference & Expo is the #1 event for the 

Mac Community. Attendees can find the latest, newly 

announced products and learn to run their Macs more 

efficiently no matter what their needs are. 

Macworld Conference & Expo San Francisco 2006 has your 

next Mac solution with training to boost your Mac abilities 

on OS X Tiger, music and audio, video, graphic design, 

photography, digital imaging, gaming, and more. Recognized 

industry experts provide professional and comprehensive 

information, networking opportunities abound and you'l l get 

to meet hundreds of companies supplying the Mac products, 

innovations and applications that you want to see. 

M 
SF 





ROKR 
DISAPPOINTING iTUNES
EQUIPPED MOBILE PHONE 

The ROKR meets the basic goal that 
Motorola set for it-it's currently the 

only phone on the planet that runs a 
genuine iTunes music player and plays 
copy-protected tracks bought from the 
iTunes Music Store. But the devil's in 
the details, and those details include 
a ho-hum feature set and a few glaring 
flaws. After putting the phone through 
its paces, we think that a better name 
might be LOSR. 

The bright side. Credit the ROKR 
with getting some key elements of the 
iPod experience right. Setting up your 
music is easy: Just plug the phone into 
your Mac with the supplied USB cable, 
then use your Mac's iTunes software 
to drag tracks or playlists to the phone 
manually, or use iTunes' Auto Fill feature 
to top it off. (Sorry, you can't buy songs 
directly from the iTunes Music Store 
through the phone.) To play music, you 
press the ROKR's dedicated iTunes 
button, and the ROKR greets you with 
the iPod's familiar menu system. 
The only difference is that you use 
the ROKR's clickable thumbstick 
to navigate instead of the iPod's 
legendary clickwheel. The thumbstick 
approach isn't as versatile-there's no 
way to quickly scroll through a number 
of selections, for example-but it's 
satisfactory, and we had no problems 
navigating through songs, playlists, 
albums, and artists. The ROKR's audio 
quality matched our iPod shuffle when 
playing through the bundled stereo 

HK's Phone 

@!open ITunes whtn this mobile phone is an;ached 

0 Only opda1e chKkt!d songs 

Convert higher bit r.m! songs to 12 8 kbps MC 

~ Displ.ty album artwork on 1his mobile phone 

f!! Enable disk use 

100 Songs -·~~---- 80 MBO;;i.u: 

You can use some of the ROKR's memory 
to store Mac files instead of songs. 

COMPANY: Motorola/Cingular 
CONTACT: 866-289-6686, www.motorola.com; 
866-246-4852, www.cingular.com 
PRICE: $249.99 (two-year contract required) 
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Are you ready to rock? This phone isn't. 

headphones (which include a built-in 
mic for voice chats); the phone's tiny 
built-in stereo speakers didn't sound 
half bad, either. 

But then ... We ran into annoying 
limitations. For starters, the ROKR 
can only hold 100 songs, despite the 
fact that its 512MB memory can hold 
more. Apparently, this is Apple's way 
of protecting iPod sales, but it limits 
the variety of music you can enjoy on 
the phone. It also means you'll want 
to regularly refresh the ROKR with new 
songs, which leads to another catch: 
The ROKR's USB 1.1 connection takes 

more than an hour to fill up 
the phone with tunes! Trust 
us, waiting an hour gets old 
quickly-especially when 
an iPod shuffle transfers 
songs about 10 times as fast. 
Another disappointment: 
You can't use your iTunes 
songs as ringtones. A final 
disappointment came when 
we discovered that the ROKR 
isn't able to play audiobooks 
directly from Audible.com. You 
have to buy your audiobooks 
from the iTunes Music Store in 
order to play them on the ROKR. 

We weren't taken by the 
ROKR's phone features, 
either. We like that the ROKR 
automatically pauses music for 
incoming and outgoing calls, 
but the phone isn't particularly 
small, thin, or stylish by today's 
standards. Its included camera 
is the old VGA variety (640 

·' by 480, no flash), while many 
!' higher-end phones snap at 1.3 

or 2 megapixels. What's more, 

Motorola's non-iTunes user 
interface is a bit confusing, often 
requiring an inordinate amount 
of button presses. And while the 
ROKRcansyncyourAddrassBook 
and iCal data over a Bluetooth 
connection, some useful info gets 
lost in the translation. For example, 

your contacts' postal addresses don't 
carry over; neither do all-day events 
from iCal. Finally, you can't type an SMS 
message to an Address Book contact on 
your Mac and send it via your Bluetooth
connected ROKR, as you can with some 
other phones. 

The bottom line. We wanted to like the 
ROKR-we really did . But for something 
that costs $249 and requires a two-
year contract with Cingular Wireless, 
we expect something at least within 
shouting distance of excellence. Instead, 
the ROKR merely combines a generic 
phone with a basic music player. A little 
of that old iPod elegance and out-of-the
box thinking would have gone a long 
way.-Helmut Kobler 

REQUIREMENTS: USB
equipped Mac, Mac OS 10.3.6 
or later, iTunes 4.9 or later 

GOOD NEWS: Only phone that plays IT unes MUSIC 

Store tracks Easy, 1Pod-hke 1ntegrat1on with !Tunes. 
BAD NEWS: Hundred-song limit Super-slow music 
transfers. Can't play Audible com audiobooks Pncey 

MacAddict RATED 
000 

SO-SO 
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319 LCD Monitor 
ACCURATE LCD MONITOR 

Lacie's 319 LCD Monitor is the 2-inch-smaller sibling of 
the 321 LCD Monitor ( '-> Jun/OS, p43) . Like the 

321, it's excellent for anyone who has a critical need for 
accurate color. 

The 319 mirrors the 321 in almost every way: It has a 
stu rdy dark-grey plastic bezel, adjustable height, the ability 
to pivot between landscape and portrait modes (but only if 
you have an AT/ Radeon x800 video card-and you have to 
change the onscreen orientation manually through the AT/ 
utility), a removable hood to help cut down glare, and 
settings-adjustment 
buttons at the 
bottom of 
the screen. The 
319's connectors 
include one VGA, 
one DVl-D, and 
one DV/-1 port; it 
has a maximum 
resolution of 1,280 
by 1,024 pixels, 
and LaCie claims 
a contrast ratio of 
600 to 1. LaCie also 
claims a 178-degree 
viewing angle, and 
our tests confirmed 
that the company's 
not just blowing smoke. 

The 319 is spot-on when it comes to accuracy, and we 
didn't spot any problems with either overall brightness 
or uneven illumination. Text is sharp and clean, but when 
playing Unreal Tournament 2004, we did notice some slight 
image streaking-not surprising, considering the 319's 18-
millisecond response time. (Apple's 20-inch Cinema Display, 
by comparison, has a 16-millisecond response time.) 

Anyone who demands absolute color accuracy in 
printed output will benefit from LaCie's $349 blue eye 
color calibrator, which allows you to make sure the colors 
displayed on the 319 match what you get from your output 
devices. The 319 comes with Lacie's blue eye pro software 
(sans hardware calibrator), but for the most-accurate 
results, you'll need the blue eye hardware. 

The bottom line. We said it for the 321, and we'll say it 
again for the 319: For color-critical work, you can depend on 
a LaCie LCD Monitor.- Roman Loyola 

PRICE: $999 COMPANY: LaCie 
CONTACT: 503-844-4500, 
www.lacie.com 

REQUIREMENTS: Mac OS X or later, 
ATI Radeon xBOO video card (for pivot) 

CODD NEWS: Excellent image quality 
Useful pivot option Adjustable height. 
BAD NEWS: Pivoted screen doesn't 
reorient automatically Slow response time 

MacAddlct RATED 
0 

GREAT 

eyetv® 
watch record edit enjoy 

Watch full screen, high-quality TV directly on your Mac. 

Record your favorite shows simply by clicking on the 

listing in the online tv guide. Edit unwanted content and 

then burn your recording to DVD*. Eye TV"' - Sit back and 

enjoy. Watch what you want, when you want it. 

winner 
ma cworld 
e d d y s 

Macworld 
l:]=f.jll 
OF SHOW 

2E'1 ot101] 4 

Starting at 

$149 

Available at these and other authorized Apple dealers: 

ti Apple Store MacMaH ~·lmac~@~warehouse· 
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Dreamweaver 8 
COMPREHENSIVE WEB-AUTHORING SOFTWARE 

M acromedia's Dreamweaver defined 
the integrated-Web-authoring-tool 

market as we know it. Dreamweaver 8 
has someth ing for everyone-but few 

can leverage all of its strengths. 
Deep and complex. A plethora of 

workflow changes make Dreamweaver 
8 a strong upgrade. Design-time CSS 

support allows code fragments to be 
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Site Window Help 
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workspace improvements round out the 

more-subtle changes to the app. 
Interface issues. While Dreamweaver 

is a clever app in many ways, it falls 

just short of being truly intelligent. For 
example, it sometimes groups browser-
validation errors logically, but it could 

offer better help correcting those 
errors. Code collapsing is great, 

but you must reselect 

expanded code to 

collapse it again. And 
,..::r-w.ai:. .,... - ........ • Macromedia's insistence 

on removing button 
lsl-.iy4e-l)te ..... 

fit."'.->111 """ 
'o•-llitn 

labels in Dreamweaver's 
interface slows workflow 
and makes it more difficult 

for novice users to quickly 
get up to speed. 

Dreamweaver's 
complexity is both its 

greatest asset and its 
greatest drawback, as its 
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deep feature set makes 
it a challenging app to 
learn. You could argue 

that Dreamweaver looks 
look: a o,JJlll' llT"'1lo!W-• __ : ~ T~. _a __ : ' c:i.. ,..,...~ ; 
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more like a professional 
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, :J · - modes, tabbed palettes , 

Dreamweaver S's integrated development environment is powerful, unified, streamlined-and perhaps too 
complex for the casual Web developer. 

and property grids. A 

dual-monitor setup is so 
helpful that it feels like a 

viewed with correct 
ON THE DISC styling, removing some 

major WYSIWYG editing 

limitations on nested 
code fragments. Code collapsing (similar 

to expanding and collapsing folder 

Dreamweaver 8 

views in the Finder) is quite handy when 
working through long files, especially 
complex externalized JavaScript files. 
Dreamweaver even allows for drag-and
drop placement of Flash 7 Video (FLV) 
files-it's brilliant in its simplicity and 
reliability. Developers working without 
a version-control system will apprec iate 
the new ability to compare remote and 

reference material for XML-related 
technologies is solid and eases the 

learning curve somewhat. 
Dreamweaver 8 also features changes 

that bring it up-to-date with a number of 

evolving technologies and techniques. 
Dreamweaver's handling of (and ability to 
supply coding hints for) both Cold Fusion 
MX 7 and PHPS have been updated. 
Those concerned with making their Web 
site accessible to the visually challenged 
will find improved validation forthe 
W3C's (World Wide Web Consortium's) 
Web Content Accessibility Guidelines 
at Priority levels 1 and 2. Many small 

necessity. Code-shy designers wi ll love 
working in Design View, almost never 

touching any code-but those designers 
will be using only a small sliver of the 

app's power. 

The bottom line. Existing 
Dreamweaver users will find plenty 
to like in this upgrade. If you're an 
intermediate Web developer-and 
especially if you're building dynamic or 
data-driven sites for less-experienced 
developers to maintain-you stand to 
gain the most out of Dreamweaver 8. It's 
a robust update to an already industry
leading tool.-Nathan Moody 

COMPANY: Macromedia 
CONTACT: 800-470-7211 , 
www.macromedia.com 

REQUIREMENTS: G3, Mac OS 
10.3 or later, 256MB RAM, 2GB 
disk space 

GOOD NEWS: Workflow improvements are brilliantly 
implemented. Drag-and-drop support for FLV and XML support. 
BAD NEWS: Complex and deep feature set 1s complicated by 
crowded, minimal interface. 

MacAddict RATED 
0 0 

GREAT PRICE: $399 (full), $199 (upgrade) 
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Stylus Photo R2400 • NEARLY PICTURE-PERFECT PRINTER 

As the image quality of the digital 
camera has improved, so has the 

quality of the digital photographer's 
most-critical output device: the inkjet 
photo printer. The outstanding print 
quality of Epson's Stylus Photo 
R2400 is certain to open the 
eyes of every serious digital 
photographer. 

The R2400 uses eight 
inks: cyan, light cyan, 
magenta, light 
magenta, yellow, 
light black, 
light light black 
(no, that's not 
a typo), and 
photo black, 
which can be 
swapped out 
for matte black 
if you decide to 
go with matte 
prints. The inks 
are part of Epson's 
new UltraChrome K3 ink set, and 
if you buy ink directly from Epson, 
you'll pay $14.24 per cartridge 
(before postage and handling). 

The abundance of black ink is a 
big reason for a black-and-white 
photographer to purchase the R2400-
the three blacks help get top-quality 
black-and-white results. Also, earlier 
this year, Eastman Kodak announced it 
will soon cease production of black
and-white photographic papers-a 
clarion call for black-and-white photogs 
to line up at the digital window. 

The R2400 can print sizes ranging 
from 4-by-6-inch snapshots all the 
way up to 13-by-9-inch Super B prints . 
Epson also supplies a few widths of 
media on a continuous roll, allowing you 
to create panoramfc banners. All Epson 
papers can be purchased directly from 
Epson's Web site. 

The R2400 connects to your Mac via 
either USB or FireWire 400. We installed 

Pricey? Sure. Worth every penny? Yup. 

and connected the R2400 in under BO 
minutes, but bear in mind you'll hal e 
to spend additional time calibrating the 
printer with Epson's software to ensure 
color accuracy. Luckily, Epson provides 
a truly robust printer driver with plenty 
of tweakability. 

Black-and-white photographers will 
find more to love in the printer driver's 

JV GLOSSY VS. MATTE 
Glossy or matte media-which should you 

use? Glossy is good for printing snapshots or 

when you want vib rant colors, and its shiny 

finish can give your pies a hint of glamour. The 

drawback is that it's easy to see fingerprints 

on glossy stock, and at some angles, it can be 

Advanced Black & White Photo mode. 
Our tests showed that letting the 
driver perform grayscale conversions 
(as opposed to doing them with our 
favorite image-manipulation app) 
made life noticeably easier and created 
results that rivaled any black-and-white 
conversion done in Photoshop-black
and-white photos from the R2400 are 

rich and vibrant, and blacks have 
more depth than anything 

we've seen from 
any other printer. 
The R2400 also 
creates impressive 
color photos with 
excellent fidelity 
and pop. You'll 
see little to no 
difference between 
the R2400's color 
images and images 
created at your 
favorite color-photo 

laboratory. 
The print times are an improvement 

over the Stylus Photo 2200 (which the 
R2400 replaces) . When we printed 8-
by-10-inch color glossy prints , print 
times ranged from 1 to 2 minutes; 

the more coverage an image required, 
the longer it took to print. Our 4-by-6-
inch glossy prints hit the output tray in 
under a minute. 

The bottom line. Epson has done 
itself proud with the Stylus Photo 
R2400. The hefty price means it's 
meant for serious, professional 
photogs, but they'll find it's worth 
every penny.-Rick Oldano 

hard to see a glossy print behind glass. Matte 

is excellent for black-and-white photos, photos 

that will be handled frequently, or photos 

behind glass. However, colors aren't as lively, 

and the texture of some types of matte stock 

can interfere with the smoothness of an image 

and show up in scans. 

COMPANY: Epson 
CONTACT: 800-463-7766, 
www.epson.com 

PRICE: $849.99 
REQUIREMENTS: USS- or FireWire 
400-equipped Mac, Mac OS 10.2.4 
or later 

CiOOD NEWS: Features will satisfy serious photogs 
Outstanding black-and-white prints. Gorgeous image 
quality 

MacAddlct RATED 

BAD NEWS: Pricey. AWESOME 
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Chatalog 
MINDFUL iCHAT UTILITY 

C hatalog makes it easy to access 

important iChat transcripts by 
delivering them to your email client 

for proper archiving. Chatalog installs 

as a System Preference, and you can 
configure it fo send iChat transcripts to 

an y email account by simply supplying a 
destination address. You can even have 

Chatalog keep a collection of images and 
URLs sent in iChat. 

In the mail. Once you've ended a chat 

session and closed the chat window, 

Chatalog sends the transcript to your 

email. The transcript appears in your 
email in box with a subject line of "[IM] 

ON THE 
DISC 

Cha la log 

user name," where 

user name is the name 
of your chat buddy. 

Unfortunately, all your 

. ~"'""' ~ .... ..,. 

REVIEWS ~ 45 

Chatalog tracks how many words have been received and "spoken" on iChat. It also needs 
to learn the "I before E except after C" rule. 

transcripts are named this way, so you'll 
have to rename the emails once you 
receive them if you want to be able to 

sort them by subject. 

Chatalog archives the images and 

U RLs from your chats in an HTML file that 

resides on your Mac (/user name/Library/ 
Chatalog/index.html). Open the file and 
you'll find a list of URLs; a catalog of 

images; and a nifty stat tracker that tells 
you how many words have been used in 

your chats, the number of what its preset 

list considers cuss words, and more. 
However, to purge the archive, you have 
to go into the /user name/Library folder, 
look for the Chatalog folder, and delete 
it. When you use iChat again, Chatalog 

will recreate a fresh HTML archive file. 
It'd be nice ifthere were a way to purge 

the folder directly through Chatalog's 
preferences. 

The bottom line. Chatalog turns your 

iChats into acceptably manageable files 
on your Mac.-Roman Loyola 

V COMPANY: Freeverse 
J\. CONTACT: 212-929-3549, 

www.freeverse.com 

REQUIREMENTS: Mac OS 10.3 or 
later (Mac OS 10.4 or later for Chatalog 
Dashboard widget), iChat AV 

tiOOD NEWS: Easy to use. Cheap 
BAD NEWS: No options for email sub1ects. No 
convenient way to clear Chatalog archive. 

MacAddict RATED 

0 00 
SOLID PRICE: $12.95 (personal), $24.95 (business) 

• Buffs out scratches from vinyl LPs 
• Wipes out hiss, hum, and other 

noise from tapes or DVs 
• New Enhance leaves a fine polish 
• Tough on grime, yet gentle on 

your signal 

• Record or import audio into your Mac 
• Edit and process your audio 
• Create custom fade-ins and outs 
• Assemble tracks in a playlist and 

burn your own audio CD! 

Disca11er for yourself haw easy and fun they are ta use. 
Check out the demo an the MacAddict CD or visit 

www.bias-inc.com/dawnlaads/freetrials 



We Need a Few 

Br \ ~ Apples 
to Stay on Top of Our Game. 

For over 29 years, Genentech has been at the forefront of the 
biotechnology industry, using human genetic information to 
discover, develop, commercialize and manufacture 
biotherapeutics that address significant unmet medica l needs. A 
considerable number of the currently approved biotechnology 
products originate from or are based on our science. Genentech 
manufactures and markets multiple products in the United 
States, providing innovative treatments for cancer, heart disease, 
respi ratory disease, growth disorders and other serious illnesses. 

At Genentech, leading-edge biotechnology isn't the whole 
picture. Al l of our breakthrough biotherapeutics would not be 
possible without the exceptional Mac OS X professiona ls who 
deliver the critical links to our success. We need senior Mac OS 
X professionals who can lead cross-functional teams in a 
high-energy, fast-paced environment with product experience 
and technical engineering expertise in the following areas: 

• Desktop client operating systems and applications for Mac OS X 
• Unix/Linux 
• Shell, Perl, command scripting and platform services 

development 
• Systems management (imaging, patch deployment, software 

updates, application installation and configuration) 
• Hardware device and peripheral integration with desktop 

software and platforms 
• Cross-platform Mac and Windows application integration and 

interoperability 

From the beginning, we have selected highly qualified people to 
join us and fostered a stimulating culture of openness, integrity 
and creativity. At Genentech we emphasize working hard, 
collaborating and sharing rewards. With a long history of helping 
busy people with busy lives, Genentech offers employees an array 
of outstanding benefits, including concierge services, on-site dry 
cleaning, on-site dental, take-out meals and sabbatica ls. For more 
information and to apply, please visit www.gene.com/careers. 

· Please use "Ad-MacAddict" when a "source" is requested. 
Genentech is an equal opportunity employer. 

Genentech 
IN BUSINESS FOR LIFE 

I DNA WAY • SOUTH SAN FRANCISCO, CALIFORNIA 94080-4990 • 650.225.1000 • WWW.GENE.COM 

CatDV Pro 4 
PRODUCTIVE MEDIA MANAGER 

Think of CatDV Pro as iPhoto for video, enabling you to import, 
preview, and export movie clips-or any media supported by 

QuickTime-though this neat app is much more than just a media
management tool; it's also a nifty DV-capture app. 

When you launch CatDV, it treats you to a sparse, slightly 
puzzling interface. For example, icons in the toolbar don't have 
any labe ls, but they do have rollove r tooltips. However, once you're 
familiar with the interface (it doesn't take tong), you'll probably 
forgive CatDV for not being ili fe -i sh . 
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CatDV does a good job of managing many media files, although the 
interface could be a little friendlier. 

Organized. Using the built-in Live Capture tool, you can 
effortlessly import footage from tape and place it into a folder. 
Live Capture reads the timecode on your tape and divides the 
capture automatically into clips. You can, than kfully, adjust the in 
and out points for each clip. You can import clips from your hard 

·drive, as we ll. The Verbatim Logger is a nice feature, enabling you 
to write comments about a clip as it plays. The ability to search 
for clips by metadata is a necessity, and the ability to batch-convert 
media clips is a well-thought-out addition (and something you 
can 't do in QuickTime Pro) . 

At $275, CatDV Pro is pretty pricey, but th e app includes export 
formats for Final Cut Pro, Avid, and more. It also lets you hook up to 
a CatDV workgroup server when managing media across a company. 

The bottom line. CatDV Pro is an effective tool for media-asset 
management. It excels at the job it sets out to do .-Rob Carney 

COMPANY: Square Box Systems 
CONTACT: +44 7050 372230, 
www.squarebox.co.uk 
PRICE: $275 

REQUIREMENTS: Mac OS 10.2 or later, 
256MB RAM, QuickTime 6 or later, Java 1.3.1 
or later 

GOOD NEWS: Good capture and management tools 
BAD NEWS: Expensive. Bare interface. 

MacAddlct RATED X-
000 0 
GREAT 



FinePix F10 
ADEPT DIGITAL CAMERA 

Turning up the sensitivity on most 
digital cameras often results in 

grainy and inferior images. Fujifilm 

has tackled this issue with the Fine Pix 
F10, which works at sensitivities all the 
way up to ISO 1600-and the quality 

of the shots produced at this setting is 

quite good. To reach ISO 1600, the FlO 
uses a larger sensor and some clever 
engineering. 

The F10 is a compact 
6-megapixel camera 

with a 3x optical 
zoom that stores 
good-looking, 

accurate, and 
sharp images on 

xD-Picture Cards. 

Unfortunately, 

the camera 
only comes 
with a miserly 

16MB card-be 
prepared to buy 

a larger card if 

you want to be 

able to store 
a reasonable 

number of shots. The FinePix 
The F10 has a beefy FlO loves the nightlife. 
battery that can 

snap up to 500 shots (without using the 
flash) before it needs to be recharged. 

Smart screen. The luxurious 2.5-inch 
color LCD screen has a refresh rate of 60 

frames per second. Such a large, high
quality screen makes taking pictures a 

tJj7 THREE-LEGGED FRIEND 
When you're taking photos in low
light conditions or of stationary 
subjects, a jitter-minimizing tripod 
is your best friend. lfyou can't 
tote a tripod, set your camera on 
whatever sturdy surface you can 
find to keep it steady. 

COMPANY: Fujifilm 
CONTACT: 800-800-3854, 
www.fujifilm.com 

pleasure-no squinting while checking 

your shots. A sensor adjusts the screen's 
brightness to account for your viewing 
conditions. For example, the screen 

brightens on a sunny day so you can 
easily see your pictures; in the darkness, 

the screen dims so you're not blinded. 

If the F10 has a fault, it's that its 
controls are a bit basic . You have a 

choice offive scene modes, a fully 
automatic mode, and a manual 
mode that lets you change just a few 

settings-certainly not the degree of 
customization or control you'd expect to 

find on a camera of this price. The lack 
of controls would be fine ifthe camera 
were aimed and priced at beginners, but 

most people spending over $300 on a 
digital camera would expect shutter- and 
aperture-priority controls as well as 

manual exposure. 
The bottom line. If snapping candid 

photos in dark conditions is your thing, 
or if you need to take photos in places 
where the use of a flash is prohibited, 
then the FinePix FlO makes a great deal 
of sense.-Mark Sparrow 

PRICE: $499 
REQUIREMENTS: USS-equipped Mac, Mac OS 
10.2.8 or later. 256MB RAM, 40DMB disk space 

GOOD NEWS: Low image noise Good-quality lens Long battery hie 
Great screen 

MacAddict RATED 

0 00 
SOLID 

BAD NEWS: Pricey. Bundled 16MB card is too small 

Never Lose 
Anything Again 

... 
i 
' ! 
l 
i 

Photos, e-mails, graphics, 
documents. Who knows what 

you've got hidden away? 

NoteBook takes all those snippets and 
turns them into searchable catalogs of 
information. Find anything instantly. 

Publish to the web in one step. 
NoteBook puts you in the driver's seat. 

You can take control. 
NoteBook can help. 

Try NoteBook free for 30 days. 

Introducing 
Circus Poniesr .. 
Note Book 

Powerful outlining and 
organizing for your ideas! 

~ 
~ 

Free demo at 
www.circusponies.com 

Macworld 
.... t 

macHOMl •••• 
© Copyright 2005 Circus Ponies Software, Inc. All 
Rights Reserved. Circus Ponies, the Circus Ponies logo, 
Note Book, and the Note Book logos and icons are 
trademarks of Circus Ponies Software, Inc. 



Epson's RX620 (left) 

and Canon's MP780 (right) can 

fax, print, scan-and handle photos, too. 

Pixma MP780 & Stylus Photo RX620 
PHOTO-FRIENDLY MULTIFUNCTION PRINTERS 

Canon's Pixma MP780 and 
Epson's Stylus Photo RX620 are 

multifunction printers (MFPs) that can 

print, scan, fax, and-contrary to what 
you've come to expect from MFPs
handle photo printing, too. 

MP780. Canon's 18.5-by-19.1-by-12-

inch inkjet MFP is a paper-handling speed 
demon, good for both general business 

and photo printing. In addition to the 

150-sheet media cassette feeder and the 
150-sheet rear media tray, the MP780 

also has a 35-page automatic document 

feeder for copies or scans. The fax 
machine can hold 250 pages in memory. 
The MP780 can also automatically print 
on both sides of a page. 

The MP780 connects to your Mac via 

USB and has an LCD screen for selecting 
options. The scanner has a maximum 
optical resolution of 2,400 by 4,800 dpi, 
while the printer (which uses five ink 

cartridges) has a maximum resolution 

of 600 by 600 dpi for monochrome and 
4,800 by 1,200 dpi for color. 

RX620. The 23.3-by-17.7-by-11.9-inch 
RX620 is designed with photos in mind. 
Its only media feeder-a rear tray-holds 
120 sheets. It has a media-card reader 
that's compatible with CompactFlash 
Type I and II, SD card, and more; and it 
has Direct Print and PictBridge support. 
The RX620's 2.5·inch LCD lets you 
perform simple image-editing ta sks 
without having to use your Mac. Serious 
photogs will like the scanner's built-in 

transparency unit for scanning 35mm 
negatives, slides, and transparencies. 

The RX620 uses a USB connection, 
contains six separate ink cartridges, 
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and has a maximum resolution of 5,760 
by 1,440 dpi. The scanner's maximum 

optical resolution is 2,400 by 4,800 dpi. 
Speed. When it comes to which prints 

faster, the MP780 wins, hands down. 

It took the MP780 a speedy 7 minutes, 
35 seconds to print a 50-page Word 

document at the normal print setting, 

while the RX620 took 36 minutes. (The 
MP780 took 26 minutes to duplex, or 

print on both sides of the page, the 
same Word document.) On the MP780, 

an 8-by-10-inch color photo printed in 

96 seconds and an 4-by-6-inch photo 
took 52 seconds. The RX620 took 5 
minutes, 18 seconds to print the 8 by 
10; it took 2 minutes, 41 seconds for the 
4 by 6. A two-page Excel spreadsheet 

took 55 seconds on the MP780, while 
the RX620 took 90 seconds. 

Print times were closer when 

dealing with a 15-page PowerPoint 

presentation; the MP780 took 14 
minutes, 15 seconds, while the RX620 

took 15 minutes, 42 seconds. When 
it came to scanning, both MFPs took 
about 25 seconds to scan an 8-by-10-
inch photo at 300 dpi. 

Stylus Photo RX620 
COMPANY: Epson 
CONTACT: 800-463-7766, www.epson.com 
PRICE: $299 
REQUIREMENTS: USB-equipped Mac, Mac OS 
10.2 or later 

GOOD NEWS: Quiet Many in-printer photo-editing 
features. Vibrant colors. 

BAD NEWS: Slow Slight .. 
blue cast on photos 

Image quality. Both printers do 

an excellent job of printing detailed, 

crisp photos. The dozens of photos we 
printed from the RX620 all had a blue 
cast to them, though they also had a 

color vibrancy not found in the MP780's 
photos. We prefer the MP780 for its 

more-accurate colors. 

The MP780 also does a better job 

with text and business graphics. Text 
in Word and PDF documents from 

the MP780 was clean, but we saw a 

considerable amount of fuzziness from 
the RX620. The MP780 also produced 

richer colors in our charts and graphs, 
although the MP780's printout of a 
plain-paper PowerPoint presentat ion 
had considerably more curl from ink 

saturation than the RX620's. 
When scanning, both the RX620 and 

MP780 accurately captured colors and 
details ; we found only minor differences 

in our scans. 
The bottom line. While we like many 

of the RX620's features that aren't found 
on the MP780, the MP780 wins with 
its combination of speed and image 
quality.-Roman Loyola 

PixmaMP780 
COMPANY: Canon 
CONTACT: 800-652-2666, www.canon.com 
PRICE: $249 
REQUIREMENTS: USB-equipped Mac, Mac OS 
10.2.4 or later 

GOOD NEWS: Fast Excellent color accuracy on 
photographs 
BAD NEWS: Noisy. Slow llJJRI 
duplexing ~ 



I-Dog 
CUTE LITTLE INTERACTIVE AUDIO SPEAKER 

Hasbro's I-Dog is a robotic canine 
that isn't fond of Milk Bones. But 

play him some groovin' tunes and show 
him some affection, and he'll make quite 
an entertaining companion-but only for 
as long as your attention span will allow. 

The pint-sized I-Dog is a dapper little 
fellow; his white and pseudo-chrome 
body is a true complement to a standard 
iPod. I-Dog draws his power from two 
AA batteries (not in cluded) and comes 
with an audio splitter cable-plug 
one male end into the I-Dog (his side, 
thankfully), the other male end into your 
iPod, and a set of headphones into the 
remaining female end if you'd rather 
not listen to the I-Dog's weak and tinny 

built-in speaker. You can also bypass 
the cable altogether and simply place 

I-Dog next to a speaker and watch him 
do his thing. 

Tricks. I-Dog's bag of tricks is limited. 
He can rotate his head and ears, bark, 
whimper, and flash colorful LEDs in set 
patterns. The patterns key you into 1-
Dog's mood, which can peak at Ecstatic 
and hit an absolute low at Sick. I-Dog 
has eight different moods (the manual 
matches each LED pattern to its mood); 
your job is to keep I-Dog happy. 

If I-Dog isn't at his best, simply find 
out what type of music he wants to listen 
to by double-clicking his nose to hear a 
sample tune in one of three genres: rock, 
tech no, or hip hop. Play the right type of 
music, and he'll be one happy pup-and 
it's amazing how accurately the Iii' fella 

can distinguish tunes. It also doesn't hurt 

At least 
he doesn't drink 
from the toilet bowl. 

to give him some love now and then by 
petting his head and pressing his nose. 
It's interesting to experiment with stirring 
up different moods. 

The bottom line. I-Dog's novelty wore 
off after a few hours, but we're fickle . 
I-Dog is a cute alternative to iTunes' 
Visualizer. Best of all, it won't crap on 
your lawn.-Gi/ Loyola 

COMPANY: Hasbro 
CONTACT: 800-327-8264, 
www.hasbro.com 

REQUIREMENTS: Two AA 
batteries, audio input 

GOOD NEWS: Cute Cable accommodates headphones 
Develops different moods. Spaying and neutering not necessary 
BAD NEWS: Weak speaker Novelty wears off quickly. Can't play 
fetch or roll over on command. 

MacAddict RATED 
ooo.o 
SOLID PRICE: $29.99 

C01U 
SIMPLE AND SOUND USS MICROPHONE 

I fyour acoustic-recording studio is 
a 'Book and you like to travel light, 

lugging along MIDI gear gives you 
the blues. And for most podcasters, 
shelling out $300 or more for a decent 
microphone preamp is a waste of cash. 
Simplicity is the secret to acoustic
recording happiness, and Samson 
Audio's C01U USB studio condenser 
microphone is as simple as a mic can be. 
It connects to your Mac through USB and 
has no buttons, switches, or knobs on its 
surface-just a little green power light. 
It works with GarageBand or any other 
digital-audio software. 

The C01U's wide diaphragm scoops 
up sound well, easily swallowing up 
voca ls and acoustic guitar before 
spitting them into your software with 

remarkable fidelity. For better 
editing control, we recommend 
recording vocals and guitar 
tracks separately; but for live 
recording sessions, this mic is 
a good option . 

Tough enough. While the 
C01U was made for the studio, 
it's strong enough for the road. 
Its heavy mesh mic screen 
withstands the occasional 
bumps that are inevitable on any 
tour, and its matte silver finish 
holds up against most dings. 

Our only complaint with this 
USB mic is that you can only use 

Simple enough for your 'Book-based 
studio. Strong enough for the road. 

it with recording software. 
The first time we plugged 
it in, we weren't sure it was 
working because Mac OS X 
didn't address it as a system 
microphone. Instead, we had 
to launch .our digital-audio 
software to get our Mac to 
recognize the C01U. (You 
can also use the mic's driver 
software, though it doesn't 
ship with the device; you have 
to download it from www 
.samsontech.com.) 

The bottom line. For acoustic 
and vocal recordings, the 
C01U works well, and its USB 
connectivity is a welcome 
bonus.-Robert Strohmeyer 

COMPANY: Samson Audio 
CONTACT: 510-364-2244, 
www.samsontech.com 
PRICE: $234.99 

REQUIREMENTS: USB-equipped 
Mac, Mac OS 10.1 or later, any 
digital-audio workshop app 

GOOD NEWS: Wide diaphragm picks up acoustic audio even 
at moderate distances. Heavy-duty construction survives hie on 
the road even 1n your backpack 

MacAddict RATED 

00000 
GREAT BAD NEWS: Doesn't work as a system m1c in OS X. 
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Mathematica CalcCenter 3 
EASY-BUT-POWERFUL MATH SOFTWARE 

Mathematica Professional is 
the 800-pound gorilla of math 

software-but it can be hard to tame. 
Enter Mathematica CalcCenter 3, a 
heavy-duty graphing calculator for the 

slightly less hardcore. CalcCenter 3 is 
based on Mathematica's algorithm set

the same commands and syntax hold 
true-but it adds a button - and menu
based interface that doesn't require 

prompt you to enter a function 
and your desired bounds before 
creating a graph . SmartPlots 
include functions of one or two 

variables, various types of data 
plots, plus pie and bar charts. 

Other lnstantCalculators step 

you through basic functions 
such as taking the derivative 

With the help of CalcCenter 3's Controller (left), you can 
fill a notebook (right) with graphs and calculations. 

you to memorize a googolplex of written 
commands. Plus, CalcCenter 3 provides 
a handy guide for oft-used calculations 
in a floating Controller window. 

ON THE 
DISC 

Mathematica 
CalcCenter 3 

You'll love 
CalcCenter 3's 

I nstantCalculators, 
which include easy-to

use SmartPlots that 

of or integrating a function (along with 
the numerical equivalents of both), 

summations, and power and product 

series. Each lnstantCalculator has a 
built-in example to help you get started. 
More good news: CalcCenter 3 creates 

standard NB math files to share with 
your number-crunching compatriots. 

Not a math geek? lnstantCalculators 

are a godsend. However, navigating 

the levels of the Controller is tedious, 
especially if your calculations require 

multiple symbols and natural constants; 
use the menu bar instead if you want to 

speed things up. 
The bottom line. If you want a 

graphing calculator and symbolic-math 

mangler, and you're intimidated by 

Mathematica's interface, CalcCenter 3 is 

the way to go.-Carey Myslewski 

COMPANY: Wolfram Research 
CONTACT: 800-441-6284, 
www.wolfram.com 

PRICE: $595 {standard) , $195 
{educational), $99.95 {student) 
REQUIREMENTS: Mac OS 
Xorlater 

GOOD NEWS: Helpful button-based hand holding. Support for 
symbolic math. Support for NB files 
BAD NEWS: Button levels aren't as easy to navigate as they 
should be. No support for Mathematica Professional app packs. 

WGXB102 56 Mbps Wall-Plugged Wireless 
Range Extender Kit 
SLICK WI-Fl-EXTENDER HARDWARE 

extender provides Wi-Fi 

access in the area where 
it resides. In ourtests, the 

device's signal extended 
to adjacent rooms, but the 
strength wasn't as powerful 
as our Wi-Fi router's-partly 

I • I fyou're down on Wi-Fi because it can't 
reach the outer limits of your home, 

NetGear's WGXB102 56 Mbps Wall

Plugged Wireless Range Extender Kit 
might restore your faith. The WGXB102 
takes a different approach to extending 
your range: Instead of using an antenna 

to boost your signal, the WGXB102 uses 
the electrical wiring in your home. 

because the WGXB102 is so Extend yourWi-Fi, but you'll have to move your night-light. 

The first piece of the WGXB102 is a 
bridge; connect it via an Ethernet cable 
to your network router, and then plug it 
into a nearby power socket. The second 
piece is the range extender, which you 
plug into a power socket in the room 
where you want Wi-Fi. The bridge makes 
a connection to the extender by using 
the power lines in your home, and the 

low to the ground . 
You configure the WGXB102 through 

a Web page; we were up and running 
within 15 minutes. Two caveats: The 
WGXB102 must connect directly to a wall 
socket (you can't plug it into a power 
strip), and neither the bridge nor the 
extender provides a replacement power 
socket. Also, the 54-Mbps speed claimed 
in the name refers to the kit's 802.1 lg 

GOOD NEWS: Elegant design. 

(AirPort Extreme) compatibility. While it's 
also 802.llb (AirPort) compatible, the 
maximum speed you can get with that is 
11 Mbps-if you're lucky. 

The bottom line. The WGXB102 is 
pricier than some extender antennas, 
but if you have lots of concrete walls or 
other Wi-Fi obstacles in your home, it 
could be your savior.-Roman Loyola 

MacAddict RATED COMPANY: NetGear 
CONTACT: 408-907-8000, 
www.netgear.com 

REQUIREMENTS: Wi-Fi network, 
available wall power outlet BAD NEWS: Can't plug into a power strip. No replacement outlet 

for the one 1t occupies. 0 
GREAT PRICE: $139 
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Harmony Audio 
NO-FUSS AUDIO HARDWARE INTERFACE 

Miglia's HarmonyAudio is a FireWire

based audio interface-you use it 

to connect your electronic instruments 

(such as your vintage 1963 Fiesta Red 

Strat) or any analog audio source to 

your Mac so you can record the sound 

in Garage Band, Logic , or any other Core 

Audio-compliant app. 

HarmonyAudio's front panel has 

two 0.25 -inch jacks for connecting 

instruments, microphones, or other 

analog devices. Each jack has a gain 

control for adjusting channel volume, 

buttons for adjusting the impedance 

(appropriate for certain types of mies), 

and Miglia's SoftClip technology, which 

prevents digital clipping. In add ition, 

the HarmonyAudio has a 3.Smm stereo 

headphone socket and headphone-

gain control to adjust 

the volume sent to the 

headphones. Th e back 

panel has four 3.Smm two-channel 

outputs, two FireWire ports, an optional 

power-supply port, and stereo-input 

controls for adjusting the volumes of the 

left and right channels independently. 

All in all, it's a fairly comprehensive set 

of features. 

Plug and play. The HarmonyAudio 

is straightforward to use; no software 

installation is needed. We just hooked 

it up to a FireWire port, selected the 

HarmonyAudio as the connected audio 

device in System Preferences > Sound 

>Input, and got instant re sults with 

GarageBand and Logic Pro 7. The input 

jacks worked well with both an electric 

REVIEWS l;s 51 

Enhance your 

Mac's audio capabilities. 

guitar and a stereo keyboard. The 

outputs coped admirably with stereo 

and 7.1-channel setups. And, most 

importantly, our audio sounded good. 

The bottom line. HarmonyAudio is 

a good fit for Garage Band and Logi c 

Express users looking for a decent 

interface. Audio pros will want to invest 

in an interface with more inputs and 

additional controls.-C/iff Douse 

X-COMPANY: Miglia 
CONTACT: +44 870 7472988, 
www.miglia.com 

REQUIREMENTS: FireWire 
400-equipped Mac, Mac OS 10.3.5 
or later, 256MB RAM 

&000 NEWS: Looks complement the Power Mac G5. Performs 
well L1ghtwe1ght case. 

MacAddict RATED 

00000 
SOLID 

BAD NEWS: Pricey. 
PRICE: $316 

Take Your Digital Photos Beyond 
the ''Ken Burns Effect'' 
Photo to Movie TM brings photos to life by adding motion 
using a powerful version of the "Ken Burns effect". You can 
add music tracks, voice narration, and a variety of slide-to
slide transitions. Export movies from Photo to Movie and use 
them in iMovierM, burn them to DVD, post them on the Web, 
or even email them. 

"It's simple and does what it does better 
than any Other!' Mac360.com 

"The bottom line? Photo to Movie is highly 
recommended!" Luminous Landstape, Sept. 2005 

Download a FREE, full-featured trial version of Photo to Movie today 
and get ready to be amazed. Experience Photo to Movie's powerful 
leatures for yourself. Visit our web site for details. Retail price $49.95 
Available for Mac OS X or Windows XP. 

SPECIAL OFFER! 
8200FF 

the retail price when you use the online code 
PTM122505 at www.PhototoMovie.com 

CNET EDITOR'S RATING: 

DDDDD 
July 2005 Issue 

Phot • OVIB 
www.phototomovie.com 
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PhotoKit Color 
COLORFUL PHOTOSHOP PLUG-INS 

P ixelGenius's Photo Kit Color is a set 

of Photoshop plug-ins that lets you 
adjust your images in many artsy and 
practical ways, producing professional 

results in almost no time at all. 
The filters include Cross Processing 

(techniques ofteri done in a photo lab), 

Color Overlays, Split Toning (tone effects 
for black-and-white or color photos), Tone 

Enhance, Color Enhance, CC Correction 
(color-compensating filters) , CT 
Correction (color shifting), and RSA Color 
Correction (color balancing) . It takes 
time to get a feel forthe color-correction, 
but it's time well spent-the filters can 

produce precise results that aren't easy to 
get using Photoshop's Curves, Levels, or 
Hue/Saturation controls. RSA Correction 
aims to give a neutral tone, but it can 

falter if your image doesn't have 
distinct black-and-white points . 

The Cross Processing 

and Split Toning filters 
achieve the same 

kind of results you'd 
get from traditional 
film -based cross 
processing and split 

toning. Tone Enhance 
and Color Enhance 
could have been sold as their own plug-in 
pack-these are some of the best filters 

on the market, adjusting your images so 
it looks like you made the right exposure 
to begin with instead of just lightening or 
darkening your whole image. 

Unlike many Photoshop plug-ins, 
Photo Kit Color doesn't have ,a preview 

PhotoKit Color can take an original (l~ft), add a 
yellow light (middle), or give it a grainy look (right). 

window. Fortunately, the filters are fast , 

so you don't have to wait long to see how 
an applied filter looks. 

The bottom line. PhotoKit Color 

t ransforms so-so images into usable 
ones, turns good photos into great ones, 
and make it look like we, too, are pixel ,, 

a: 
geniuses.-Steven Parke ~ 

x. 
9~ 

COMPANY: PixelGenius REQUIREMENTS: PowerPC, 
CONTACT: www,pixelgenius,com Mac OS 9-1 to 9,x or 10,1.3 or later, 

GOOD NEWS: Fast Excellent, profess1onal-looking results, 
BAD NEWS: Can't preview effects. 

---~~~~~~~~, ! 
MacAddlct RATED ?D 

00000 I 
GREAT I 

x. 

PRICE: $99,95 128MB RAM, 35DMB disk space, 
Photoshop 7 or later 

Micro Hard Drive 
SNAZZY USB HARD DRIVE 

The coolest thing about the Micro Hard 

Drive is what's inside its chic case : a 
2GB or 4GB 0.85-inch Toshiba hard drive. 
That's about the size of a postage stamp. 

(Insert your own "I remember when hard 
drives were yay big" memory here.) 

The Micra's case measures 1.61 by 

0.66 by 3.3 inches, and its tuckable, 
durable USB 2.0 connector gives the 
drive its padlock look. While we didn't 
hear a peep (or a beep) out of the 
3,600-rpm Micro, we did notice that it 
heated up during our t'esting-though not 
so hot that we couldn't touch it; we're 
talking PowerBook-type warmth . The 
drive continued to work without a glitch 
despite the heat. 

Speed. Imation touts a read speed 
of SMB per second and a write speed 

3MB per second, and our 

test results came close to 
those numbers. Using the 
Xbench benchmarking 
tool (free, www.xbench 

.com) on our dual 2.7GHz 
Power Mac GS, we got an 
average read speed of 
4.67MB per second and 
an average write speed of 

2.97MB per second. When 
we duplicated 200MB of 
files of various sizes in the 
Finder, however, the Micro 
took a sluggish 19 minutes. 
Thedrivecomesbund~d 

with version 1.0 of lmation's Security 
Manager software, which functions fine 
with earlier versions of Mac OS X, but 

GOOD NEWS: Nice design, 

Inside this case is the 
world's tiniest hard drive. 

doen't work with Mac OS 
10.4 (Tiger) . Imation says 
it 's working on a Tiger
compatible version that 
will soon be available at 
lmation's Web site. You can 

assign a password to the 
drive, but oddly, we were still 
able to access our password
protected drive on Macs not 
running the Security Manager 
software. 

The bottom line. The Micro 
Hard Drive provides a lot of storage in a 
lil' package. Just don't bother with the 
software.-Roman Loyola 

MacAddict RATED COMPANY: Imation 
CONTACT: 888-466-3456, 
www,imatimcom 

REQUIREMENTS: USB
equipped Mac, Mac OS m2 
or later 

BAD NEWS: Bundled software doesn't work with Tiger. 00000 
GREAT PRICE: $159 (2GB, tested) , $189 (4GB) 
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Squeezebox2 
COMPROMISED DIGITAL-MUSIC PLAYER 

iTunes in the 
living room. 

S lim Devices ' Squeezebox2 connects 
to your Wi-Fi or Ethernet network and 

to your stereo or powered speaker system 

so you can play music from your Mac in 
another room. It's not as straightforward 

as Roku's Sound Bridge ( " 
Feb/05, p46), but it's a capable device. 

Setup is reasonably simple. Attach it 
to your music system via the included 
ana log stereo RCA cable or your own 

digital-optical or digital-coaxial cable, 

screw in the antenna, and enter your 
network's password . (Neither the 

antenna nor the password is required for 
an Ethernet connection.) Then, go to your 

Mac, download the SlimServer software 
from Slim Devices' Web site, install it, 
and tell it where your music files are 

stored . If you keep them all in your iTunes 
Music folder, SlimServer recognizes your 

iTunes playlists; if not, SlimServer's Web 

interface lets you set up 
playlists yourself. Slim Server 

supports MP3, WAV, FLAC, WMA, 

AIFF, unprotected AAC, Ogg Vorbis, 

and Apple Lossless files. Once set up, 
you use the included remote to browse 

artists, albums, or playlists; play songs; 
control volume ; and so on. 

When it comes to playing your iTunes 
music, Roku's Sound Bridge wins over 

the Squeezebox2 on several counts. 
Squeezebox2's SlimServer software 

recognizes new playlists you create 
in iTunes, but it doesn't forget ones 
you deleted in iTunes unless you force 

a refresh through SlimServer's Web 
interface. And while the Squeezebox2 
display shows the name of the song 

currently playing, it doesn't show the 
artist or album info (as the Sound Bridge 

does) without a few extra remote clicks. 

The sound 
quality from 

the Squeezebox2, 

however, is better than 
that of the Sound Bridge when 

played through a stereo system, though 
the difference was less noticeable on 
powered speakers . Squeezebox2's 320-
by-32-pixel display can play animated 
frequency spectrums or a visualizer. 

The bottom line. The Squeezebox2 
can do a few things the SoundBridge 

can't, such as serve as an Ethernet 
bridge or play music located somewhere 
other than your iTunes folder. But if 
you just want a streaming iTunes music 
player, the SoundBridge is a better 
choice-at $149.99 (including Wi-Fi) 

for the base model, it's cheaper, easier 
to set up, and better-integrated with 

iTunes.-Jake Widman 
,_~~~~~~~~ ....... 

COMPANY: Slim Devices 
CONTACT: 650-210-9400, 
www.slimdevices.com 

REQUIREMENTS: Mac OS 10.1.5 or 
later, Ethernet or Wi-Fi network 

GOOD NEWS: Reads !Tunes playhsts and plays 
Internet radio stations. Can act as an Ethernet bndge. 
BAD NEWS: Expensive. Requires additional 
(downloadable) software. Inconsistent display 

MacAddict RATED 
00 

SOLID PRICE: $199 (wired), $279 (wireless) 
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Combine the legendary Star Wars 
saga with classic LEGO blocks, 

and what do you get? LEGO Star Wars, 
obviously, a game with charm and 
plenty of humor. The blend of licenses 

works surprisingly well, from the music 
and sound effects (ripped right from the 
movies) to the blocky graphical style of 

the environments. 
Tons of toys. You control one of over 

40 characte rs from Episode I, II , and Ill 
(sorry fan boys, pregnant Pad me is not 

a playable character) in a game that 
plays much li ke a platform· hopping 
Mario game-only instead of collecting 

Your defeated foes shatter into their 
component parts-and valuable studs. 

offers a Free Mode in which you pick 
two different characters and run a level 
again, unlocking more hidden areas-it's 

a compelling reason to replay levels 
multiple times, and it nicely extends the 

life of the game. 
Multiplayer play is handled well, as 

a second player can jump in at any time 

to take control of a Mac-operated ally 
already in the action. The controls can be 

a little wacky, especially since you can't 
control the camera, but calibrat ing your 

gamepad in the main menu coins, you collect LEGO 

studs. Combat can be 
repetitive-you just hack 
through levels-but each 
character has special 

abilities that add some 
variety. To reach difficult 

places, for example, Jedi 
Knights can use Force powers 

to flip switches and levitate 
structures; Jar Jar Binks (yes, 
that Jar Jar Binks) can jump 
higher than most; and Pad me 

can use her grapple gun. 

JJ' BELLY UP 
TO THE BAR 

helps the responsiveness 
of your character. LEGO Star 
Wars runs fairly decently on 
a Mac that meets the game's 

minimum requirements, 

Go to Dexter's Diner, then 
head to the bar where yo u 

type in codes. Enter th ese 
codes to enhance your 
gameplay: 

LD1168 Revea l an arrow 

that points to canisters. 
RP924W Put mu staches 

on yo ur charac ters . 
4PR28U Make your 

characte rs invincible. 
L449HD Enable cla ssic 

movie blasters. 

but the action suffers from 
serious slowdown during 

more chaotic scenes where 
LEGO chunks are flying 
everywhere-bringing back 
childhood memories of 

hundreds of LEGO bricks 

strewn across the floor while 
Extras. LEGO studs are hidden 

everywhere; collect enough, and you can 
turn them in to earn more characters, 
unlock goodies, and get parts to build 
trophy vehicles that appear outside of 
Dexter's Diner. You won't be able to get 
all the studs in one trip, so the game 

building LEGO castles, cars, houses, and 
airplanes. 

COMPANY: Aspyr 
CONTACT: 888-212-7797. www.aspyr.com 
PRICE: $29.99 

The bottom line. LEGO Star Wars 
offers fun and simple gameplay for 
Padawan gamers while still holding the 
attention of Yoda-aged fans . May the 
blocks be with you.-Matt Osborn 

REQUIREMENTS: 1.2GHz G4, Mac OS 10.3.8 or later, 
512MB RAM, 2GB disk space, 32MB ATI Radeon 9000 
or GeForce FX5200 video card or better 

CiOOD NEWS: Great gameplay Charming Flexible mult1player on the fly 
BAD NEWS: A little short for a stormtrooper Need Skywalker-class skills to 
finish the pod-racing level 

MacAddict RATED 
00 

SOLID 
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TC1000BN 
Power Ready 
Notebook Case 
GADGET-CHARGING 'BOOK 
CASE 

I fyou're juggling an iPod , cell phone, 
PowerBook, and PDA, you could spend 

half your life trying to keep everything 

recharged . APC's TC1000BN Power 

Ready Notebook Case cuts down your 
charging time by letting you plug in your 

gear without taking it out of the bag. Set 

the voltage dial on the included power 
supply to 20 volts for your PowerBook, 
attach the appropriate adapter to the 
power supply, and then run the cables 

through the bag's compartments to all of 

Glamorous? No. Power-full? Yup. 

your gear. A USB splitter lets you charge 

two USB devices at a time, and a host of 
adapters-including a FireWire one for 
your iPod-let you attach different kinds 

of devices. The case easily fits 15-inch 
PowerBooks and 14-inch iBooks, and it 
has a restraint strap for 12-inchers. 17-

inchers need not apply. 
The bottom line. With a conventional 

ballistic-nylon design, the Power Ready 
Notebook Case puts function before 
form. But the trade-off in convenience 
is well worth a little sacrifice in fashion . 
-Robert Strohmeyer 

COMPANY: APC 
CONTACT: 
877-800-4272, 

REQUIREMENTS: 
PowerBook, iBook, cell 
phone, PDA, or any other 
power-hungry gadget small 
enough to fit. 
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Runs well, looks amazing, and does something so Incredibly unique: . Chris Plrillo, lockergnome.com 

Your Life in a Comic! 

Apple Design Award 
Best Product New 10 ~OS X 
200SWinMr 

Macworld 

••••t 
maotOME ••••• 

"COMIC LIFE IS ONE 
OF THE MOST CREATIVE, 
INTUITIVE, ELEGANT, AND 

FINaY CRAFTED PIECES OF 
SOFTWARE I'VE EVER SEEN" 

KEVIN COPELAN(), FATHER TYLER HALL, PROGRAMMER 

"BRILLIANT! THIS IS PERFECT FOR 
STORYBOARDING OR PANEL BREAKDOWNS 
FOR COMIC BOOK PR0.:7ECTS. THIS WILL 

HELP COMIC ILLUSTRATORS LIKE ME PLAN 
THINGS our.· 

AOAM GLAZER, COMIC ARTIST 

The fun photo comic creation software 
with tons of uses: 

·Comics 
·Annotated family photos 
·Children's story books 

·'How-to' Guides 
·Greeting cards 
• Posters and more! 

available at select Apple 
resellers and online at 

FREEVERSE.COM 



Pixma iP4200 
AFFORDABLE 
INKJET PRINTER 

Tree huggers 
may like the 

iP4200's ability 
to print on 

double-sided 
photo paper. 

I fyou know someone who talks out of 
both sides of his or her mouth , you 

probably don't call that person your 
friend. But when you see the Pixma 
iP4200 print 8-by-10-inch photos on 
both sides of a single page, you just 
might fall in love. 

The iP4200 is an affordabl~ photo 
printer for the masses. Its two direct
feed trays let you switch from 4-by-6-
inch prints to 8-by-10-inch ones without 
having to change the media in the tray. 
Just select your size in the onscreen 
printer dialog, and the iP4200 knows 
which tray to grab the media from-and 
if you choose two-sided printing, it 
automatically sucks the media back in 
to print on the second side. 

In our tests, the iP4200 consistently 
produced 4-by-6-inch prints in well 
under a minute and generally printed 8-
by-10-inch images in just over 2 minutes. 
However, because the multicartridge 
print system needs frequent automated 
cleaning, these print times sometimes 
extended to 3 minutes or more. 

Unfortunately, the occasional longer 
waits don't really correspond to better 
images. Even crisp 2,272-by-1,704-
pixel images-the highest resolution 

possible on our 4-megapixe l Canon 
test camera-tended to come out a 
little fuzzy on the supplied 8-by-10-
inch photo media. This problem was 
far less noticeable, but still present, 
in 4-by-6-inch prints . Color quality, 
however, was impeccable. From dark, 
rich reds to pale ivory highlights, the 
iP4200 matched our original images 
beautifully, even teasing out subtle 
variations in bright summer skies. 

At only $130, we find it hard to criticize 
the Pixma iP4200 too severely. Certainly 
we expect some sacrifices-for example, 
the iP4200 cuts corners by leaving out 
the memory-card slots that have become 
so common on photo printers. It does, 
however, offer a USB port on its front 
panel for PictBridge printing directly from 
your camera. 

The bottom line. Ultimately, if 
you're hardcore about your digital 
photography, the iP4200 is probably 
not the printer for you. It simply lacks 
too much in the way of imaging prowess 
to satisfy the Photoshop set. But if you 
want an inexpensive photo printer that 
produces decent images and two-sided 
prints, the iP4200 is a good choice. 
-Robert Strohmeyer 

COMPANY: Canon REQUIREMENTS: USS-equipped Mac, 
CONTACT: 800-652-2666 or 516-328-5000, www.canon.com Mac OS 10.2.1 or later 
PRICE: $129.99 

GOOD NEWS: Good overall speed Two-sided photo printing lets you 
create albums with ease 
BAD NEWS: Images lack sharpness No memory-card slots. 
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ot ist 
THE BEST OF THE BEST FROM RECENT REVIEWS 

The legendary ARP2600 analog synth 
rocked the seventies, but according 

to Mac-music guru David Biedny, its 
digital, polyphonic progeny is "even 

better th an the real thing." 

Imaging pro Steven 
Parke declares that this 

package of Photoshop 
plug-ins "deserves to be 

added to the arsenal of 
any photo professional 

or se rious amateur." 

miniStack o-------
After putting a trio of Mac mini-styled 
hard drives through their paces, 

MacAddict Reviews Editor 
Roman Loyola found 

the miniStack "stood r=--=--;;;;;;;:;;;;:::;;;:::;,, __ 
out from the pack." 

Mercury 
Elite-AL Pro 
Roman Loyola says, "There's a lot to like 

about the Mercury Elite-great speed, a 
nice case, and a plethora of connectivity 
options." 

Adobe lnDesign CS2 

Adobe Photoshop CS2 

Adobe Photoshop Elements 3.0 

Corel Painter IX 

LaCie Big Disk Extreme 500GB 

LaCie d2 DVD± RW Double Layer 

Newer Technology mlniStack 400GB 

OWC Mercury Elite-AL Pro 400GB 

Sony DRX-710UL-T 

WiebeTech TrayDock 

$249.00 Aug/05, p42 This workflow app amps up any lnDesign team's productivity. 

$699.00 Aug/05, p40 A strong upgrade to the world 's most feature-rich layout app. 

$599.00 Aug/05, p38 A raft of new photo-focused features makes this upgrade rock. 

$89.99 Mar/05, p36 Adobe's affordable image editor gets a significant upgrade. 

$429.00 Feb/05, p38 This natural-media champ is now faster and more capable. 

$399.00 Aug/04, p55 Cutting-edge technology provides cutting-edge performance. 

$1 49.00 Feb/05, p48 Cram 8.5GB of data onto DVDs with this speedy burner. 

$359.99 Nov/05, p42 This speedy Mac mini-style drive is also a FlreWire and USB hub. 

$329.99 Nov/05, p50 Speed, a great case, FireWire 800/400, and USB 2.0-all good stuff. 

$229.95 Jun/05, p46 This double-layer burner has scorching single-layer performance. 

$169.95 May/05, p49 This slick hard-drive enclosure provides the ultimate in flexibility. 
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BURNING VOLUME QUESTION 
When I burn an audio CD, its volume 
level comes out much lower than a 

store-bought CD's. How can I fix this 
problem? 

~ Crossfade playback 

~ Sound Enhancer 

low 

' ' stc:onds 

You can uncheck Sound Check. 

Many variables affect your burned 

12 

hlQh 

CDs, from the bit rate and source to 
the quality of the original CD rip. But 
the most common cause of volume 

discrepancies is iTunes' Sound Check 
feature, which adjusts song playback 
so that all songs play at about the 

same volume. Try turning it off-go to 

iTunes >Preferences; in iTunes 4.x, click 

quick 
answers 

QUICKIE SETUP 
I have to set up a whole lab of iMacs. 
How can I bypass the registration 
screen that comes up the first time I 
turn them on? 
The registration screen is actually an 
app, so just press Command-Q and then 
click the Skip button. This takes you 
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the Audio tab ; in version 5, click the 

Playback tab. 

VISUAL CAPTURE 
Is there a way to capture iTunes' cool 

Visualizer as a movie? 

Snapz captures as much of the on screen 

action as you desire. 

iTunes generates its eye candy on the 
fly, so you can't just grab a movie file 
out of a some hidden folder. What you 

can do is intercept the visuals with a 
screen-capture utility such as Snapz 

Pro X 2 ($69, on the Disc or download 
from www.ambrosiasw.com), which 

lets you capture all or 
ON THE part of what happens 

DISC on your screen as a 
SnapzProx 2·0·2 QuickTime movie. 

KEY EJECT KEY 
I replaced my iMac keyboard with a 

non-Apple keyboard. Now I can't eject a 
CD since there's no Eject key. Do I have 
to buy an Apple 'board? 
If your keyboard lacks Apple's official 
upper-right-hand-corner Eject key, 

you can eject CDs or DVDs by pressing 

right to the Mac OS X setup screen to 
create users and passwords. 

NAMELY 
Is there a way to find and launch an 
application by just typing its name? 
There is indeed. Just download the 
wonderful Namely (free, on the Disc or 
download from http://homepage.mac 
.com/asagoo/namely); open it, start typing 
any installed app's name, and Namely will 

ON THE 
DISC 

Namely 1.6 

find and launch it. Of 
course, Tiger's Spotlight 
can do this, but Namely 
is much faster. 

and holding the F12 key until the eject 

symbol appears on your display. And 
don't fret, Dashboard fans-you can still 

tap F12 to activate Dashboard. You can 
also change Dashboard's default trigger 
key in System Preferences > Dashboard 

& Expose. 

I WANT CD TEXT! 
When I burn CDs in iTunes to play in my 
car stereo, I can't get CD Text to display. 
What's the secret? 
CD Text is just additional info placed at 
the header of a disc; some CD players 

use it to display song info (such as artist 
and title) while playing. Unfortunately, 

iTunes can't create discs with CD Text. 
While you' re waiting for this feature 

to show up in a future version, Roxio's 
Toast ($99, www.roxio.com) offers the 

ability to burn discs with CD Text, as 
does NewTech lnfosystems' Dragon 
Burn ($40, www.ntius.com) . 

S-T-R-E-T-C-H 
I just installed Tiger on my 17-inch 
PowerBook G4. Now, every image and 

icon seems to be about 10 percent wider 
than it should be. All my pictures, iPhoto 

slideshows, and Quicklime movies are 
stretched horizontally. What happened? 

• II 
hardy har hard drive hardy har hard drive 

Before (left) and after (right). Fix the 

fun house-mirror effect. 

Your PowerBook's wides creen display 

has a 16:10 aspect ratio, which is wider 

TIGER SANS DVD 
I see that Tiger comes on a DVD. How 
am I supposed to install it on my DVD
challenged eMac? 

Since you can't install Tiger via an external 
DVD drive, you'll need to get your new OS 
the old-fashioned way: on CDs. Apple's 
Media Exchange Program (www.apple 
.com/macosx/upgrade) offers Tiger CDs 
for $9.95-and yes, you have to first buy 

the Tiger DVD to qualify for this deal. 

EMAIL PANE PAIN 
When I launch Apple's Mail, the 
highlighted message is already open 



than the old 4:3 standard associated 
with resolutions of 640 by 480, 800 
by 600, and 1024 by 768. Your 'Book's 
native resolution is 1440 by 900, but in 
the name of backward compatibility, it 
can display 4:3-aspect-ratio resolutions 
of 640 by 480, 800 by 600, and 1024 by 
768, placing black bars along the edges 
or stretching the screen to fill the extra 
display space. To unstretch your screen, 
go to System Preferences> Displays and 
set your resolution back to its native 
1440 by 900 pixels . 

DRIVE-SPACE REFRESHER 
I have my desktop View Options (in the 
Finder, go to View> Show View Options) 
set to Show Item Info so I can quickly 
see how much space is available on 
my hard drive by just looking at its 
icon-but it only updates after I restart 
my Mac. What gives? 
A restart isn't absolutely necessary. To 
force your desktop to show your hard 
drive's proper info, copy any file to the 
root level of the disk. If you have multiple 
hard drives, you have to do this for each 
drive separately. 

Bonus tip: 
Shrink the 

Text Size 
to avoid 

truncating 
yourdisk

space info. 

0 Dcsk[op 

Icon size: 5 2 x 52 

I I I f I I I t 

Small Large 

Text size: '. 12 pt : J 
Label position : 
0 Bottom 0 Right 

Show icon preview 

Keep arranged by 

Name 

and flagged as read. I prefer to confirm 
that I want to read a message before I 
open it. Can I do that? 
Sure. Simply double-click the dimple in 
the center of the horizontal bar between 
the message list and the message-

~ ,. • • From 
• Rlk Myslewskl 

Rlk Myslewskl 
• Rlk Myslewski 

... 0 1 .. i.. "'""~ .. ,~ .... .i t -

F\Y: Powe rBook and 180 
fW: How Can I Setup 2 Y 

UalG . .>cu, rV.;M:r)J .::W~ Ulf.=Ju.-.-. -U IV\I 1r- u11--- -

To: <1etters.9:nJAtaddlctco1J1> 

Double-click the dimple to hide message 
previews-or drag it to resize the panes. 

TERMINAL UNIX 
You guys are always crowing about Mac OS X's "Unix underpinnings." 
What the hell is that supposed to mean? How and why is all this Unix hidden? 
Mac OS X's foundation is the tried-and- Finder, use Cocktail ($14.95, on the Disc 
true Unix operating system, which- or download from www.macosxcocktail 
after years and years of tweaking by .com); launch the app and go to Interface > 
many very smart people-is highly Finder. Check the Show Invisible Items 
stable. However, without the happy box and click the Restart button to 
face Apple has added to it, Unix is too relaunch the Finder. Now if you need to, 
arcane and cryptic for ordinary users (or say, tweak your Apache Web server's 
even many experienced users). That's configuration file or append your hosts 
why Apple chose to make the inner file with updated server information (part 
workings invisible from the Finder-out of your daily chore routine, right, Mister 
of sight, out of mind. This lets Apple's Smartypants Obergeek?), you can find 
graphical user interface (GUI) take the required files (/etc/httpd/httpd.conf 
control and allow for a pleasant and and /etc/hosts, respectively) in a Finder 
easy-to-use experience. If you really window and edit them in TextEdit-no 
must see all the directories (such as Terminal hijinks required. But be wary-
the oddly named etc, bin, opt, and moving, deleting, renaming, or messing 
var), you can do so-just open Terminal with any hidden Unix 
(/Utilities/Terminal) and type Is -a to files can cripple your ON THE 

DISC view everything. If you want to see all Mac-another reason 
the hidden Unix directories from the why Apple hides them. 

,- Finder Dock Expose 

@ ow ;nvls;ble ilems 

_ ostcon g 
_ hostconfig ... 

hosts 
_ magic 

_ magic.default 
mime.types 

(......; Show Quit In Finder menu 

Dlsable window zooming Cocktail has many powers, both simple and advanced. 

STEREO IN MONO 
Is there a way to get my Mac's audio to 
output in mono so both channels are 
sent to both sides? I want to listen to 
music with just one of my earbuds in so I 
can still hear what's going on around me. 

preview pane-the preview pane will 
disappear. To get your previews back, 
find the dimple at the bottom of the 
message list and double-click it again. 

KEEP IT SIMPLE 
I like to write my blog posts in TextEdit, 
then copy and paste them into my 
blog-but sometimes my blog software 
turns the text into gibberish. Help! 
TextEdit saves documents as RTF (Rich 
Text Format) files by default, but most 
blog kits can't deal with RTF. When you 
launch TextEdit, select Format> Make 
Plain Text to switch to a bloggable format. 

You might think that the Balance slider 
in System Preferences > Sound would 
accomplish this, but that's not the case. 
As a matter of fact, there is no built-in 
way to make stereo sound monaural in 
Mac OS X- but your local Radio Shack 
stocks a $3.99 solution. Pick up a Gold 
Stereo-to-Mono In line Adapter (www 
.radioshack.com , catalog number 274-
882) . It merges the two stereo channels 
into a single monaural signal that plays 
through both channels so you can keep 
one ear to the wall. 

,.rt::,., Buz Zoller is a graphic designer living in 
~ Florida. He has been a devoted Mac 

user for ove r 10 years and has worked for 
both Apple and Power Computing. 

S b •t technical questions u m1 or helpful lips directly 
via email (askus@macaddict.com) or c/o 
MacAddict, 150 North Hill Dr., Ste. 40, 
Brisbane, CA 94005. 
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Make Over Your Mac with Custom Icons 
by Johnathon Williams 

WHAT YOU NEED 

Mac OS 10.3.9 or later (for lconBuilder) 

lconBuilder 8 
($79, on the Disc, www.iconfactory.com/ 
iconbuilder.asp) 

Photoshop Elements 2 or later 
($79.99 download, www.adobe.com) or 
Photoshop 7 or later ($599) 

MacMerc styles (free, www.macmerc.com/ 
sections.php?op =viewarticle&artid = 70) 

It's your desktop-jazz it up with icons of your own design. 

W 
hen it comes to icons, we Mac users are spoiled 
rotten. Thanks to Aqua's visual goodies, Mac 
OS Xis the only operating system on the planet 
with icons that look good enough to eat. Here, 

we show you how to design you own Aquafied icons, complete 
with lickable lighting effects and delectable drop shadows. 

Before you get started, understand that while we've 
selected tools that make icon-crafting easy, it still takes time, 
effort, and good ol' paw-on-mouse action. Grab Icon Builder 
from the Disc, download the three MacMerc style presets 
(Aqua Sphere, Aqua Sphere Overlay, and Icon Subject) from 
the link in "What You Need" above, and prepare to get iconic. 

To install the Icon Builder plug-in, drag it to /Applications/ your 

version of Photoshop/Plug-lns. Drag the Icon Builder Essentials 
folder to someplace handy; you'll need it later. Open Photoshop and 
press Command-N to create a new document; enter 128 pixels in the 
Width and Height fields, set the Color Mode to RGB Color (leave the 
second pull-down menu on 8 Bit), and select Transparent from the 
Background Contents pull-down menu. Photoshop users: Select the 
Styles pa lette (Window > Styles), click the arrow on the top right, and 
click Load Styles. Use the Load dialog that appears to locate the three 
MacMerc styles you downloaded earlier. Select them, click OK, and 
the styles will appear in the palette, ready to use. Elements users: 
Drag the style files into I Applications/ Adobe Photoshop Elements/ 
Presets/Styles, and they'll appear in the Layer Styles pull-down menu 
within Elements' Styles And Effects window (Window> Styles And 
Effects). 

Select the Custom Shape Tool from the Tools palette 
(Window> Tools) , and click the drop-down Shape menu 

from the Options palette (Window> Options in Photoshop; 
Window> Tool Options in Elements) . Click the arrow at the top 
right, and select All in Photoshop or All Elements Shapes in 
Elements. Choose a shape for your icon-we chose the yin-yang 
symbol because of the sense of harmony it can bring to even the 
most cluttered desktop. Next, click the Color box in the toolbar, 
and select a primary color for your icon-we chose dark red. 
Finally, use the Custom Shape Tool to draw the shape within your 
document, leaving a little space on all four sides. (You want in the 
neighborhood of 10 pixels on the top and sides and about 20 at the 
bottom. It doesn't have to be exact, so feel free to eyeball it.) 
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Name: l~v Great Icon ____ I 
Preset: ( Custom !·f----. 

Width: I 12 8 I( pixels 
~----~ 

Height: [fr? -~ _ \ ( pixels 
'--------~~ 

Resolution: lf2 ___ I'. pixels/inch 

Color Mode: : RGB Color : } '.~B_b_i_t ---~~ 
Background Contents : ( Transparent 

'-----"'"------------'----' 

G Advanced --------------

Every great artist needs a canvas. Make yours transparent. 

Photoshop's custom shapes make a perfect starting point for 
icon designers- they're simple, tweakable, and free. 
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Ordinarily, you would now have to spend hours futzing 
with lighting and layer effects to match Apple's Aquafied 

stylings. Fortunately, the good folks at MacMerc have saved you 
the trouble. In the Layers palette, select the layer that contains 
your shape. ln the Styles palette, select MacMerc Aqua Sphere. 
Select Layer> Rasterize >Layer in Photoshop or Layer> Simplify 
Layer in Elements. Then select Layer> Duplicate Layer and 
click OK in the resulting window. In the Layers palette, select 
the copy of your original layer. Select Edit> Fill. From the Use 
drop-down menu, select 50% Gray; in the Blending area, check 

Preserve Transparency; then click OK. 
Finally, in the Styles palette, select 
MacMerc Aqua Sphere Overlay. 

MacMerc's Aqua styles work 
best with spherical shapes, 
but they're worth trying on 

Open Icon Builder's Macintosh template (Icon Builder 
Essentials> Icon Builder Grid Files> Macintosh.psd). In 

the Layers palette, select the layer with the placeholder folder 
icons, and click the eye icon to hide it. Go back to your icon
design window, select the Move tool, and drag the whole design 
into the Macintosh.psd file you just opened. Place your design 
so that it fits within the large box on the left. Photoshop users: 
Open the Actions pa lette (Window> Actions), click the top-
right arrow, select Load Actions, and navigate to / Icon Builder 
Essentials/ Icon Builder Assistant. Double-click the Icon Builder 8 
Assistant.atn file, and Icon Builder's actions will appear in your 
Actions palette. Click the action labeled Generate Macintosh 

,,. Standard, and Photoshop will 
automatically resize your icon 
and place it within the smaller 
boxes on the template . Elements 
users: See step 6 instead . 

lconBuilder's Photoshop actions 

With all of your icon sizes in place on one layer, press 
Command-A to select everything, an'd select Filter> 

Icon Factory> lconBuilder 8.0. If you see an error message, click 
OK to make it· go away. From the top-left drop-down menu, 
select Macintosh-Normal. Your icons should appear with the 
appropriate boxes around them on the right side of the screen . 

[Icon Builder 

To build your icon, click the left
pointing arrow in the middle of 
the window. Finally, click Save, 

[ Macintosh - Normal : i too = .. =.~= .. = .. ==,,= .• ,==.= .. ::;:::=:::,= .•• =-.~..... and choose a name, format, 
121hcl28 Nomu.I ~ 

48r48 

1211.}2 

16d6 

and location for your icon. 

Icon Builder automatically adds 
the necessary system resources 
to your icon file, sparing you a lot 
of time and trouble. 

Our yin-yang shape looks pretty 
good at this point, but we can 

do better. In the Layers palette, select 
the original shape layer (it should 
be called Shape 1) . Select the Magic 
Wand from the Tools palette, and click 
on the open, transparent area inside 
the shape. Press Command-Shift-N to 
create a new layer and give it a name. 
Now, click Edit> Fill in Photoshop or Edit 
>Fill Selection in Elements, select Color 
from the Use drop-down menu, and 
choose a color to fill the space. Finally, 
making sure the new layer is selected in 
the Layers palette, select MacMerc Icon 
Subject from the Styles palette. Now 
press Command-Shift-E to merge the 
layers. Badda-bing! Your icon is ready. 

'V Layers 

{ Normil ~ : l <>P1t11Y:~ 
w !>. ,.. LOck; 0 Q 

l' lfd " 
U.yul 

f' I ~ Sh1pt ltOOY 

[911 © SN.pt I 

A second color or 
element adds depth. 

Lacking the almighty Actions palette, Elements users 
must prep the icon manually. After dragging your design 

into the template's biggest (128-pixel) box, go back to the 
design window and drag your icon in again-only this time, use 
the box corners to resize the icon to fit into the 48-pixel box, 
and repeat the process to fill all four boxes. Now proceed to the 
Layers palette and use the far-left column to hide all layers that 
don't contain a copy of your custom icon . Press Command-Shift
E to merge the visible layers into one layer. 

Elements lacks support for Actions, so you have to 
resize your icons and merge your layers manually. 

PASTE IT INTO PLACE 
The quickest way to get your new icon onto your desktop is 
to select lconBuilder's option to save it as a folder icon. To 
reuse your icon, select its folder in the Finder, choose File> 
Get Info (or press Command-I), click on the icon in the upper
left corner of the Get Info window, and choose Edit> Copy 
(or press Command-C). Now do the same with whatever file 
or folder you want to iconicize; only this time, select Edit> 
Paste (or press Command-V) instead of Edit> Copy. 

JV READ THE FORKIN' MANUAL! 
Apple breaks its icons down by function into various design 
families. To view th e nitpicky guidelines, head to http: // 
developer.apple.com and search for Aqu a Icon s. 
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tr back up your iTunes tunes 

Back Up Your iTunes Tunes 
by Niko Coucouvanis 

WHAT YOU NEED 

iTunes 4 or later (free, www.apple.com/itunes) 

Digital audio files (MP3, Apple Lossless, AAC, 
or whatever) 

Blank CD or DVD discs 

Dragon Burn (optional, $40 download, 
www.ntius.com) 

W 
ith the advent of digital music and 
the iTunes Music Store, you probably 
have a good number of possessions 
that you only possess in digital form, 

stored on a Mac that could be stolen, fried by 
lightning, brain -munched by hungry zombies-or 

worse . Here's how to back up the songs you 
bought from iTunes-and we mean back up for your 
own use, not to burn a bunch of copies for your 

deadbeat friends . 

Apple can't make it too easy to convert your purchased music into an 
unprotected format-legal weasels call that enabling (as in enabling 

folks to easily steal music) . To clarify: It's completely legal and within your rights 
to back up the songs you've bought in your format of choice-just don't make 

four copies for your mom and her bridge club. 
Launch iTunes, select iTunes >-Preferences, and click the Advanced tab. In the 

Burning pane, select Audio CD (if you're using iTunes 4.x, there is no Advanced 
tab ; just click the Burning tab instead) . Set the Gap Between Songs if you like, 

and check the Use Sound Check box if you'd like iTunes to normalize the volume 
across tracks . Hint: You can adjust any track's volume individually by opening 
the track's Info window (select the track and press Command-I) and selecting 
Options; Volume Adjustment is the topmost slider. 

How you organize your music collection is up to you, but the 
easiest way to create backups is to first create a playlist for each 

album. Click the plus-sign button in iTunes' lower-left corner to make 
a new playlist, and then type in the album name : Acid Eaters in our 
example. (Hint: If you want it to keep your album playlist alphabetically 
sorted with your other Ramones albums, name it Ramones_Acid Eaters 
or something similar.) After naming the playlist, select Purchased from 
iTunes' Source list, click the Artist or Album column header to sort by 
artist or album, Shift-click to select multiple songs, and drag the selection 
onto the appropriate playlist. Bonus: Notice how short all of these 
Ramones songs are? You could easily back up three or four Ramones 
albums in uncompressed AIFF format on a single CD. Just keep track of the 
status readout at the bottom of the iTunes window to keep your list within 
the size limits of your blank CD (typically 650MB to 700MB). lfyourtunes 
are in a compressed format, the megabyte number is misleading-look at 

.h 
P.:irent;il 

1----~ General Importing Burning +------1 

CD Burner: ~ PIONEER DVD- RW DVR-1070 : l 
Preferred Speed: ~ Maximum Possible ; ) 

Oise f ormat: 0 Audio CO 

Gap Between Songs: : 4 seconds : J 

CJ Use Sou nd Check 

If you lose your purchased music, you can't just go 
download a new copy- better make a backup. 

the time instead. (Audio CDs fit about 74 to 80 minutes.) Organizing your music into playlists is the only way to burn. 
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With your preferences set and your playlists stocked, 
initiat ing the backup is a push-button affai r- just highligh t 

a playlist in the Source list and click t he Burn Disc button in iTunes' 
upper-right corner (or se lect File > Burn Playlist To Disc) . This will 
create a standard audio CD that you can play in the car, home 
ste reo, or any modern CD-p laying device-such as your Mac. To 

restore the songs to your Mac in t hei r original format, open iTunes 
>Preferences, click the Advanced tab, and select Import ing. (In 
iTunes 4.x, there is no Advanced tab; just se lect t he Importing tab) . 
Select AAC Encoder or your encoder of choice from the Import Using 
pull-down menu. 

Got a lot of music? Once your iTunes libra ry grows past a 
few gigs, backing up to CDs becomes annoying. So if your 

Mac has a DVD-capable drive, use a DVD disc instead- 4.7GB 
goes a long way. To best fill the space, create a new playlist as 
described in step 3, and keep dragging other play lists onto it until 
the status bar indicates your disc is f ull. Even if you overshoot the 
disc's capacity, iTunes is smart enough to burn what'll fit on the 
first disc and then prompt you for more blank discs until it 's burned 
the whole list. The downside here is that you'll lose individual 
playlists-but you can export your library (File > Export Library) as 
an XML file that you can later use to recreate your playlists . When 
you want to rebuild , simply select File > Import and navigate to the 
exported Library.XML file . 

If you don't feel right about stripping Apple's well
intentioned copy protection from your tunes-or you're 

sympathetic to the RIAA-you can back up your songs in 
the same format in which you bought them from the iTunes 
Music Store : Protected AAC. Thi s kind of backup is much less 
"enabling" than converting the tunes to the CD-standard AIFF 
open format. Open iTunes > Preferences, click t he Advanced 
tab, and se lect the bottom option, Data CD Or DVD. Now simply 
repeat step 3 to burn the songs to disc. Bonus: Backing up in 
Protected AAC format has the benefit of retaining your songs' 
album art- backing up in AIFF format strips the songs of their 
album art. Note that discs created this way will not work in your 
garden -variety CD player. Your backed-up songs will only work 
in iTunes on one of your five authorized Macs (or PC s) . 

~ .I&. 
Advanced Parental 

( General Importing Burning }-------.. 

CD Burner: • PIONEER DVD- RW DVR- 107D FD 
Preferred Speed: : Maximum Possible : J 

Disc Format : Audio CD 

Gap BHwee11 Songs: _4_s_ec_o_n_ds_......,..._·_, 

Use Sound Check 

A disc will hold way more songs in Protected AAC format 
than in CD-standard AIFF. 

Please in sert a bl an k disc. .. 

Search . Name Time Artist 

f!5 Journ ey to the Center oft ... 0 2:52 The Ramones 
1!1 Substitute 0 3:15 The Ramones 
~ Out of Time 2:41 The RJ.mones Acid E;i 

11! The Shape of Things to C.. . 1:46 The Ramones 0 Acid Ea 
t;l Somebody to Love 0 2:31 The Ramones 0 Add Ea 
fl! When I Was Young 0 3:16 The Ramones 0 Acid Eal 

7 and 7 Is 0 1:50 The Ramones 0 Acid Eal 

!!! My Back Pages 0 2:2 7 The Ramones C) Acid Eal 
Can't Se.em to Make You .. . 2:42 The RJ.mone.s Acid Eal., 

This is the part we'd automate if it weren't so illegal to do so. 

.£ fokt:r 
f ~ h.:r.mHup..i.nts 

Gt; p;.i.rtymhl! 

11-J P.myShulflt 
[,B Podmu 
[li PoUudde 

Lt_ Rlmonu_Acid Eattn 

:.L Rilnc1d 
Gt Sticky Fingi:u 

;. 
. , 

10 
11 

t2 
13 ,, 
1S 

16 
l7 

18 

• Naint TI mt AlllH 
8!! Somebody 10 love 0 1:31 Thtll..:tmcnu 
i!!!I When l\\'.:ts Young 0 3:16 Thl!R;amones 
~ 7.:tnd7 1s 0 l :SO The R.imonu 
~ Myhckr.i.gH 0 1:27 Thl!R.:tmonts 
I!! C11n't Seem to Make You .. 0 2:42 The R.:tmonu 
!!!I U.ive You E.vu Seen tht R ... 0 1:ZZ TheR.imonu 
~ I C.in't Control Myself 0 Z:SS The Ramonu 
~ SurfOty 0 2:26 The Ramones 
B Barr;acud;a(Rehur.s;a!Tap .o 4:26 Sonic You1h 
!!! Suru:nder 0 4:19 Chup Tnck 
!!I Godzlll.:t 0 4:18 Blut()yS1trCult 
f! The M:an Who Sold the Wo .o 4:04 David Bowle 

1165 M>ng~. 2.7 day1. 5.64 CB 

Music whores-er, aficionados-might want to use DVDs and/or 
mega long playlists to streamline the process. 

iTUNE-UPS 
BACKUP EFFICIENTLY Backing up in AI FF fo rmat creates 
discs that are more widely compatible, but it also uses about 
10 times the space per song. 

DEAUTHORIZE So what happens when you reach your 
limit of five Macs authorized to play your iTunes-purchased 
music? Simple : Clear your authorization s and start fresh with 
five new Macs. To do so, log into the iTunes Music Store, 
then click on your Account name and supply your password 
to get to the Apple Account Information screen, which 
contains the master-deauthorizer button. 

IMAGE ME THIS To skirt the bounds of legality a litt le more 
closely, use a disc-burning app such as NTl's Dragon Burn 
($40 download, www.ntius.com) to convert your tracks to 

an unprotected format without wasting a blank CD. In the 
burn window, se lect CD/DVD Image Writer from the Recorder 
pull -down menu . We'll leave the rest of the process for you to 
figure out-but don't worry; it's easy. 

LAST RESORT If you manage to completely lose the files for 
songs you've bought from the iTunes Music Store, there's 
still hope ... maybe. If you ask nicely, App le might rep lace 
songs you've purchased and lost-but there's no guarantee. 
The company addresses lost-music comp laints on a case -by
case basis, and even that might change before or after you 
lose your music files. 

,~Niko Coucouva nis doesn't have to remind you again that stea ling 
~music is bad, does he? 
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64 {J ~~~p~~k animation on your iPod 

Put a Flipbook Animation 
on Your iPod 
by Niko Coucouvanis 

If you have a photo-capable iPod and enjoy old-tyme flip book animation, 

here's how to merge the two while you save up for a new video iPod. 

WHAT YOU NEED 

Color-screen iPod or iPod nano ($199 to $399, www.apple.com) 

iTunes 5 or later (free, www.apple.com/itunes) 

Quicklime Pro 6 or later (optional, $29.95, www.apple.com) 

"' w 
'-' 
§ 

The craft offlipbook animation has a rich and storied 

history, so we'll leave the creativity up to you-but follow 
these general guidelines. Firstly, stick to an iPod-friendly format 
(JPEG, GIF, PNG, BMP, PSD, or TIFF) when making your images. 

Connect your iPod to your Mac and open iTunes; select ~ 

If you have an animation app such as Flash, Toon Boom Studio, 
or LiveStage, use it and export your animation as a series of 
images. As you create your animation frames, try to use the 

whole document window-it doesn't matter how big the window 
is; just fill the whole frame to keep your art visible when iTunes 

converts the images to iPod size. 
0 

, , ....... ,, 

Make sure to name the images so that v~;rr · • • • • · • .... ·• r-o .. 

the Finder will keep them sorted in 
order-01filename, 02filename, and so 
on, for example-then stash them in a 
folder named Flipbook. 

Fill up the frame if you want to see 

When you get iTunes' photo-syncing preferences 
set correctly, click OK to start the sync. Note that if 

you've synced photos from home and are doing this project 

on your Mac at work, syncing will wipe out any photos that 
you've previously synced from the other Mac. Also note 
that the next time you plug in your 'Pod at work, the photos 
will sync automatically according to the Preferences; avoid 
this by unchecking the Synchronize check box. Now for the 
payoff: Unmount and disconnect your iPod from your Mac, 
and navigate to the iPod's Photo directory. Select the Flip book 
folder or album, and open the first image. Once it loads, you 

ITunes 

1lmlilflQ pho10J for ·cto11ghpocr ... 
Optlmlzlno21of62 

Name 
~ To1.iltyNa1ur;i.I 

$ Cl'1ilr 0 t l unt 
@ f 1oodOIRtd 

0 
0 
0 

can scroll 
through the 
images by 
turning the 
clickwheel. 
How's that 
for retro? iTunes shrinks the files down so you don't have to. 
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iTunes >Preferences, click the iPod icon, and then click the ~ :;; 
Photos tab. If you haven't set up photo syncing, don't fret-the 
actua l syncing won't start until you press OK in the Preferences 

window. If you're already set up to sync selected iPhoto albums, 
you'll have to create a new album in iPhoto, import your flip book 
frames (use C.ommand-0 or File> Add To Library), and then select 

that album in iTunes' photo-sync preferences. If you're already set 
up to sync your entire iPhoto library, put your Flip book folder in 

your /Users/user name/ 
Pictures folder, and set 
iTunes to sync with your 
Pictures folder. 

Sync options are limited, but 
adequate-and automatic, 
so disable syncing before 
you disconnect the iPod. 

doughpod 

MAKE YOUR MOVIES MOBILE 
Just like modern cinematics evolved out of the humble 
flipbook animation, you can use a similar procedure to put 

video clips on your 'Pod. The secret is to convert the video 
file into a series of still-image files using QuickTime Pro 
($29.95, www.apple.com). Open a video file in QuickTime, 

and select File > Export. In the resulting dialog, select Movie 
To Image Sequence from the Export pull-down menu, then 
click the Options button . Select a suitable format from the 
pull-down menu, and enter 
a frame rate-JPEG at 15 
frames per second works 
well. Save the sequences to 
a dedicated folder on your 
hard drive, then follow steps 
2 and 3 to upload the frames 
to your iPod. 

Formn: ~ --m 
Frames per second: @j fil 

Insert space befort number 

Quicklime plus iTunes equals 
movies to go-more or less. 

~ 
i;; 
z 
0 

I 



HOWTO ~ 65 

Blow Stuff Up in Photoshop 
by Niko Coucouvanis 

WHAT YOU NEED 

Photoshop Elements 3.0 
($89.99 retail, $79.99 
download; www.adobe 
.com) or Photoshop CS2 
($599) 

H 
alfthe draw of a high-megapixe t 
digital camera is the prospect of 

overframing your shot in the field, 

then cropping and enlarging the good 

Digital photos 

part tater on your Mac. The problem is that 
digitally enlarging photos can be tricky-but 

we've got the secret. If you're scanning your 

image (as opposed to using one taken with your 
digicam), scan it at a high resolution-around 
1,000 dpi (today's scanners capture up to 

9,600 dpi, which is excessive for most uses). 
We enlarged the photo on the left using two 

methods: The top-right close-up shows the result 

when we did it the quick way; the bottom-right 

close-up shows the result when we did it the 

proper way-notice the subtly sharper edges. 

If you're snapping digitally from the get-go, set 

the camera to its highest resolution and best 
quality, and shoot in TIFF or RAW, if possible. 

If you plan on applying any sharpening or filter effects, 
do so after en larging-for now, stick to auto-adjusting 

levels, color, and maybe brightness and contrast. In Elements, 
select Enhance > Auto Levels (in Photoshop, it's Image> 
Adjustments> Auto Levels); ifthe result seems excessive, use 

Photoshop's Edit > Fade command to adjust the Opacity to 

about 75 percent, then use the same procedure for Auto Color. 

Elements has no Fade command, so ifthe automatic corrections 
do too much, undo them and 

instead put each correction on 
its own layer. Select Layer > New 

Adjustment Layer> Levels, then 
use the Layer palette's Opacity 

slider to lessen the correction . 

Photoshop Elements' Layers palette 

Running that 10-percent-enlargement plan takes all of 
five clicks, but if you use Photoshop proper (version 6 

or later), you can cut that click count down to one by making 

an Action . Just open the Actions palette (Option-F9) and click 
the Create New Action icon; in the resulting dialog box, supply 

a name and hot key, then press Record. Now perform your 

New Action 

Lewis 

10-percent
enlargement as 
in the previous 

step. When 
you're done, 
click Stop on the 
Actions palette, 
and your new 

Action wil l 

Name: I 110% I ( Reconl ) 

appear in your 
default Actions . 

Set: f,...D_e_fa-ul-t A- c-tio_n_s ----..,.!~:j ( Cancel 

Function Key:~ ::'.Shift '.::Command 

Color: ( 0None i:J 

Photos hop f.1 1 ~ "' ""'~' """"""''" 
Actions can 

automate 

anything. 

,~ Niko Coucouvanis knows better than to crack wise about blowing 
'!!...1 up the president-of Venezuela. 

) 

The key to enlarging is to do it in short steps; enlarging 
your image 10 times by a factor of 10 percent gives 

cleaner results than enlarging 100 percent in one pass. Select 
Image> Resize> Image Size in Elements (Image> Image Size 
in Photoshop), check alt three boxes at the bottom of the 

window, and select Bicubic from the Resampte Image menu . In 
the Document Size section, change the Width pull-down from 

Inches to Percent-the 

Height menu wilt 
automatically change 
to match. Enter 110 in 
the Width field, and the 
Height updates itself to 

match. Click OK. 

As they say, slow and 

Height: I 13256 I( pixels 

Elements has no Actions palette, but you can improvise. 
Open some images that you want to enlarge and 

select File > Process Multiple Files. In the resulting window, 
select Opened Files from the top pull-down menu, choose 

a destination, uncheck alt of the items under Quick Fix, and 
proceed to the Image Size section. Check Resize Images, select 
Percent from the Width pull-down menu, and enter 110- with 
Constrain Proportions checked, Elements will calculate the 
Height for you . It's 

not as smooth as 
using an Action, but 
then again, Elements 
doesn't cost you an 
arm and a leg. 

Elements' batch 

skills are strong. 

Flle Namlr>g------------, 

0 Rename Flies 

~+I D ' ' """- [! 
Ex.lmplc: Nl macroOOl.glf Starting serlalf• ri--J 
Compa11bllity CJ Windows ~Mac OS _,Unix 

~ Resize Images 

~
lmageSize 

Width: fi1if] ( p<!rcent ! I JI Resolu1ion: 200 ~ dpl 

Height: n f lnche_s ,: j 
Sconstr~ln Proportions 
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===~-"'"-==! Run more Applications Faster 
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Get more done faster with Memory Intensive 
Applications like Photoshop. OWC has over 17 Years 
Experience with adding Memory to Apple Computers. 
Speak to one our knowledgeable team members at 
800-275-4576 or visit www.macsales.com/memory 
- and you'll get the right memory for your Mac! The 
Right Memory from OWC Makes the Difference! 

External FireWire/USB2 Options 
Any Mac with available Fire Wire or USB 
OWC Mercury Pro 16X DVD SuperDrive External 
FireWire/ USB Solution $139.99. Includes Dantz 
Retrospect, Dragon burn, 5 pieces of DVD-R 
media and 25 Pack CD-R media. 

media, cases & label 
kits in stock too! 



Hard Disk Controller Cards 
mtill 
Serial ATA 4-Channel PCl-M $79.95 
l®NN®r 
Tempo ATA & SATA Mac PCI Contro lle rs 
Tempo Trio FireWire/ USB2/ATA-133 
all in one PCI $149.00 

FirmTek 
4-Channel SATA Controll ers 
from $119.95 

SATA External Enclosures 
owe 
*NEW* OWC Mercury Eli te-AL SATA 
DUAL BAY $99.95 

FirmTek 
Dual-Bay Hot Swap Externa l Serial ATA 
Enclosure with SATA PCI Contro ll er Card $257.95 

l®NN®r 
Sonnet Fusion 4-Bay SATA Kit $549.00 

Internal Hard Drives 
Bulk up your computer by giving it higher 
capacity to perform for your needs. 
For iMacs, eMacs & PowerMacs 

\ 
3.5" Plug I L. z? . .t:'!/. . 

"- & Play 80GB -~/ __, 
- to 500GB • 1. 

_ trom $59 ~ ,, , 
For PowerBooks, iBooks & Mac mini 

\ ' 2.5" 40GB 
'- to 120GB 
- from $69 ,, , 

ADD FIREWIRE & USB 
to your Mac! 
FireWire from $9.95 
FireWire+USB Combos from $29.99 

PRO SOFT 
Drive Genius () 
Retail~6S·0 
Maintains, M~ages, 
Optimizes, Repairs. 
Keep your Hard Drives 
at their best. Recover 
data if disaster strikes! 

~,,Drive [S TI 
LIP>Gernus 

\ 
'- 3SSPecia/ OWc' -

%OffrN .... 
- 0 . ow -
-:-..:.'YftfS6s.o0 

.

, .,., 
~ 
~ ~ 

~ ...... 



Laptop Accessories 
n ) neUJer 
NuPoJNer Batteries 
PowerBook G4 Titanium 15" 

4800mAh NuPower $149.95 
For all 400-lGHz Models, up to 42% 

MORE Capacity v s. Origina l Batte ry ! «<' 
Nu Power batteries wi th up to 50% more ~ 
Capacity also ava ilab le from 
$119.99 for PowerBook G4 
Aluminum 12/15/17" Models, 
PowerBook G3 Wallstreet / 
Lombard / Pismo, All iBook G3 
and iBook G4 Models. 

Make your Mac mini even better! 

Upgrade to l GB 
on ly $99.00 
More Memory= Much Foster! 

More Storage thot's up to 43.8% Foster! 

miniStock' 
From $99.95 

Burn DVDs & CDs for onl y $149.95 
BX DVD Burner is twice as fast as Apple's current 5 
uperDrive option+ supports Dual layer DVD Burning! 

Exclusive OWC Online Video shows how to insta ll these Mac 
· mini upgrades or for $99 incl ud ing overnight pickup and 
return delivery, OWC will do the Mac mi ni upg rades for you! 

Call or Visit macsales.com/macmini 

say about th e RoadTrip!+ 
"The RoadTrip!+ FM 
Modulator worked 

flawless ly ... and I was ve ry ' 
impressed w ith 

the sound quality." 

Protect your screen! There's an OWC Laptop 

Screen Protector (LSP) product for your Mac. 

PowerBook G4 17" $17.99 
PowerBook G4 15" $17.95 
PowerBook G3 15" $14.99 
iBook/PowerBook G4 12" $13.95 

Stops 
marks! 

The OWC LSPs are precision cut, glove soft leather - ~ 
protectors that prevent potentially permanent marks 
which can occur from the trackpad and keyboard wh ile 
your laptop is closed. 

High-Speed Nationwide Dia l-up and DSL Services 
Toll-Free Tech Support & More from Mac Experts 

Visit FasterMac.net o r call toll free 
800-869-9152 to learn more o r to sign up. 

ilugger iMac cases 
fo r the iMac GS or for 
Mac mini and/or up 
to 20" LCD Display 
5 co lor combinations 

start ing at $99.95 

Rain Design i360' 
A Turntable for 
your iMac GS 17" 
and 20" $39.00 

-
Eye candies for 
your iMac.Six 

to choose from. 

Network Adapters 
D-LinK 
D-Link 10/100 
Et hernet PCI Card $9.99 

Logitech Cordless 'Click' Opt ica l Mouse 
for USB SPECIAL $25.99 Logitech 

O'Reilly Books r lt The latest Mac titles 
from $9.95 Over 30 Mac 

Titles In Stock! - -

Apple OS X 

~ 
Apple 05 X 'Tiger' $99.00 
full re tail box version 
OS X 10.2, 10.3 from $17.99 

~ 
f 1 nal ls t 
ma c wor l d 
II d d y I 
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ATI MacEdition Performance Video Cards For all PowerMac G4 Models: 

When your Mac is Fast, Don't let a SLOW video card hold you back! 
PCI Video Upgrade for Performance or 
Additional Displays: 
ATI Radeon 9200 w/128MB for any 
Mac with an Available PCI Slot 
$127.9S 
Up to 204Bx1S36 resolution. 
Compatible with up to 24" Displays! 

High-Performance AGP Video Card Upgrades 
*All of the following support up to two displays* 
ATI Radeon xBOO MacEdition 
with 256MB $395.00 
TOP OF THE LINE GS VIDEO Card 
supports up to Apple's 30" Display! 
For PowerMac GS Only. 

ATI Radeon 9600 $199.99 
2S6MB of high-speed video memory 
4xorBxAGP 
Dual DVI 
TV Out 
Built-in VersaVision™ for portrait disp lays 
Aupports up to 30" Displays - inc luding 
Apple's Cinema 30"! 
For PowerMac G4 Digital Audio, Quicksi lver; 
All PowerMac GS Models. 

NEW! ATI Technologies RADEON 
9800 PRO MAC EDITION $259.00 

NEWr I, 
, ATI Radeon 
_ 9800only 

Ultra High Performance Dual Head Video 
Card WI DVI, VGA and 5-Video Ports, 2S6MB. 
New, for PowerMac G4s. 

- $259.99 ,,,,,. 

\ 
30 Day I 

Money-Back 
on NewerTech, 

Powerlogix, and OWC 
brand upgrades! 



iSkin Duo 
combine for 360° protection 
for your iPod nano or shuffle. 
Includes Ultra-Clear Screen Protector, 
Wheel Cap click wheel protector, and a 
removable rotary belt clip. 

iSkiti 

SportSuit Convertible 
Protection, flexibi lity, and a 
secret pocket for head
phones, the Convert ible 
also has options that allow 
car, bike, and belt mounting. 

naviProex 
Cut loose with wireless 
remote control for iPod. 
Enjoy navigating through 
your favorite playlists, 
albums or audiobooks. 

smartCharge 
all-in-one car charger 
specifically designed 
for the iPod shuffle. 
Includes built-in 3.5 mm (1/8") stereo audio jack. 

~ 
~ 

ll'1lp 

IQ 

iTripLCD 
Sports a large, backlit LCD 
screen, a handy side knob 
makes it a breeze to select 
broadcast frequency, 
selectable LX or DX modes. 

(GRIFFIN) 

Boostaroo Revolution 
Awesome portable audio 
amplifier & splitter gives you 
high-definition 3-D 
surround sound imaging. 

II. II 
u .ybea+ audio" 

expand your sou nd 

l 

Lili pod 
A watertight, floatable, 
hardshell case that fits snugly 
around your iPod and keeps it 
safe, no matter what activity 
you partake in. 

Lili Pod 
. ' " ·~~~ 

Dr. ~<" ott ! ~ Where Santa shops for all his Mac & iPod needs. 
~ .c , Find a reseller online at http://www.drbott.coryi/local ·phone: 800.541.1230 

' ~1.,~ ,' . , , 



PowerBooks & iBooks 
TechRestore.com 1-866-96-RESTORE 

iBooks: 
63/700, 256MB, 20gb, Combo Drive, 12" $499 
63/600, 256MB, 20gb, Combo Drive, 14" $549 
63/700, 256MB, 30gb, Combo Drive, 14" $549 
63/800, 256MB, 30gb, Combo Drive, 12" $549 
63/800, 256MB, 30gb, Combo Drive, 14" $579 
63/900, 256MB, 40gb, Combo Drive, 12" $599 

All PowerBooks & iBooks Come 
With A 6-Month Warranty! 

Mac Repairs & Parts 
OVERNIGHT- NATIONWIDE: 1-877-34-REPAIR 

Overnight Power Supply Repairs 
For 63, 64, 65 & iMac: Only $129 
Includes Overnight Shipping! 

Overnight Logic Board Repairs 
Starting At $149 

Mac Parts: 

Cases, 
Video Cards, 
Cables, 
Drives, 
and much more! 

iPod Repairs & Upgrades 
OVERNIGHT- WORLDWIDE: 1-877-For-iPod 

i~od _Battery Freedom .. _ 1=::-~ 
l:.1fet1me Battery _ • §: i 

Replacement ..,,...- @.·- -~ 
OnlY, $99! . \;:ti 
Extended Capacity Self-Install iPod Battery 

Upgrade Kits - Starting At $19! 

iPod Upgrades: 
1st Gen. 5gb to 20gb $1 j!J9 
2nd Gen. 1 Ogb to 20gb $129 
3rd Gen. 15gb to 40gb $189 
4th Gen. 20gb to 60gB $219 
Includes Round-Trip Overnight Shipping 

Visit Us Online, Check Our Daily Blog Specials And 
Sign Up For Our e·Mail Newsletter To Save Up To $50 Off! 



The Mac Experts! 
Located in Oregon, the land of forests, 
friendly people and no sales tax 

Great Gifts for the Holidays! iPod 1 
Make that special some- · 12-inch iBook G4!1.33GHz n a n 0 • 
one's Christmas extra 512140/combo/AP/BT ... .. . $994 
special with a gift from 
this great line-up of 
products from PowerMax. 

Get a Gift for the Whole Family! 

256/160/Super.drive . 

Apple iPod carrying case w/ belt clip .......... $39.98 
i5kin eVo2 iPod skin . . . . . . . . . .............. . . $24.88 
Apple iPod Shuffle reconditioned . ... . ..... .. $78.99 
pr. Badelin's Wireless iPod Auto Adapter Kit .. . $79.99 

Apple's latest MP3 player is 
thinner and more powerful 
than ever. Pencil-thin and 
feather-light, the iPod nano 
comes with Apple's patented 
click-whee/. Available in your 
choice of 2GB (500 songs) and 

1 4GB (7 ,000 song) capacities. 
Make's a great gift! 

2GB iPod nano black or white 
. .... . . .. . ... ..... . $194.88 

4GB iPod nano black or white 

.. .............. . .. $244.88 

Look What 
PowerMax 
Customers 

Are Saying! 

P~werMax Certified Super Holiday Mac Specials! 
Pre-Owned Macs We've attained an exclusive allocation of Apple Certified 

PowerMax is the web's 
~. largest Certified Pre-

Refurbished computers at fantastic, low prices. Order today 
and avoid the holiday rush! 

Does Your Computer 
Break Your Heart? 

~ Owned Mac dealer. We 
have a massive selection 

of quality, pre·owned PowerBooks, 
iBooks, iMacs and PowerMacs. Choose 
from over 1200 configurations. All 
Certified Pre-Owned 
macs are thoroughly 
cleaned, inspected, 
bench-tested and come 
with a 90-day warranty. 

Dr. Bodelin's Optical Mouse 

only $14.99 
Fast, accurate 
optical tech

nology. 
Choose from 
three styles! 

Trade-In Your Mac! 
Thinking of upgrading to a new Mac? 
You can trade in your old M · · 
for credit toward a brand 
new one. Call us today or gc 
online to find out how 
easy it is to recycle your 
old machine! 

Mac mini G4/ l.25GHz 256MB RAM/40GB HD/Combo . . $409 
Mac mini G4/1.42GHz 256MB RAM!BOGB HD/Combo .. $479 
20" iMac GS/1.BGHz 256MB RAM/ 160GB HD/SuperDr. . • $1388 

Come check out the PowerMax 

MatchMaker! 
eMac G4/ 1.42GHz 2S6MB RAMIBOGB HD/Combo .. . ... $729 
eMac G4/ l.25GHz 256MB RAM!BOGB HD/SuperDr. . . •.. $749 
12" iBook G4/ 1.2GHz 256MB RAM/30GB HD/CD-ROM . . $788 
15" PwrBook G4/ 1.5GHz 512MB RAM!BOGB HD/Combo . $1699 

15" PwrBook G4/1.67GHz 512MB RAM!BOGB HO/Super . $1899 
GS Pwr Mac GS/ 1.BGHz 256MB RAMIBOGB HD/Super .. $1299 

If you and your computer have lost that lovin' feeling, it might 
be time to look into a new Mac. In order to ease the transition, 
PowerMax created MatchMaker. All you need to do is answer 
a few questions and MatchMaker will provide an increasingly 
refined selection of Macs for you to choose from. With Match
Maker, you'll never get stuck with the wrong computer again! 

D 8 d f /. Getthemostoutof 
Dr. Bodelin's..' Just \n,\ f, O e In~ your iPod with these 

Lapto~- iPod Accessones cool accessories! 
Bumpers Wireless iPod/iPod Mini Auto Adapter Kit 

· t $19 99, Listen to the iPod over your car stereo via digital FM trans-
JUS • • mirter. Adjustable mounting arm and aux. output! $79.99 

A must-have for . . . 
Wireless 1Pod Shuffle Auto Adapter Kit 

every laptop. 7 Same functionality as above. 
colors available! but for the iPod shuffle! .. . •••.. ... . . •. . • . . . $29.99 

Apple Refurbished 
Cinema Displays! 

.,. ........ - ,.___;;,(/f!lff' 

_· --· .. ___ J 
23"0is;i;' .. . .. :$1299 
30" Display ....... . $2588 

iPod Shuffle Portable Audio System 
Your shuffle becomes a boombox with these compact 
speakers. iPod Boom Box also available! ..••••• $38.99 

Silicon iPod Shuffle Skins 
These protective skins come in a variety of colors. $8.99 

Retractable Sync Cable for 30-pin iPod ..... $13.99 

Retractable Sync Cable for USB iPod . .. .. .. $13.99 

Car Charger Adapter for 30-pin iPod ....... $13.99 

Car Charger Adapter for USB iPod .. . ... . . . $13.99 

Local: (503) 624-1827 ·Fax: (503) 627-1635 

Email: sales@powermax.com 

1tBI• 
LaCie is breaking the 
limits of hard drive 
capacity with their new 
Big Disk Extreme! 

40GB Mobile FW/USB .... ............... . ...... $119 
BOGB FW F.A. Porsche Design . ....... .... . ...... $119 
160GB FW F.A. Porsche Design . . . . . .... .. ... . . $139 
160GB d2 Extreme with Triple Interface . .. ...... $179 
250GB d2 Extreme with Triple Interface .. .. . .. .. $219 
500GB d2 Extreme with Triple Interface ... . . . .. $399 
I.OTB d2 Extreme with Triple Interface . ........ $799 
DVD+! · RW 16x DL FW Light Scribe 

with Toast 7 nranium . . . . . . . . . . . . . . . .. . . . . . $189 

Personal Financing 

Fast P.O. Approvals 

• Business Leasing 

ti Authorized Reseller ti Authorized 
Reseller 

, 
Apple Specialist 

• Daily Specials on 
our Web Site 

Prices subject to change without notice. Credit card orders strictly verified against fraudulent use. With use of credit card as payment, customer acknowledges that some products are subject to final sale. Many prices are 
limited to stock on hand. All brand names are registered trademarks of their respective holders. Not responsible for typographical errors. "after mall·in rebate(s) t excludes mac mini t tsome restrictions apply 



MAC SHOP 

Software Savings for Students, Teachers, and Schools! 

I Adobe® Ou ark® Macromedia® Alias® 
i Creative Suite 2 QuarkXpress 6.5 Studio B Maya 7 Unlimited i Save! 67% Save! $756 Save! $710 Save! 85% 5 
1 Order Today! Only! $189.95 Only! $289.95 Only! $389.95 

~ 
Get the Best for less! The Industry-Standard! Brand New Version! Brand New Version! 

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices are 
ONLY for the academic community. And our prices are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving! 

Adobe"' Macromedia"' 
Acrobat Pro 7 ..... ....... Save 69% Dreamweaver 8 .. ... ............. $189 
Photoshop CS 2 ......... Save 53% Flash Professional 8 ..... ... ... $239 
Video Collection .. ... ... Save 55% Contribute 3 ............ ...... ....... $89 

Alias" 
Maya 7 Complete Student..$289 
Sketch Book Pro 2 Student .... $89 

Corel" 
Painter IX ...... .... ...... .. ... ........ . $89 

Microsoft"' 
Office 2004 Student!Teacher .. $139 

Wacom" 
Graphire3 6x8 Tablet.. .......... $169 
lntuos3 6x8 Tablet .... ..... .. ..... $279 

Auto/Air Power Adapters 
for all 

Titanium G4S & iBook models 
Replacement Mini 

AC Adapters 
for all 

Titanium G4s & iBook models 
(65 Watts max.) 

Mini AC adapters feature: 
• 100 - 240 auto switching inimt 
• 1'0ld atuay outlet prongs 
• Convinient cable wrap 

with Vctcron. srrap 
• 4.1x1.6x1. i " 

LU on Auxiliary Power Packs 
For all Ti G4S & iBooks 

Extend your laptop runtime 
3 to 4 times longer 

Lightwieght 
2.4(MP6o)lbs - 3.4(MP9o)lbs 

Size - u.25 x 8.5 x .5" 

Lind adaptersfcature: 

. !~'i~1!'1~:~!~~:,~~itry 
• Durable ABS housing 
•Nylon carrying case 

1\Iu.tl'otut:r 60(95w.H) 
lit .Ma,>.·l'owcr 9004ow.H) 

Order online at: 
www .lindelectronics.com 

or call #800-897-8994 to order 
Jud Ucclnini.c", IUC'. 6414 CmlhddR.e Street, ~'1in1tcKpt>lh1, MN !)..;..t.;lb IJ5:.t-Q:t, ... ·O:JO:-J 

We carry many of the products 
reviewed in this magazine! Hey Parents! 
Griffin TuneCaps (set of 3) .... ...... ....... $9 "You are eligible 
Norton AntiVirus 10 ... .... ....... ........... $49 to buy for your 

students at home 
or away at school." 

Roxio The Boom Box .. ... .. ...... .. .. .... ... $39 
Canon Pixma iP90 .... ..... .... ... ......... $225 
Epson Stylus Photo RX620 ..... .... .. .. $279 

ALL MEMORY ON SALE!!! 
65 1 gb/2eb Kil ~ 
Mac Mini 1 eb ..,. 
iMac 65 1 eb /512mb 
iMac 63/64 256/512mb/leb 
PwrBook/iBook 512mb/1 eb 

· 64 Tower 256mb/512mb/ 

All Models only $99 

-

Available for: - ~=~~~~~~= 
i8ook Clamshell models 

~resh Juice! i8ook w· White/Snow 

Prices subject to change at any time. 

New Pioneer SuperDrives iBook &. Powerlook 
A106 4x DVD·R $ 39 SupeitJrives 
A110 16x DVD·R 59 available now 

Notebook Drives - Internal Serial ATA 
Capacity RPM 
BDgb 5400rpm $ 99 
1DOgb 5400rpm 159 
120gb 5400rpm 249 

( Moc Shop 

Capacity Cache 
25Dgb Bmb $ 109 
4D0gb Bmb 225 
5DDgb Bmb Call! 



Wanna Keep Your Personal Information 
and Projects TOP SECRET? 

Use ... 

TopXNotes 
ADVANCED NOTEPAD FOR OS x 

A modern notepad for Mac OSX loaded with handy features! 

MULTIPLE FONTS, PREDEFINED 
SIZES, AND COLORS AND CUSTOMIZABLE 

FULL DRAG & DROP 
NOTE TEMPLATES 

AUTOMATIC 
"Ou1cKNOTES" 

LINK RECOGNITION 
FOR lJUICK ACCESS 

TO YOUR NOTES 

TABLE OF CONTENTS 

WITH CATEGORIES 

AND GROUPS 

ENCRYPTION 

KEEPS SENSITIVE 
DATA SAFE 

MULTIPLE, 
••• AND MUCH, 

INDEPENDENT 
NOTE VIEWS 

MUCH, MUCH MORE 

i-~ ~;~ f 
l!l•-- ••- n 1.- · ·--- . a- ·-3- ·- -~-

u 

t!I H•-• -~-.. ·- ··~ r-·- Q "( " 

Trop ical 
Software 

TopXNotes 
~JMJ___jf~ 

fl il'--· ~ - " l"I 
~•LWIIB 

VISIT HERE TO DOWNLOAD AND TRY ToPXNoTES 

~ Tr0Pwl~?oL~~£~~fo~ 
~ersiontracker 

_...... S.0 1.allno 

This year, give the 
gift of Speech 

ilisten MX 

Your iMac's other half. 
"iGo is a desk designed w ith the iMac 
in mind, and the t wo together 
are quite a sight:' 

* * * * Macwarld UK 

l 

1.800.797.7321 

Let's interact! 

NEW. i360° swivel base provides 
an elegant and dynamic way 
to tu rn your iMac GS and 
Cinema Display (1 7': 20" and 23") 

www.rai ndesigninc.com rain design • 



Special Buy Memory Sale! 
65 lgb $109 
65 512mb 49 
PowerBook 64 1 gb Samsung 152 
PowerBook 64 :i12mb Samsung 63 IDE, Serial 

G-RAID and Laptop 
$ 349 Hard Drives 

' 
499 IN STOCK ' 929 

1,099 Best Prices! 

We've got your back. 
Thousands of parts and accessories for your Powerbook 

> avoid costly service 
> do-it-yourself Powerbook & iBook parts 
> free online Fixlt Guides 
> thousands of parts and upgrades 
> 6-month warranty on most products 



iMac G5 

256mb-$39 
512mb- $69 
1Gig - $149 

PowerMac G5 
512mb - $69 
1Gig - $135 
2Gig - $259 

eMac DOR 

• 

256mb-$39 
512mb - $69 

:> l 1Gig - $135 

High-Performance 
Mac Memory 

iBook G4 

256mb - $45 
512mb - $75 
1Gig - $179 

PowerBook G4 

512mb - $75 
1Gig - $179 
2Gig - $349 

G4DDR 

512mb - $69 
1Gig - $135 
1.5Gig - $199 

Secure Online Ordering: Speak to o Moc Expert: 

WWW.RAMJET.COM 1-800-831-4569 
Ramjet, Inc. has served the Macintosh community since 1996. 
Offering top quality components and genuine Mac expertise, 
Ramjet is frequently cited as the top Macintosh memory company. 
Being geared toward the professional user, Ramjet performs 
stringent compatibility and performance bum-In tests to assure 
maximum reliability. This quality control, coupled with an easy 
and generous warranty, makes Ramjet the smart choice. 

Professional Fast De endable 

FAMILY HISTORY - GENEALOGY 

REUNION®8 
Re uni o n 8 is t h e pe rf e ct t ool to 
orga nize your fa mily his tory. Plenty of 
room for names, dates, places, stories, 
notes, tidbits, and 
so urces. Include 
all yo ur favo ri te 
p ictures, sounds, 
and home movies. 
Auto m at ica ll y 
build multimed ia 
web pag e s to 
sha re your family 
hi s t o ry o n th e 
In te rn et! Print la rge, co lo rful tree 
charts, timeline charts, and fan charts 

for fa mily reuni o ns. Fun 
a nd edu cational fo r the 
w ho le fa mily. Reunion 8 
takes advantage of O S X 
and incl udes ove r x 

II 
1 00 new featu res 

liill@'' .r: .i;tj and enhancements! 

" o e . ,,_, .. .... ,....,.. •• 

~~·~.:' .!.ii. _.!. §.-~~-
...... !'!'1• •~··~-'t.·~--·"""""" ' --·-

i I~;~~-·~ ----
Leister Productions 

web site/demo: www.Le ist erPr o .com 
e-mail: info@LeisterPro.com 
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MacPrices.com 
Nothing But (Mac) Prices 

Find the lowest price! 
Get the best free bundles! 

www.macprices .com 

wo::>·sapeJi11e1o::>ew·MMM 

sJe1111 pasn 6u111as pue 
6U!An9 JOJ UO!ln1os JnoA 

sapeJJ. nv :JO :>ew 

The Keyspan 4-Port Print Server is an ideal print 
sh~ring sol~tion for creative profe55ionals! 

High Capacity: Connect as many as 4 USB printers to your 
wired or wireless network. 

Bi·Directional: Transmits print jobs to attached printers. 
Reports ink/paper status back to the MadPC. 

Versatile: For use with inkjet printers, laser printers, 
photo printers, label printers and plotters. 

High Performance: Supports simultaneous use of attached printers. 

.,, rvr DAN Connect/Ql15 for your Computer 
na; I~.-,. www.keyspan.com 

Great Gift Ideas ._7/' / 
& S • IS • ~ 1 5%~ pec1a av1ngs ~o/:/:t_\.-

from RadTech Order o;:;r~v'\.. ..... 
Sleevz·· for iPod and save 15%. 

Use Promotion Code: 

Back acks • Cases 

BlueTooth Gear 

w ww.radtech.us/ma 



Special web site hosting offer 
for MacAddict Readers! 

www.lnno-Tech.com/MacAddict 

Exclusive hosting provider for 

Mac.,..LO ...... ~ lnnoTech 

7 great reasons to choose DriveSavers: 
• Fast, advanced, proprietary techniques. 
• All operating systems; Mac, Windows, OS/2, 

Netware and UNIX. 
• AU storage devices including SAN, RAID and 

NAS systems. 
• Instantly retrieve recovered data 

with DataExpress'". 
• Recommended and certified by all 

hard drive manufacturers. 
• Government Contracts 

''We Can Save It!" • Featured on MacAddict,MacWorld, Smee 1985 
CNN, BBC and others. 

Visit DriveSavers at www.drivesavers.com 
©2003 DRIVESAVERS, INC 400 BEL MARIN KEYS BLVD .. NOVATO, CA 94949 INTl 415-382-2000 

Mactallic· 
mactallic.com 

... some call them Hoods! 
(800) 818-3946 

www.HoodmanUSA.com 

Powerful. Swift. Reliable. 
The Ml Ni's Sweet Too ... 

Sign Up For a FatCow Hosting Plan Sept. 15th Through December 5'" 2005 and You Could 
Win a MINI Cooper® or a Mac mini® or an iPod mini® 

The FatCow"' 
• 1 Gig of disk space -~f ~- ~-~~~~~ 
. 30 Gigs of monthly transfer 

100 e-mail boxes 
WebMail 

Spam & virus filtering 

· ShopSite Shopping Cart 

• SiteDelux Site Editor 

Mac Shop 



LETTERS 
TINGED WITH SEPIA 
As a charter subscriber now 
in my fifties, I have long 
accepted the fact that your 
magazine's humor is geared 

toward a younger generation. 
Thanks for surprising me with 
the nostalgic Charles Macias 
ad in the October issue (Shut 
Down, p80). It was so true to 

the original 1950s comic
book ad that I went back and 

read it twice with my Amazing 
X-Ray Specs.-C. D. Tavares 

I> Now Pia ing ;;;;;; 

9of12 NAN OGAMI The Journey 
FatboySlim 
Palookaville 

3:37 -0:59 

I made this iPod nano 

origami because, well, I 
can't afford a real one yet. 

Download the PDF from 

http://homepage.mac 
.com/pockyrevolution/ 
ipod_nano_origami.html, 

then just cut and fold! 

-Roland Saekow 

A BREAKDOWN IN 
COMMUNICATION 
I had just read Niko 
Coucouvanis's convoluted 
method to "Power Your iPod 

with a 9V Battery" (Oct/05, 
p62) for about $11 and 

alotofheartache,when 
something ... tingled ... my ... 

memory. Oh yeah! Roman 
had just reviewed, in that 
very same issue (p49) , the 
TuneJuice, which does the 

same thing in a much slicker 
(and, considering my wiring 
skills, safer) package. No 
offense, guys, but I think 

I'll shell out the extra eight 

bucks for the TuneJuice. 
-Steve Wust 
The appearance of both 
articles in the same issue 
was no mere coincidence
some folks like a thing 

done for 'em; others get 
a major kick out of doin' 
it themselves. We aim to 
please all ofyou.-Max 

FONT FOIBLE 
Your " Frazzled by Fonts" 
article (Oct/05, p24) 
contained a slight typo. 
The URL for "Mac OS X: 

Zero songs in your 
pocket!-Max 

Font Locations and Their 
Purposes" should be http:// 

docs.info.apple.com/ article 
.html?artnum=106417, 

not http://docs.infor.apple 
.com/ article.html?artn um= 
106417. Your readers should 

know that the link works, and 
the information is good. 
-Tim Spaulding 

Whoops, sorry about that

you are correct. See, even 
after writing that article, 
we're still having font 

problems.-Max 

PANORAMA-RAMA 
I enjoyed "Make Better 
Panoramas with PTMac" 

(Oct/05, p59), especially 
since I spent a day or two 

Survey 
Says 

DO YOU PLAN ON BUYING APPLE'S NEW MIGHTY MOUSE? last week looking for a good 

panorama stitcher. Along with 
PTMac, I also found the free, 
open-source Hugin (http:// 

sou rcefo rge. net/project/ 
showfiles.php?group_ 
id=77506) helpful because Here are th e results 

of our August 2005 
survey. Check out 
www.macaddict.com 
each month for a 
new on line poll. 

18% Nope, I've 
been using a scroll
wheel mouse for 
years and I don't 
want to switch. 

37% Maybe, 
but I need to 
test-drive it at an 
Apple Store first. 

78 MacAddict December 2005 

4% Nope, all those buttons 
and stuff confuse me. 

535 respond ents 

4% Nope, the 
side-squeeze 
buttons look 
too small for my 
normal-adult-size 
hands. 

37% The Steve has 
spoken; I will buy. 

it supports one thing that 
PTMac doesn't: Autopano
SIFT, an add-on that finds 
control points in your images 
for you. Download the Mono 
version from http://user 
.cs.tu-berlin.de/-nowozin/ 
autopano-sift.-Andrew Seidl 



TIGER ISLAND 
Our project in school was 
to create an " imaginary 

island," so I used Photoshop 
to create Tiger Island, with 

Spotlight City ("the only 

place in the world where 

it never gets dark") , iPod 
mountain, and the FireWire
th e only river in the world 

that is always 180 degrees 
Fahrenheit and run s at over 

900 mph, which is how fast 
FireWire seems to be. Check 

out the fin ished version! 
-Jakey Simonds-Malamud 

Be sure to visit picturesque 
Automator Canyon, but 
avoid the Deserted Windows 
Desert-nasty bugs and 

worms dwell out yonder_ 

Spot-on rendition, Jakey. 
Believe it or not, I'm from 
Spotlight City-but it's a 
bit too overcrowded and 
difficult to navigate, if you 

ask me. And when I was a 
wee doodle, I actually used 
to camp out in Dashboard 

Forest, where the trees 
do indeed "disappear and 

reappear within 1 to 2 
seconds."-Max 

It warms Niko's hearts to see 
how-tos used in the service of 
such noble causes. 

POLLO LOCO 
I have a basement full of 
vinyl (I know, I'm old), and 

I've finally gotten around to 
transferring my trusty old 

vinyl albums to CDs. My 
only disappointment was 
my inability to scan 12-inch 
album covers on my flatbed 

scanner. Th en I saw your 

" Make Simple Panoramas" 

how-to (Oct/ OS , pS8). Problem 
solved! It was a little labor 

intensive, but worth it for rare 
treasures like my coveted 
Chickenman album. 
-Tim Donohoe 

THE LOVE CHILD 
When I saw "Kill RAM-hogging 
routines!" on your October 

cover, I instantly thought 
there 's no way you'd tell the 

MacAddict public to turn 
off Dashboard, because 
it's Apple's love child-but 
sure enough, you guys did . 
Good job.-Ston er, via the 
MacAddict Forums 
Thanks, though I hope you 
got that name from your 
tendency to hurl rocks at 

sinners-otherwise, I'm 
telling your mother.-Max 

WIN! 
Win an EOS 
Digital Rebel XT! 
When we reviewed Canon's EOS Digital Rebel XT ( u 
Sep/ OS, p44), we sa id, "When it comes to th e Reb el's excellent 
image quality, we could go on for hours." Now, if you write the 
best caption for the picture below, this top -quality 8-megapixe l 
digital SLR (complete with 18mm-to-SSmm EF-S zoom lens) 
could be your tru sted shooting companion for hours, days, 
months, and years. Only one entry per contestant. 

Entry Form 

CONTESTANT INFORMATION 

Full Name: 

Add ress: 

Cit: State: 

Zi : 

Email or telephone: 

Write a 
caption 

for this 
picture. 

Send email entri es to : contest@macaddi ct .com with the s ubject: Rebel Contest 
(Don' t fo rget to include yo ur address Information!) 
Send s nail·mail entries to: Rebe l Co ntest , MocAddict magazine, 
150 North Hill Or., Ste . 40, Brisbane, CA 94005. 
Dead line for entry: Decemb er 31, 2005. 
Contest results will appear in our Apr/ 06 issue. 

Contest Rules The judges will be MacAddict editors and will base their decision on 33 pe rcen t humor, 33 percent 
orig inality, and 33 percent crea tivity. All entries must be received no later than December 31 . 200S, with the winner 
announce d around April 2006. By entering thi s contest, you ag ree that Future Network USA may use your name, 
likeness, and Web site for promot iona l purposes wi tho ut fu rther payment. All prizes will be awa rded, and no min imum 
number of entries is required. If two or more people enter identical w inning captions, the entry received first will be 
awarded the contest prize. Prizes wo n by minors will be awarded to their parents or legal guardians. Future Network 
USA is not responsible for damage s or expenses the winn ers might incur as a result of this contest or the receipt of a 
prize, and winners are responsible for income taxes based on the value of the prize received. A list of winners may al so 
be obtai ned by sending a stamped, sel f-addressed envelope to Futu re Network USA c/o MacAddict Contest, lSO North 
Hi ll Or., Ste. 40, Brisbane, CA 91100S. This contes t is limited to resid ents of the United States. No purchase necessoiry. 
void in Arizona, Maryland, Ve rmont, Puerto Rico, and where prohibited by law. 

Winner! Congratulations to Willi am Kohuth, whose 
caption won him an Other World Computi ng 

400GB Mercury Elite-AL Pro 800/400+USB2 

Combo hard drive ($379.99, www.macsales 
.com). And a quick note to the 121 readers 
who offered " Intel Inside": Original ity counts 
for 33 percent of your score. 

"Hey you kids, get off the lawn!" 

Volume 10, Issue 12 
MacAddict (ISSN 10BB-548X) is published monthly by Future Netv.Qrk USA. 150 North Hill Dr., Ste. 40. Brisbane, CA 94005, 
USA. Periodical-class postage paid at Brisbane. CA, and at additional mailing offices. Newsstand distribution is handled by 
Curtis Circulation Co. Basic subscrip!ion rates: one year (12 issues+ 12 CD-ROMs) U.S. $39.90. Canada $43.95, U.S. prepaid 
funds only. Canadian price includes postage and GST 128220608. IPM 0962392. Ou1side the U.S. and Canada. p1ice is $53.95, 
U.S. prepaid funds only. POSTMASTER: Send address changes to MacAddict, P.O. Box 5126. Harlan. IA 51593-0626. Fu1ure 
NeW..Urk USA also publishes Maximum PC. Mobile. PC Gamer. Official Xbox Magazine, PSM, Guitar World, Guitar One, Guitar 
World Acoustic. Bass Guitar, Guitar Legends, Future Music, Future Snowboarding, Snowboard Journal, Snowboard Trade Nei.vs, 
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Publications Mail Agreement #40043631. Returns: 496(}.2 Walker Road, Windsor ON N9A &l3 
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80 /1 SHUT DOWN 
Lr don't let the back page hit you on the way out 

iPod Engravings 
You'll Never See 
Soon after the recent 

announcement of a Harry 
Potter-themed iPod (www 
.apple.com/ itunes/harrypotter), 
complete with an engraved 
Hogwarts crest, we received 
word from our spies embedded 
deep within Apple's product
development fortress that J.K. 
Rowling's megapopular oeuvre 
wasn't the first aural pleasure 
that the 'Podmeisters had 
proposed . In fact, as proven 
by this photo-smuggled out 
of Cupertino at great personal 
risk-there were at least three 
other audiobook-equipped 
iPods under consideration. 
Take a gander at their contents, 
and-for once-be glad that 
Apple Marketing stepped in . 

The Oxford 
English Dictionary 
Over 290,500 words. In order. 

The Value of Pi 
to 200 Million Digits 
Amedeo Avogadro's favorite 
sequence? 6021023. 

Congressional 
Record, Volume .._______, 
102 (1956) 
Don't miss the thrilling bolt
thread-standardization bill on 
page 634. 
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1 'm h-of f ih-ished with hllf c.(ie""+ 's Web site 
u.hfi( everlf (a.st de+a.i( is -perfec.+. 

» Affordable Web Hosting 

1 "'-eed a. hos+i"'-Cjt -provider with +ha.+ 
sa.me kih-d of C-ommi+meh-+. 
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Domain Registration 

Real-Person Customer Service"' 

Online Sales & Marketing Tools 

SSL Certificates 

NetworkSolutions® 
Go Farther™ u 

... And More 

Call or click: 1.866.455.2005 I www.networksolutions.com 
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UNRIVALED SPEED, CAPACITY & DESIGN. 

ING LACIE D2 HARD DRIVE EXTREME NOW OFFERS CAPACITIES OF 
G FIREWIRE 800, FIREWIRE 400 & USB 2.0 AND EXTREME SPEED. .._ ••• 

1 
.. 

INED TRANSFER RATE OF UP TO 64MB/S, IT'S IDEAL FOR ~ lr.!1;.~=.~ 
NG, GRAPHIC DESIGN AND SYSTEM BACKUPS. WWW.LACIE.COM 


